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Pricing Perspective:
Since there are many methods of 
pricing available for both operating 
systems, this site lists only retail 
prices. Actual prices may vary greatly. 
A Google search, or a price comparison 
site (Pricewatch.com, pricegrabber.
com, dealmac.com) can lead you to 
many online retailers of OEM and 
upgrade versions of the OSes that may 
cost less than the MSRP. Lower prices 
may also be available from educational 
and other discounts. Please check with 
your school, employer, church, www.
froogle.com, computer manufacturer, 
and local government for any available 
discounts. 

At the time of writing this document 
here's what PC Connection was getting 
for our OSes: 

OS X 10.3 $119.95
Family 5 computer pack: 
$199.95 

XP Home Edition
Upgrade: $98.95
Full: $189.95 

XP Professional
Upgrade: $189.95
Full: $289.95

OS Shootout: Mac OS X vs. Windows XP

Home

Dan Pouliot
Last updated, January 1, 2005 
This web site is available as a downloadable PDF. Final PDF updated: 
1/1 (9.7MB). 

January 1, 
Keeping my promise to myself, I've made the final edits to this site 
and generated the last PDF version. It has been fun, but unfortunately 
the demands of life leave me no time for frivolous pursuits such as 
this. If you get value out of the PDF, please make a donation. 

If the revenue stream picks up enough I may return to updating this 
site in the future. Thank you to all who have sent me donations and 
kind words. I am humbled by your generosity. 

Sincerely,
Dan Pouliot 

Nov. 28, 
Proving it is possible for a Mac fan to trash talk OS X, forum member 
Rosyna has written: The True Cost of Mac OS X. 

 

Is it no longer true Macs are easier than PCs? Has Windows XP finally 
caught up with (and maybe even surpassed) Mac OS X? Is Mac OS X just 
a pretty OS, but of little substance? To get a little more clarity on this 
topic, I decided to look at the two OSes—Mac OS X 10.3 and Windows 
XP— in depth, and cover usability issues such as networking, windows 
and keyboard controls, voice feedback and voice recognition, the Dock 
vs. the Taskbar, Find/Search, Help, and much more. 

Although I say I'm comparing two OSes, I'm really comparing three: 
Mac OS X, Window XP Home Edition, and Windows XP Professional. 
When necessary I'll elaborate on the differences between Home and 
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Mac OS X vs. Windows XP

Total Cost of Ownership (TCO) is the 
cost of the OS, plus the cost of the 
hardware, plus the cost of support, 
divided by the number of years that you 
own the machine. At least one site tries 
to compare the prices of Mac an PC 
hardware. Paul Murphy of Linuxinsider.
com presents a detailed case that--
contrary to conventional wisdom-- Macs 
are cheaper than PCs. Industry analyst 
Gartner has concluded that Macs are 
more cost effective than PCs to own. 
This was a private study that got leaked 
to the public. Gartner's subsequent 
refusal to publicly endorse its own 
conclusions smacks of corporate damage 
control. 

Pro. For those of you that would like a more in-depth comparison of 
Home and Pro, you can check out Microsoft's own comparison. 
Microsoft's comparison leaves out some details. For instance, it says, 
"join Windows XP Professional systems to a Windows Server domain." If 
you read between the lines you'll understand that XP Home Edition 
cannot connect to an Active Directory Domain. For a more verbose 
comparison, check out this comparison on Paul Thurrott's SuperSite for 
Windows.

What about XP Tablet Edition and XP Media Center Edition? 
XP Tablet Edition and Media Center Edition are unique offerings in 
the marketplace. 

If you want a computer with writing tablet capabilities, you have 
only one choice: XP Tablet Edition. True, OS X can interoperate with 
pen tablets, but you cannot buy a Mac that allows you to write 
directly onto the screen. 

Likewise, XP Media Center Edition is the only place in the market you 
can get OS level integration with your TV set for viewing photos, 
listening to music, or recording and playing back shows. You can find 
similar third-party offerings for the Mac, but not integrated directly 
into the OS. 

Since their offerings are indeed unique, this site will not discuss 
them in depth. Suffice to say: if you want a tablet PC, you must get 
XP Tablet Edition. If you want a "digital media center" with OS 
integration, you must get XP Media Center Edition. 

This shootout is narrowly focused on features (and the usability of those features) for creative professionals, so its 
conclusions may not be true in other work environments. For instance, corporate employees have very different 
requirements for what makes a useful computer from those of web or video designers. Furthermore, this shootout only 
considers components that either come with the OS or are supplied for free by the OS manufacturer. I think it's fair to 
say that everybody loads up his or her computer with commercial, shareware, and freeware apps that extend the 
computer's basic functionality. I wouldn't be so bold as to try to compare X vs. XP in terms of every possible 
combination of software on the market. So take this shootout with a heavy grain of salt. 

From the Editor: 

As you will no doubt deduce as you read this site, I prefer Macs. Just the same, I think this site is mostly objective. 
Use the online forum to keep me straight. 

—Dan Pouliot

Let the shootout begin!

Pick a topic:  
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Introduction: A Note about Bias, Scoring Defined

Bi·as: A preference or an inclination, especially one that inhibits impartial judgment. 

Routing out Bias If you're reading this site, chances are you already have a preference or an inclination 
regarding Mac OS X and Windows XP. And, surely, anyone with enough computer experience 
to be able to thoroughly compare these two OSes has a preference by now. As I see it, what 
is at issue here is whether we let that preference inhibit our impartial judgment. 

I suppose I shouldn't be surprised that the issue of bias comes up regarding this site. But 
after all the effort I put into eliminating bias from my assessments, I was quite surprised 
when I saw the high emotional charge that this site sparked among posters to various 
message boards (including this site's own board), and the sheer volume of posts implying, or 
outright accusing, this site of being biased. 

Occasionally newly written content may lack a thorough examination of the topic at hand. 
Such potential/perceived biases don't remain long, since they are quickly dealt with by the 
active community on this site's member forum. For that reason, I think it is fair to say that 
this site is about as impartial a comparison of these two OSes as can be found anywhere. 

So how do we tell when a statement is biased? The following are some clues or ground rules 
to help detect when bias may be present: 

When to suspect that bias is present

One may suspect bias is present if a discussion:

Is extremely forgiving of the failings of one yet extremely harsh with the failings of the 
other
Burning CDs in OS X isn't as convenient as in XP. And drag and drop on the PC just doesn't cut 
it. Be vigilant of mediocrity in all OSes. 

Changes the subject to reinforce a position
This is not a Mac vs. PC shootout. It's a shootout is about the quality of user experience of 
these 2 OSes. That's all. It's not a shootout about: 

●     Quantity or quality of hardware- processors, peripherals, you name it
●     Cost
●     Third-party software
●     Apple's viability
●     Microsoft's evilness
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X vs. XP > Introduction: A Note about Bias, Scoring Defined

Sure, this site mentions cost issues and third-party software, but merely as a conversation 
points. I think I even put down Microsoft once or twice [hey, it's fun and easy ;-)]. But third-
party software and cost issues do not affect any scores (nor does Microsoft's evilness). 

I don't mind people discussing these other items in the forum, just as long as they realize 
that they are off-topic. I bring up easily 200-300 points about these OSes in this site. Talk 
about that! If you don't rebut my assertions I must conclude that you agree with me. If you 
disagree with the fundamental value of such a 'pure OS' debate, you should stop reading 
now, because this site will just make you angry. 

Makes apologies, justifications or exceptions for poor OS experience
This can look like saying, "The reason why the Num-Lock key behaves backwards is...[fill in 
justification]". It can also look like saying they 'prefer' reduced functionality, as in, "Who 
needs drag and drop, it's unnatural". Caveat: sometimes fewer choices may yield a superior 
OS experience, specifically when the user could feel overwhelmed. 

Expects the user to conform to 'how the computer does things' rather than expecting the 
computer to accommodate different user styles
Examples: "What are you doing trying to put slashes in a file name? You can't do that! Use 
underscores instead." or "You can't install these device drivers until you've connected the 
new device" or "You can't connect the new device until you've installed these device 
drivers". 

Confuses "right/wrong" behavior with personal preference
It's ok to prefer one button mice. It's ok to prefer drag and drop, it's ok to prefer custom 
buddy icons, using the trackpad as a mouse button, navigating the file system via the 
keyboard, etc., etc. 

Blames the user for undesired outcomes
The word "idiot" has no place in usability conversations. Not everybody has logged thousands 
of hours of computer time. Computers need to be as easy to interact with as other human 
beings (please no cracks about humans being difficult to interact with). No OS is there yet, 
but when a user clicks a button and the wrong thing happens, 9 times out of 10 there is a UI 
design solution that could have averted the undesired outcome. In order to improve all OSes 
we need to place the blame of usability problems not on the user but on the UI. True, it's 
very difficult to design a UI that simultaneously accommodates the needs of the novice and 
the needs of the power user. However, just because it's difficult doesn't mean it's not 
possible or that we should forgive a UI that doesn't live up to the task. 

Omits crucial content that could alter the conclusion
True, there are plenty of aspects of these OSes I haven't yet included in this shootout. 
However these omissions are strictly due to the fact that there aren't enough hours in the 
day to be 100% thorough. I've tried to include all of the most crucial elements of the OS 
experience, and I'll continue to add topics as time permits. 

Exaggerating an issue to strengthen your case
(yes, people actually said these things on this site's forum) 

Example 1: "I'm paying 300% more for this Apple brand product than I would if I were to buy 
a comparative product from another manufacturer!". 
I'd love to see the PC that's 1/3 (actually 1/4!) the price of a similarly equipped Mac! 

Example 2: "There are about 1000 times more software for PCs".
Wow! 1000 times more! Let's see, at the time that forum post was made, Apple claimed 
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there was over 6,000 programs written for Mac OS X (as of January, 2004, Apple claims 
10,000 OS X apps). 6,000*1,000=6,000,000. 6 million applications for PCs, that's incredible! 
It's also about as outrageous an exaggeration as I can imagine. 

Both of the above statements are also intentionally vague, implying more than is actually 
stated. 

The first example: "I'm paying 300% more for this Apple brand product" implies that Apple 
computers cost 300% more than comparably equipped PCs, and Mac owners are therefore 
forced to pay 300% more for their hardware. When pressed for facts, the author of this 
statement backed it up by finding some third party RAM that costs roughly 1/3 of Apple 
branded RAM, thereby making his statement technically true. Of course, Apple computers 
can use third party RAM, so Mac users aren't forced to use exhorbinantly priced parts as the 
statement implies. 

The second example: "There are about 1000 times more software for PCs" is unprovable 
since there is no real data on how many applications there are for PCs. However, since this 
site is not about PCs but about XP, the statement becomes even more questionable, since 
Microsoft recommends that XP users install not just applications that are compatible with 
Windows XP, but rather only applications that receive the Designed for Windows XP status: 

"While compatible products work with Windows XP, products that are 
Designed for Windows XP are specifically created to take advantage of the 
great new features in Windows XP and reduce the number of problems you 
might otherwise have using your computer." (emphasis mine) 

In order for an application to receive the Designed for Windows XP status, it must do all of 
the following: 

●     Perform primary functionality and maintain stability 
●     Install without an unnecessary reboot 
●     Uninstall completely without leaving code behind 
●     Enable users to easily share computers 
●     Allow for easier system and OS upgrading 

meaning that if a program doesn't have that status, you may be at risk for stability issues, 
problematic system upgrades or problematic uninstalls. 

While all software to receive the Designed for Windows XP status is in the Windows Catalog, 
Microsoft has not disclosed the total number of programs with that status. As a marketer, 
the decision as to whether or not to publish that number purely comes down to how 
impressive the number is. That Microsoft hasn't disclosed the number leads me to believe 
that the total number isn't that impressive. I'd guess it's less than 10,000, thus making the 
claim of "There are about 1000 times more software for PCs" quite an exaggeration. 

Remember, these aren't guarantees of bias, they're only when to suspect bias. In such a 
complex debate where people have strong emotional investments in their decisions it's easy 
to misspeak. That's when you inquire, get clarification or correction and hopefully move on. 
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Scoring 
Defined 

Previously this site used a winner-takes-all scoring system, which didn't accurately reflect 
how similar these OSes sometimes are. So I've adopted a 1-10 scaling method for each topic: 

0.  not natively supported, solutions may be purchasable
1.  not natively supported, but freeware/open source solutions are available
2.  exceptionally poor support
3.  poor support
4.  below average support
5.  average/acceptable support
6.  slightly above average support
7.  good support
8.  very good support
9.  exceptionally good support

10.  Perfection - improvement is not possible

Granted, this system isn't perfect either, but it's better than winner-takes-all. 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Login

Login Security 
 

Both OSes can be configured to automatically log in (if only one user is set 
up on the system). They can also both be configured with a "Welcome 
Screen," where you select your user from a list and type in your password. 
They can also be configured to not display a list of user accounts, thereby 
requiring users to type in both their username and password. 

XP: XP can be configured to display Press Ctrl-Alt-Delete to 
login with a brief sentence, "This makes your computer more secure." 

 
This optional "secure logon" screen can be disabled in the User Accounts 
control panel, unless you're a corporate user (like myself) and your IT 
department locks down that feature as mandatory. Microsoft says that the 
Ctrl-Alt-Delete sequence is "guaranteed" to always bring you to THE 
official Windows login screen. This is because Windows has been 
historically extremely vulnerable to viruses that take over the boot 
sequence and steal your login. 

One persistent reader pointed out to me that this "guaranteed login" 
would be a very good thing in certain environments. Let's say you're in a 
school lab sitting down at a computer and typing your username and 
password into the screen in front of you. How do you know that that 
screen isn't just an application running on that computer and made to 
resemble a login screen, whose sole purpose is to capture your password 
and email it to somebody? 

OS X: By default OS X automatically logs you in as the primary user of the 
computer. As soon as you begin adding more users to your computer, OS X 
asks you if you still want to automatically log in as the primary user at 
startup or if you want to require users to log in. If you choose to require 
logins, OS X brings you right to to login screen at startup, no Ctrl-Alt-Del. 
Furthermore, if you type your password wrong, the login window wiggles! 
This simple, elegant and unintimidating feedback lets users know that 
they need to try again. The down side to a wiggling login screen is that it 
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may be insufficient to notify a novice user that they entered the wrong 
password. A written confirmation that the password was not accepted 
would help novices. For anyone wanting an "official" key sequence to bring 
you to a login screen, OS X uses -Shift-Q. 

Though I'll never lose any sleep over the lack of a Ctrl-Alt-Delete login 
guarantee on OS X, I can appreciate the fact that such a level of security 
is important in certain environments. 

Login Security: OS X: 7, XP: 9 

Security, Out-of-the-box 
 

Login security is not synonymous with overall security. Computer users 
want to know if they buy a computer and turn it on, is it secure? Or do 
they need to take extra steps to make their computer secure? 

Every OS (or at least the components supplied with the OS) has security 
vulnerabilities. Hopefully OS manufacturers patch vulnerabilities as soon 
as they are made public. However, it's an OSes security model that 
determines how easily vulnerabilities can be exploited. An OS with a poor 
security model is like a house with its front door wide open, letting 
anybody in whenever they want. An OS with a solid security model is more 
like a prison—the only people getting in or out are the ones that the guard 
allows. Out-of-the-box security is intended to look at the default security 
model of these two OSes when you first turn them on. 

Both OSes choose to hide file extensions by default (XP hides extensions of 
"recognized" file types by default, revealing extensions of "unrecognized" 
file types). In XP hidden "recognized" file extensions mean that users could 
be fooled by "faux" extensions (Picture.jpg.exe, where .exe is hidden) 
unless they are in Tiles view and looking for the full file information. 
While OS X is not fooled by this, it can be fooled by a more insidious 
method: file extensions need not match the file type at all. For instance, 
an application package (which should have a .app extension) can have a .
jpg extension). The good news is that such misleading extensions do not 
transit the internet natively: they must be wrapped in a package (binhex, 
DMG, zip, etc), then "uncompressed" locally. 

XP: With Windows XP SP2 (released 8/04) XP now has a Security Center to 
help the user protect against worms, viruses, and hackers. XP SP2 also 
warns the user of unauthorized programs trying to access the internet as 
well as warns of the dangers of running EXEs off the internet. 

OS X: While OS X may not be immune to viruses, it has 2 obstacles to the 
installation and dissemination of viruses that XP lacks: 

1.  Installers for OS X require authentication to run, installers for XP 
don't. (This is not always an obstacle, since many OS X apps use the 
"drag-install" method, thereby bypassing an installer)

2.  Administrators in OS X do not gain access to system critical files 
(known as root access). Administrators in XP do, thereby allowing 
applications access to those files too
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But every OS gets viruses, right?
Every OS can get viruses, but for some reason, viruses for Mac OS X 
haven't yet materialized. Listen to what David Zeiler cites numbers 
from Sophos PLC and Symantec in his 7/21/2003 SunSpot.net article 
entitled "What, me worry?" 

"In a report released last month, Sophos PLC, a British 
company that sells anti-virus software, noted that 
through the first six months of 2003, the most 
commonly reported virus that could affect Mac 
computers was one designed for the "classic" Mac OS -- 
not OS X. It placed 78th on the company's list. 

..."According to Security Focus, a computer security 
information Web site owned by Symantec Corp., the 
Cupertino, Calif.-based maker of the Norton brand of 
anti-virus products, the number of viruses written for 
the classic Mac OS is about 50. 

OS X: 

●     OS X ships with file sharing and related services turned off
●     OS X requires installers to get authentication to make changes to 

files the user does not normally have access to (like system files).
●     Keychain Access Info button warns of weak passwords
●     Modified applications require permission to access passwords 

stored in Keychain
●     Users can be fooled by misleading file extensions
●     Fast User Switching allows users to run background processes which 

could enable them to snoop on other users (see Fast User Switching)

XP: 

●     Users can not be fooled by misleading file extensions, but 
extensions for recognized file types are off by default

●     Fast User Switching doesn't allow users to run background 
processes which could enable them to snoop on other users

●     Security Center aggregates security-related settings into one 
location: Automatic Updates, Antivirus software, Firewall

●     XP educates and actively warns users users about security dangers
●     Programs cause XP to throw a yellow flag, and a red flag if 

unsigned.
●     Outlook Express, MSN Messenger and Windows Messenger will not 

allow the user to download potentionally dangerous files (can 
interfere with legitimate EXEs, but protects against almost always 
malicious PIFs and VBSs.)

●     Local Security Policy in XP Pro (not available in XP Home) can 
require users to make strong passwords, set password expiration 
times, and require miniumum length of passwords 

●     No warning of weak passwords (if Local Security Policy is not 
enabled)

●     XP does not require installers to get authentication to make 
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changes to files the user does not normally have access to (like 
system files).

●     XP ships with File Sharing service and related services turned on
●     Windows Networking runs all file sharing and related services over 

the same ports (limited to the local subnet). "All the traditional 
Windows networking services ... file and print client, file and print 
server, messenger, login, and so on... all these services predate 
Windows use of TCP/IP. They used a LAN protocol that involved 
what are called "named pipes" to connect between services. Under 
TCP/IP, all these services run encapsulated (almost in a kind of 
emulation mode) under that old LAN environment. That 
encapsulation runs over a few common ports, so an IP-based 
firewall that allows a connection to the ports required for ANY of 
these protocols allows connections for ALL of these protocols." 
Thanks resuna

●     The "Trusted Zone" model of ActiveX objects is often 
circumvented, making ActiveX a delivery mechanism for viruses 
and spyware. 

As recently as July 2004, XP shipped with 5 ports open. If Windows XP had 
adopted the same security model as OS X from the beginning, I would bet 
money that MSBlaster, SoBig.F, Code Red, and many other viruses that 
caused millions of dollars of damage to companies and goverments would 
not have been able to spread as quickly as they did. 

Security, Out-of-the-box: OS X: 7, XP: 7 

Fast User Switching Fast User Switching means that users can log out of their work 
environment without quitting programs, allowing other users to log in and 
run their own programs simultaneously. For instance if one person wants 
to hop on the home computer to look at his email without seriously 
disturbing the other person, he can do that with Fast User Switching. 

XP: Users in XP 
(Home and Pro) can 
use Fast User 
Switching as long as 
they're not connected 
to a Windows 2000 
domain. The login 
screen will display 
how many programs 
one user has open. It 
will also display how 
many unread emails 
are in your inbox. 
This is a great feature, since if all you wanted to do is check your email, 
just go to the login screen, see that you have no mail, and you're done! 
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OS X: OS X supports Fast User 
Switching via a menu in the upper 
right corner of the screen. Fast 
User switching is turned off by 
default, and turning it on displays 
a warning that it is not entirely 
secure and should only be used if 
you trust the other users on the 
computer. In my tests, Fast User 
Switching in Panther was 
sufficiently secure for casual use, 
but it didn't take me long to 
figure out one way to circumvent its security: VNC. If one user runs VNC 
server, he or she can remotely log in to the computer and take control 
regardless of which user is actively logged in, as long as VNC server is 
running. This behavior is to be expected w/VNC, since its sole purpose is 
to see what's happening on the remote computer ("frame relay 
application"). 

 

Owners of Quartz Extreme capable Macs will be treated to a "flipping 
cubes" transition when switching users

Selecting "Login Window" 
from the Fast User 
Switching menu locks the 
screen, displaying the 
window shown here. 

OS X's login screen does not 
display how many programs 
a user has running or how 
many unread emails they 
have. 

OS X allows users running 
the same OS to have 
completely different 
Internationalizations. So, 
for instance, one user can 
be running OS X in English and another user can be running OS X in 
Japanese. This is great for multilingual families. 

OS X supports a number items that can be customized per user that XP 
does not (see table), thereby allowing each user account to be more 
tailored to that user. 

XP: 
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●     FUS screen displays number of unopened emails and open 
applications

●     FUS not available when connected to a Windows 2000 domain
●     Users must all run the same internationalization
●     Less per-user account customization

OS X: 

●     Users can run separate internationalizations
●     Greater per-user account customization
●     FUS screen does not display number of unopened emails and open 

applications

Fast User Switching: OS X:8, XP: 7 

Handling Caps Lock Key When logging in to your computer, OS manufacturers found that one of the 
biggest usability problems people had was that they didn't realize that 
their Caps Lock key was depressed. Since password keystrokes are hidden, 
people could type their password over and over, not realizing that the 
system wasn't logging them in because of the Caps Lock key. 

XP: XP 
notifies you 
via a tool tip 
to let you 
know if your 
Caps Lock 
key is 
depressed 
when typing 
your 
password to 
log in to your Account. This tool tip will also occur with any authentication 
dialog box, including web site login dialogs. 

OS X: OS X notifies you if your 
Caps Lock key is depressed when 
typing your password to log in to 
your Account via a "caps lock" 
icon (an arrow with a line under 
it). Nowhere in Apple hardware 
or software printed 
documentation do they let you 
know what that icon means, and it is not easily found in online 
documentation either. So if you don't know that an upward facing arrow 
with a line under it means "caps lock key" then that notification is 
meaningless to you. 

Apple seems to recognize the obscurity of that symbol, as they explain it 
in subsequent dialogs: 
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It's a shame they don't explain it in the User Account Log In screen. 

Handling Caps Lock Key during authentications: OS X:5, XP: 8 

Locking the Screen OS X and XP both have several methods to lock the screen.

XP: 

●     Type WINDOWS + L to lock 
●     Type Ctrl-Alt-Del then Enter to lock (you must have the welcome 

screen enabled for this to work, otherwise type Ctrl-Alt-Del, then 
select Shutdown or Switch User )

●     Set the screen saver to protect (no way to manually initiate the 
screen saver)

●     Control Panel > Power Options > Advanced> Prompt for password 
when computer resumes from standby. 

OS X: 

●     Select Login Window from the Fast User Switching menu (To enable 
Fast User Switching: In the Accounts> System Preferences, select 
Enable fast user switching from the Login Options section) 

●     Lock Screen from the Menu Bar icon (To add this icon: In Keychain 
Access, select View> Show Status in Menu Bar) 

●     Require password when waking from sleep or screen saver in 
System Preferences> Security (combine with "Exposé Hot Corners" 
to instantly lock the screen by dragging your mouse to a specified 
corner) 

●     Automatically log out after x minutes of inactivity (also in in 
System Preferences> Security) 

●     Bluetooth device proximity screen locking (with the shareware 
Salling Clicker) 

XP users wanting to walk away from their computer need to either type 
Windows-L (if the keyboard has a Windows key) or close the lid (if it's a 
laptop). OS X users can drag their mouse into a sleep corner. While typing 
Windows-L on keyboards with a Windows Key is arguably no more difficult 
than dragging your mouse to a corner, it requires that your keyboard have 
a Windows key (most Thinkpads don't: the T23, T30 and X30 don't). 
Thinkpad users who want a key sequence to lock the screen (they could 
just close their lid) can type Ctrl-Esc, l, s to lock the screen. 

What OS X has over XP is the use of bluetooth devices to enable proximity-
based locking. Walk away from your computer (with your cell phone in 

http://www.xvsxp.com/log-in/ (7 of 8)1/1/2005 5:47:53 AM

http://homepage.mac.com/jonassalling/Shareware/Clicker/


X vs XP > Login

tow) and your screen will lock automatically. Return to your computer and 
it will unlock automatically. True, this is enabled via third-party 
shareware; there is currently no equivalent software available for XP, 
however. 

Locking the Screen: OS X:8, XP: 8 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
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Activation/
Registration

XP: All boxed retail versions of XP Home and Professional require activation (XP Volume/
Open Licensing Editions do not), but registration is optional. Retail versions of XP have a 
30-day limit. You must your activation key from Microsoft by the end of the grace period. 
If you do not, XP will stop working until you activate. You can extend this deadline by 
not logging off. Once you log off after 30 days w/out activating, it won't let you log back 
in. 

Most OEMs (Dell, Gateway, HP, for instance) use System Locked Pre-Activation. This 
means that end users who purchase a PC with XP from one of these OEMs will never run 
into activation unless they are trying to install their system disc on a different machine 
(which is not allowed under Microsoft's OEM License). Even if the user makes massive 
hardware changes, as long as the motherboard doesn't change, no activation will be 
necessary. 

In general, if the computer comes with a 'Restore Disc', it probably uses System Locked 
Pre-Activation. If the computer comes with a true XP Install Disc, it probably doesn't use 
SLP, and the end user will need to activate it. 

Activation records are erased from Microsoft's servers after 6 months (180 days). 

Significant changes to your computer may require reactivation. Microsoft's Windows XP 
Product Activation web page states, 

"If you overhaul your computer by replacing a substantial number of 
hardware components, it may appear to be a different PC. You may have 
to reactivate Windows XP. If this should occur, you can call the telephone 
number displayed on the activation screen to reactivate the software.". 

Learn more at annoyances.org. 

OS X: There is no activation. There is only an optional registration screen. 

One reader pointed out that activation only takes a couple of seconds so it's no big deal. 
True, from a usability standpoint it's no big deal, but I'm not the only person I know that 
finds XP's activation insulting. That said, it's unfair to ding XP excessively for trying to 
protect itself from piracy. 

Activation/Registration: OS X: 9, XP: 7 
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Real-time 
feedback during 
pauses 

According to Ask Tog's First Principles of Design, in his Latency section, button clicks 
should have some kind of feedback "within 50 milliseconds," and if the wait will be 
longer than 2 seconds, the system should display some sort of message approximating the 
duration of the wait. 

Both XP and OS X could use help here. For instance, though both OSes display feedback 
at various points during startup, both also have intervals during startup where no 
feedback is displayed. Further, neither lets you know how long the startup sequence will 
take. That is also true when launching applications—neither OS notifies you of how long 
an application launch will take. 

XP: XP routinely fails to notify the user if the system is busy. It doesn't give ANY 
feedback when launching Internet Explorer. True, this is not an issue with faster 
computers. On my 400MHz PIII, however, I frequently find myself double-clicking the IE 
icon multiple times because I'm not sure if Windows registered my first try. Several 
seconds later I find that I just launched multiple instances of Internet Explorer. When 
Microsoft Outlook is busy downloading a large email attachment, the cursor becomes an 
hourglass only AFTER you try performing another task, like clicking a scroll bar, or trying 
to view a different message. Even then it fails to provide a progress bar, even if the 
attachment will take quite a while to download, so the user has no idea how long he or 
she will be waiting. 

OS X: OS X does a pretty good job of keeping you appraised of the computer's status. For 
instance, Apps bounce in the Dock while launching, or if you prefer, the black arrow 
under the Dock item will pulsate. Finder windows, Safari tabs, software updates and To: 
and Cc: boxes sport a status pinwheel (at right) to notify you that items are in 
progress. Whenever you stop getting feedback, that's a good sign that an application 
has become unresponsive, and may require a force quit. 

Real-time feedback during pauses: OS X: 7, XP: 4 

Responsiveness Thanks to GribUser for these great illustrations.

I'm considering responsiveness here as distinctly different from raw speed. Speed is a 
measure of how quickly the OS or applications handle computationally intensive tasks. 
Responsiveness is more a matter of how quickly the interface responds to basic user 
inputs: scrolling, window dragging, window resizing, tabbing through dialogs, selecting 
menus, etc.

 

scrolling

Here are a couple of illustrations of interface 
responsiveness with OS X and XP. Note that these are not 
actual videos, but simulations. Notice how in both 
illustrations XP's interface keeps up with the cursor, but 
X's doesn't. 
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window resizing

  Keep in mind that these illustrations are generalizations. Both OSes do not behave as 
depicted above in all cases. For instance, my PowerBook G4 400Mhz was perfectly 
responsive when scrolling. And I have also witnessed XP being less responsive than 
depicted here. In general, however, the illustrations above accurately demonstrate a 
tendency in Mac OS X to be less responsive than Windows XP. 

Responsiveness: OS X: 7, XP: 9 

Move/resize 
windows at 
borders

OS X: Standard windows can only be moved from the top edge. Brushed metal windows 
can be moved from any brushed metal portion of the window. Resize windows at one 
corner (lower right). 

XP: Windows are moved from along the top edge. Windows can be resized along any 
edge and corner. 

While I appreciate XP's ability to resize a window from any edge, I've found myself 
frequently accidentally resizing a window when I meant to move it (when I'm working 
fast). To avoid accidental resizing I need to slow down and pay attention to the cursor to 
see if it is an arrow or a vertical bar with arrows at either end. One possible solution to 
this issue would be to require the user pause for a half second before initiating a resize 
drag from the top edge. Another possible solution would be to have "drag zones" on the 
along each edge that were draggable rather than allowing the window to be dragged 
from anywhere along the edge. Either method would reduce accidental resizing. That 
said, I'll give XP the edge for having more resizing options. Only being able to resize a 
window from the lower right corner is often too restrictive, especially if that corner is 
offscreen. 

Move/resize windows at borders: OS X: 6, XP: 8 
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Cursors, Context 
sensitive

Both OSes have a handful of common cursors: 

●     Arrow
●     Finger ("click here")
●     Arrow with a plus sign ("release the mouse to add the dragged item here")
●     Curly Arrow ("release the mouse to create a shortcut here")
●     Circle with a diagonal line through it ("that item cannot be dropped here")
●     Spinning ball/hourglass ("system is busy")
●     I-Bar (insertion bar for entering text) 
●     Crosshair cursor for precision selection 
●     Question Mark ( Press the Help key on a full sized keyboard) 

OS X: OS X has additional cursors: 

●     Arrow with a menu symbol ("clicking now will reveal a contextual menu")
●     Magnifying glass (for selecting colors; invoked from the Colors palette)

XP: Windows has additional cursors: 

●     Resize/Move left-right
●     Resize/Move up-down 
●     Resize/Move diagonal
●     Move/Size arrows pointing up, down, left, and right
●     Disc is busy—this icon of a CD next to your arrow pointer lets you know that a CD-

ROM has been insterted and is spinning up. 

These additional cursors are primarily used for moving/resizing windows at their borders 
(see above). Since OS X lacks the ability to resize windows along their edges and it's been 
scored in the previous section, it would be unfair to ding X a second time for lacking 
these cursors. 

Cursors, Context sensitive: OS X: 9, XP: 9 

Moving Windows 
Offscreen 

Windows should never be permitted to move offscreen (or sufficiently offscreen that no 
mouse-movable portion of the screen is visible). 

XP: Whenever a window accidentally gets moved completely off the screen, the Size and 
Move keyboard commands can be invoked, and the window can be moved back onto the 
screen via the keyboard. This is making up for the OS's deficiency, since it should *never* 
allow such a state to occur. 

OS X: I have yet to see a window that's so far off the edge of my monitor that it's 
inaccessible. However, OS X's Finder includes a feature to automatically slide windows 
that are mostly offscreen back (on screen). One way to view this in action is to move an 
open window as far as possible to the left or right of the screen. Next, drag a file from 
the desktop onto the sliver of the window that's visible. Wait a second, and the window 
will slide into view. Drag the icon off the window and it slides back to its original 
position. Drop the icon into the folder, and the folder remains in the middle of the 
screen. 

As for application windows, they cannot be moved entirely off of any edge of the screen. 
While the Title bar of Carbon applications cannot be moved below the bottom of the 
screen, Cocoa applications can have their Title bars moved off the bottom of the screen, 
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although they will snap back to a safe position as soon as the mouse is released. 

Though the comments regarding how to move XP windows back onscreen came from 
readers, other readers have also reported that with the correct video drivers, windows 
would never accidentally become lodged offscreen. 

Moving Windows Offscreen: OS X: 9, XP: 9 

Menus, Context 
sensitive, 
Accessing 

XP: Access contextual menus via the right mouse button, via Shift-F10 or by hitting the 
"Context key." 

Shift-F10 is quite a cumbersome key sequence both mentally (kind of cryptic) and 
physically (most users will need to take their eyes off the screen and possibly their 
fingers off their home keys in order to manage it). Still, it provides a way to navigate 
contextual menus exclusively via the keyboard. 

The Context key is typically located next to the right Control key on Windows keyboards, 
and may have an illustration of a contextual menu on it. This key is not available on all 
keyboards (my ThinkPad doesn't have it). 

OS X: Access contextual menus by Control-clicking or via the right mouse button IF you 
have purchased a third party two button mouse. If you have a one button mouse, (PC 
users: try to re-read that last phrase without rolling your eyes) access contextual menus 
by Control-clicking. Certain items in contextual menus (like Dock items) can additionally 
be accessed by click-and-holding. 

How about Quantity/Quality of Contextual Menus?
That is a great topic that I'd like to cover in depth in the future. I can say that both 
OSes have a healthy array of context sensitive menus. One that XP has that I'd love 
to see in X is Send to email recipient. X's method for attaching items to 
emails from a contextual menu is a bit more cumbersome: From the menu, select 
Open With... then select your email program. (Apple's "official" method of attaching 
items is not located in a contextual menu: from an Application's menu, select 
Services> Mail> Send File, Send Selection, Send To) 

I'd love to see Apple start selling a two button mouse, even as a BTO option, but that's a 
hardware issue, not software. Just the same, a one button mouse is just as valid a 
personal preference as a five button mouse. This makes Apple's inclusion of control-
clicking sensible, and click-and-holding provides right-mouse-button free method to 
access contextual menus of Dock icons. For a truly mouse-free method in OS X, use Focus 
on Dock (Ctrl-F3). XP provides Shift-F10 (cumbersome but mouse free) and the Context 
key (not on all keyboards). So it seems that even though both OSes treat this matter 
differently, it would be unfair to give one the point over the other. 

Menus, Context sensitive, Accessing: OS X: 8, XP: 8 
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Fitt's Law, 
Adherence to 

Fitt's Law: "The time to acquire a target is a function of the distance to and size of the 
target." 

According to Fitt's Law, targets placed along the edges of the screen are inherintly 
"larger targets" because it's impossible to scroll beyond the edge of a screen. Therefore, 
targets should be placed along the edges of the screen (Corners are even better, and 
directly under the mouse is best). 

Neither OS pays total homage to Fitt's law. They both have an abundance of contextual 
(under the mouse) menus, and they both use some edges of the screen. Both OSes make 
fairly good use of screen corners. As a bit of explanation, having something near the 
corner is not the same as having it at the corner. Example: OS X's Apple menu is near the 
corner, but if you place your mouse exactly in the corner of the screen and click, the 
Apple menu doesn't open. 

XP: All application menus reside within their Application's window, so even when 
maximized, an application's menu items (File, Edit, etc.) are not at the edge of the 
screen (though the Close button is in the upper-right corner and the Minimize/Restore/
Close contextual menu is in the left corner). Furthermore, maximized windows have 
other shortcomings: maximized windows cannot be resized and when you maximize a 
window the ease of working between apps diminishes. Dragging and dropping content 
from one app to another involves dragging the content down to the Task bar onto the 
button that corresponds to the window you want to drag into (even though the cursor 
switches to the Can't-Do-That icon), then, finally drag the item back up the screen to the 
location you want to drop it. Not impossible, but not too practical either. One other 
method is to begin dragging your file and then Alt-tab to the window you want. Then 
release the keys and the window comes to the front, so you can drop your selection into 
it. This works in OS X too, but is arguably still too cumbersome for frequent use. 

Corners in XP are better used than screen edges: the Start Menu is always placed in a 
corner, which makes it a very easy target. Also, when a window is maximized, the upper 
left corner of the screen accesses the Close, Minimize, and Restore commands. The 
upper right corner accesses the Close icon. 

Shaded portions of the screen are areas that adhere to Fitt's law. The circle in the 
center represents contextual menus access directly under the mouse. 

http://www.xvsxp.com/general/ (6 of 9)1/1/2005 5:47:58 AM

http://www.asktog.com/basics/firstPrinciples.html#fitts%27s%20law


X vs. XP> General Interface

Note: The upper corners of the screen only adhere to Fitt's law when a window is 
maximized. The section in the middle of the top edge of the window is XP's Keyboard 

switcher. 

OS X: Virtually all application menus are attached to the top of the screen, rather than 
to the applications' windows (with the exception of apps where the developers 
intentionally chose to alter this default configuration). This simultaneously adheres to 
Fitt's Law while reducing screen clutter. 

Panther supports the use of all four corners of the screen (via Exposé). You can 
customize your screen corners to start or stop your screen saver, show your desktop, 
reveal all windows, or reveal windows of the current application. Exposé is definitely 
useful, though I would have also appreciated the ability to customize my screen corners 
to do things like accessing the File menu of my current app, or at least accessing my 
Apple menu, neither of which is possible in OS X. 

Apple doesn't sell two button mice. This means users who don't purchase a two button 
mouse will access contextual menus in other ways. The most common one-button-mouse 
way to access contextual menus is to use the Control key combined with a mouse click. 
Some menus can be accessed via a click and hold (for instance, Dock menus). 
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Note: the Dock adheres to Fitt's law with clicks, but not with drag and drops. Items can 

be dragged under Dock icons without highlighting the icon. 

Fitt's Law and Drop Down Menus 

The Pick a Topic drop down menu at the top and bottom of each page in this web site 
is a perfect example of Fitt's Law in action. Safari and Internet Explorer for XP handle 
such menus differently: 

 

XP: When an XP user selects the menu at the bottom of this page the menu will pop 
up, but the entire menu will pop below the mouse (or above the mouse if there isn't 
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enough room on the monitor to display the menu in its entirety below the mouse). 
The current selection "General Interface" will be highlighted to remind the user which 
page he or she is currently on, but will NOT be directly under the mouse. The user 
will then need to scroll a little or a lot to get to the next page in the list. This 
undesirable behavior is softened a bit by the fact that XP users can type the first 
letter of the item they want and the menu will snap to that item (Safari for Panther 
responds to typing too). 

OS X: When an OS X user clicks on the menu at the bottom of this page the menu will 
pop up, and the current selection "General Interface" will be directly under the 
mouse. So X users just have to scroll down one item to select the next page in the 
list. If the menu is near the bottom of the screen the menu and so cannot display the 
remainder of the list, a down arrow will appear at the bottom of the list, indicating 
that scrolling down the list will make the rest of the list appear. (Note: Mozilla for X's 
drop down menus do not behave this way because Mozilla's UI widgets are platform 
independent, and, therefore, fail to adhere to OS X's user interface guidelines.) 

From the perspective of Fitt's Law, OS X's Application menus attached to the top of the 
screen definitely beat XP's menus that could be a) anywhere on the screen and b) are 
NEVER at the absolute top of the screen. X's Exposé means that all four corners of the 
screen are used. XP only uses three corners, but I appreciate what Microsoft has chosen 
to place in those corners: the Start Menu, the Close button, and the Minimize/Restore/
Close menu. I originally gave this score to OS X, but upon further consideration I think 
both OSes have considerable room for growth here, so I'll give them a tie. 

Fitt's Law, Adherence to: OS X: 7, XP: 7 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
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Dialogs, Part 1

Dialog boxes 
 

Dan's Book 
Recommendations: 

"Confusion and clutter are failures of design,
not attributes of information" 
—Edward R. Tufte, Envisioning Information. 

Let me illustrate a point by showing you just the buttons in an XP dialog box: 

In the dialog above, would you know which button to click? 

Ok, let's try the same dialog box with X: 

Now would you know which button to click? By the way, these screen shots were 
both taken from Save dialog boxes. 

I don't like reading. OS X's buttons are often all I need to read. XP's I ALWAYS 
have to read the entire dialog box.

In the above examples, Mac OS X places the strongest visual weight on the safest 
button, and separates the 'safe' buttons from the 'unsafe' buttons, to reduce the 
chances of accidental clicks producing undesirable results (notice the space 
between the Don't Save button and the other two buttons). Windows XP also 
places greater visual weight on the safest buttons, but does not separate unsafe 
buttons from safe buttons.

Apple's own developer guide to 
the differences between Windows 
and Mac OS X explains: "clear 
dialogs in Mac OS X communicate 
to the user: 1) what happened, 2) 
why it happened, and 3) what to 
do about it. To ensure that consistent format, Mac OS X dialogs tend to use verbs 
as button titles." Note Apple's usability guidelines do not require verbs for button 
titles, but rather emphasize the value that they may bring to dialogs. 
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While we're on the topic of dialog boxes, consider this: any print publisher will 
tell you that wide blocks of text cause eye strain, because the eye has to 
navigate back and forth across such a large distance. That's why columns in 
newspapers and magazines are about 12 words across. Microsoft's dialogs do not 
adhere to this basic text layout rule, as seen here: 

 

Not to mention that it just looks bad. Wrapping the text to three lines would 
make a big difference. (True, this example is Outlook, which is not included w/
XP, but XP is replete with dialogs that don't adhere to publishing guidelines.) 

Confusing Dialogs
Frequently I run in to dialogs in XP that I have to read and reread: 

 

Notice how the second sentence does not logically follow from the first sentence. 
Consider this: if you select No, does that mean that rather playing it in "its own 
window" that it will play it in the current window? It turns out that if you select 
Yes, it will play it in a pane attached to the current window, something the 
dialog did not explain. If you select No, Internet Explorer will launch your default 
media player and play it in that application. 

Defenders of this dialog may say that all you have to do is click the More Info 
button for clarification. However, a rewrite of this dialog would eliminate the 
need for a More Info button: 

You clicked an audio or video link. You can play this in Internet 
Explorer or in your media player application. 

Do you want to play the item in Internet Explorer? 

That's better, however it illustrates the problem that may occur when using only 
Yes, No or Cancel as user selections in a dialog. If you want to play the link in 

http://www.xvsxp.com/dialogs/ (2 of 4)1/1/2005 5:48:02 AM



X vs. XP> Dialogs, Part 1

 

your media player, you have to answer No. 

You can have wine or water with your meal.
Would you like Wine? Yes, No, Cancel
Imagine how difficult life would be if human beings could only use Yes or No 
style questions with each other. True, the kinds of interactions we have with 
computers is significantly less complex, however the point bears 
consideration. 

The following choices for buttons would have a less negative connotation 
attached to using your Media Player and would be more logical:

Use Internet Explorer, Use Media Player, Cancel 

My redesigned dialog would look like this:

 

It's shorter, less confusing, and you don't have to read the sentences. The buttons 
are quite descriptive all by themselves, so that most users wouldn't even need to 
read the explanation.

Using buttons other than Yes, No and Cancel brings up another issue. What 
keyboard equivalents should be used for these buttons? This issue in and of itself 
shouldn't be a reason to abandon verb-based/context sensitive dialogs. The above 
dialog is vastly more sensible than the original, and most users will click the 
options with their mouse, as opposed to the small group that will use keyboard 
equivalents. It's a bad idea to have a dialog that could be more confusing to 
everybody in order to accommodate a small minority who will navigate the dialog 
with their keyboard. Button selections could be made here by using the left and 
right arrow keys, or a letter in each button: perhaps Use Internet Explorer, Use 
media player, Cancel. One could argue that this would make dialog shortcuts less 
predictable or logical, but in the original example, how is typing N (for No) a 
predictable or logical way to play a video or audio link in your media player?

Dialog boxes: OS X: 7, XP: 5

Pick a topic:  
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Dialogs, Open and 
Save 

 

Both OSes allow you to type the first letters of a file or folder in an Open or Save 
dialog box to select that item. In Save dialogs for both OSes you can click on a file 
listed and the file name text box will be auto-populated with the file name of the 
file you clicked on (this is new to OS X with Panther). Both OSes allow you to create 
folders from within Open/Save dialogs. 

OS X: Open and Save dialogs respond to OS X's keyboard shortcuts for accessing 
common places: 

Shift- -D, Desktop ( -D also works)
Shift- -H, Home
Shift- -C, Computer
Shift- -U, Utilities
Shift- -A, Applications
Shift- -I, iDisk
Shift- -K, Network

as well as a few navigation shortcuts:
Shift- -up arrow, Enclosing Folder
Shift- -[, Back
Shift- -], Forward
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Panther's Open Dialog 

Panther's Open and Save dialogs allow you to browse your files in List View or 
Column View. Similar to Finder windows (or a web browser), Open/Save dialogs 
have back and forward buttons. Special Places are listed in the left column (users 
can add their own places to this column), and Recent Places are available within 
the pull down menu above the files pane. Notice that the entire contents of folders 
are displayed. Items that the opening application doesn't recognize (in this 
example, Photoshop) are greyed out. Also notice the recessed panel below with the 
Format options. This section was custom-added for Photoshop, and demonstrates 
how Open/Save dialogs can be customized by applications for tasks pertinent to 
that application. 

Column View permits previewing of 
items prior to opening. 

Initially, OS X's Save Dialogs are 
minimalist:
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The Where popup menu provides 
one-click access to the current 
directory, the locations listed in the 
Finder window sidebar items 
(sidebar items are completely 
configurable) and Recent Places.

Click the Where menu's expand 
button to access the expanded view 
of your computer and connected 
drives. Subsequent Save dialogs will 
retain your choice of the expanded 
or the minimalist dialog, displaying 
that view first.

You can select whether to show or 
hide the extension of the file you're 
saving. You can also create new 
folders in Open/Save Dialogs. 

Both Open and Save dialogs support drag and drop. Just drop a file or folder from 
the desktop (or any window) into your Open/Save dialog to instantly navigate to 
that location. This is a big time saving feature. 

XP: Open and Save dialogs in XP behave like standard file browser windows: you 
can create new folders as well as rename or delete files or folders. You can also 
browse your computer in 5 views: Thumbnials, Tiles, Icons, List, Details. 
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Viewing files in Thumbnail View 

XP uses a different strategy from that of OS X for displaying folder contents in Open 
and Save dialogs. Rather than dimming non-matching files, XP hides files that don't 
match the selection in the Files of type menu. Hiding files can ironically slow the 
process of navigating folders. Familiarity is an important aspect of navigating file 
systems—it's easy to get disoriented when folder contents differ from what you are 
used to. 

 
The contents my My Documents folder filtering all non- .txt files. 
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The left pane of Open and Save dialogs provides access to Recent Documents (and 
folders), Desktop, My Documents and My Computer. Though Desktop, My Documents 
and My Computer is obvious, it is counterintuitive that a button entitled My Recent 
Documents is the method by which one navigates to recently visited folders. 

The interface elements to the left of these dialogs do not seem to be system-wide. 
Microsoft's flagship Word uses different (older) elements:

 

XP: 

●     The ability to choose any file system view (Icon, List, Details, etc)
●     Rename and even delete files in Open/Save dialogs
●     Folder contents displayed differently than when in the file system leads to 

loss of familiarity, ironically slowing your navigation of the file system 
●     Applications must make an assumption about what types of files you are 

interested in (thereby hiding all other files), and (in my experience) the 
application is too often wrong. 

OS X: 

●     The Where popup bests XP at providing one-click access to recent and 
important places.

●     A full complement of keyboard shortcuts to navigate to special locations.
●     Drag folders or files onto Opens/Save dialogs to instantly navigate to that 

item
●     Listing sidebar items in Open/Save dialogs is an invaluable way of creating/

accessing bookmarks as well as popular locations.
●     Fewer views than XP (List and Column views).
●     Users may have to wade through folders with lots of greyed out files to find 

the files that they are looking for.
●     The inability to delete or rename items in Open/Save dialogs means you'll 

have to remember such changes and make them later.
●     No icon view means OS X users looking for previews must use Column View 

and click items one-by-one to get previews

Both OSes dialogs have plenty going for them, and both have their drawbacks too. 
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I'm always irritated when XP hides the files I need to see, and OS X could benefit 
from allowing users to rename or delete items from within dialogs, as well as an 
icon view to preview multiple items simultaneously. 

Dialogs, Open and Save: OS X: 7, XP: 7

Open Recent 
 

X and XP allow you to access recent items (applications and documents) via the 
Apple menu (OS X) and the Start menu (XP). 

OS X: OS X provides a system-wide "Recent Items" menu command in the Apple 
menu similar to the equivalent feature in XP. 

Apple has also provided a simple method for cocoa developers to include an "Open 
Recent" menu in their applications. While this does not guarantee that application 
developers will take advantage of this feature (Microsoft Office for the Mac has a 
custom-built "Open Recent" feature) it does make it more likely that applications 
will have that feature (since developers don't have to code it themselves) and it 
provides consistency from application to application for apps that use it. 

Most of the apps supplied with OS X that I tested used this feature (Script Editor, 
QuickTime, Preview, iMovie). Apps that lacked the feature lacked it for good 
reason: Safari aptly has a History menu rather than an Open Recent command. 
Supporting application will display a list of files recently opened by that 
application. A Clear Menu command is provided for those of us who like to hide our 
tracks. ;) 

Below is an example of OS X's Open Recent menu. Notice that paths are only 
displayed when they are required to differentiate between files with the same 
name. And when they are displayed, the end of the path is displayed, so that it is 
quite clear for these two files (see screen shot) of the same name, one resides on 
the Desktop and the other resides in the scripts folder. 

Script Editor for X's Open Recent Menu 

XP: XP has a My Recent Documents button in Open and Save dialogs. This button 
displays the contents of your Recent folder, but only displays files that the current 
application can open. Application developers wanting recent items to be displayed 
in the File menu (Microsoft Office does this) need to add that functionality into 
applications themselves. You can access recent applications and documents from 
the Start menu, however this menu is not application specific and therefore retains 
a much shorter history. 

I tried to understand the logic behind how Microsoft's Word and PowerPoint displays 
recent items, but with three screen shots I got three seemingly different methods: 

http://www.xvsxp.com/dialogs/open_save.shtml (6 of 7)1/1/2005 5:48:07 AM



X vs. XP> Dialogs, Part 2

In the first example, Word 
shows the drive letter, maybe 
some of the path, and some of 
the file name. Notice when 
the path would have helped 
to differentiate #2 and #3, XP 
failed to display the path. 

In the second example, PowerPoint doesn't display the drive letters. It is unclear to 
me why XP chose to display drive letters sometimes but not this time. 

In the third example, Word displayed the beginnings of paths. Notice how the 
beginning of the path provides no indication of which "test" file is on the Desktop 
and which is in My Documents. 

XP's My Recent Documents buttons displays more recent items than OS X's, but OS 
X's method requires fewer clicks to access a recent item. XP's lack of recent items 
in the File menu has led third party developers (even Microsoft themselves) to 
attempt to build such functionality directly into their software, leading to 
unsatisfactory and inconsistent results. 

Open Recent: OS X: 9, XP: 6

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Home Donate/PDF 
Version 

Final 
Score 

Discuss  Categories:  

Drag and Drop

Let's take a look at how these 2 OSes implement Drag and Drop: 

 Fully supported.
 Support is mediocre (incomplete, inconsistent or doesn't behave as one would expect.)
 Not supported. 

XP OS 
X 

Drag Action/Notes 

  Drag highlighted text from one section of a document to another.

XP Moves the text. Some apps do not support this: NotePad, Command Prompt.

OS X Moves the text (In Terminal, copies the text). 

●     Click and hold for half a second before dragging in Cocoa apps (TextEdit, Mail, 
Stickies, Script Editor and Help). 

Because it's not obvious which apps are Cocoa apps in OS X, this interface inconsistency is 
made even more frustrating. 

Drag highlighted text from a document onto the desktop. 

XP Not supported in NotePad or Outlook Express. Dragging from WordPad creates a scrap object, 
that can only be dragged back into WordPad. (Dragging scrap objects into NotePad displays 
garbage text.) No other apps support dragging text to the desktop. Word supports scrap 
objects. Dragging a scrap object into an Outlook Express message attaches it as a file. 

OS X Creates a clipping of that text that can be dragged into other documents to be reused. If 
dropped into an application that supports rich (styled) text (AND created from an app that 
supports rich text), then the text will retain its formatting, otherwise the text will be used w/
out formatting. Implementation varies from app to app: 

●     Dragging from Safari creates a clipping of un-styled text. 
●     Click and hold for half a second before dragging in Cocoa apps (TextEdit, Mail, 

Stickies, Script Editor and Help). 
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Drag highlighted text from one document to another. 

XP Cuts the text and pastes it into the receiving document. 

●     NotePad and the command prompt do not support dragging or receiving dragged text. 
●     Help supports dragging as well as cut and paste, but in either circumstance images and 

font information are lost. Numbered lists lose their numbers when being dragged to 
WordPad. 

MS Office behavior: Dragging text from WordPad to Word cuts the text from WordPad and 
pastes it into Word as a WordPad object, with bounding boxes, that can only be edited by 
double clicking the box to open it up in a 'mini WordPad editor', thereby prohibiting the full 
range of editing tools found in Word. 

OS X Copies the text into the receiving document. 

●     Click and hold for half a second before dragging from Cocoa apps (TextEdit, Mail, 
Stickies, Script Editor and Help). 

I think it makes more sense to have the text be copied from document from another, as in the 
circumstance where you're quoting something from a doc to put into an email.

Drag selected text from within a web form <textarea> to a different location w/in the web form. 

XP Moves the text.

OS X Moves the text (Safari). In Mozilla and OmniWeb, moves the text. Not supported in Internet 
Explorer. 

Drag a URL from a text document onto a web browser window. 

XP Not supported in Internet Explorer. (Apps tested: NotePad, WordPad) WordPad to Mozilla 
works. 

OS X Opens the URL in the window. (Apps tested: Stickies, TextEdit)

Drag image from a web page into another web browser window. 

XP Displays image in new window and path to image in local cache in Address box.

OS X Displays image in new window and path to image on server in Address box.

From a web developer's perspective, the path to the image on the server is more important than the 
path to the local cache. 
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Drag image from a web page onto your desktop. 

XP Behavior varies. If the image is enclosed w/in a hyperlink, a shortcut to the hyperlink is 
dragged to the desktop. Otherwise, the image is copied to the desktop.

OS X Copies the image onto your desktop. The image (in ghosted form) drags with the mouse to 
indicate the action that is about to occur.

Web developers dragging images from web pages are most likely trying to copy the image, therefore 
creating a shortcut is less useful. 

Drag an item onto an icon on a window's toolbar or sidebar. 

XP Though XP doesn't support dragging icons onto a window's toolbar, you can drag icons onto a 
windows Links bar to add them. However, these icons don't behave as true proxies: you cannot 
drop an icon onto a folder icon in your Links bar in order to move that item into that folder.

OS X  

Moves the item there (if it's a folder shortcut) or opens the item w/that shortcut if 
it's an app.

Drag an item between icons on a window's toolbar or sidebar. 

XP Not supported.

OS X After a short pause, other toolbar icons will slide out of the way so that you may permanently 
add this item to the toolbar. Sidebar items can be added immediately (a horizintal blue line 
appears, indicating where the item will be added). 

Drag an opened folder's icon from its location above the window's toolbar. 

XP
Creates a shortcut of the folder wherever you release. Hold down the 
Ctrl key to Copy. 

OS X

Moves the folder to wherever you release. (Wait for the icon to highlight before dragging. This 
helps prevent accidentally moving a folder.) Hold down the Option key to to Copy. Hold down 

-Option to to make an alias. 
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Drag a file or a group of files into an email message window. 

XP OE attaches them to the message.

OS X Mail attaches them to the message.

Drag a folder into an email. 

XP Outlook Express displays an error stating that directories cannot be dropped into mail 
messages. It then asks if you would like to make a shortcut to the directory. Outlook also 
exhibits this behavior.

OS X Mail attaches the folder and its contents to the message.

Drag a group of items into a document other than email. 

XP Dragging a list of items (as well as copying and pasting that group) attempts to paste the 
contents of the items into the document. If the list contains a folder, an error will be 
generated. If the application does not support styled text and the items being dropped 
contain styled text or are images, garbage text will be pasted. In Command Prompt, the path 
to the item you first dragged will be pasted. Other selected items will be ignored. 

OS X Attempts to paste the contents of the items into the document. If the items are folders, it 
asks you if you want to copy or alias the enclosed contents. 

(Copying and Aliasing appear to perform the same function, which is to display the folder's 
icon in the document [Stickies, TextEdit]). If the application does not support styled text, the 
icons 'slide' back to their original position, indicating that the action is not permissable. In 
Terminal, the paths to all of the documents will be pasted. 

Note: Copying and pasting a group of files pastes a list of the files. 

If the item is an application, XP becomes unresponsive, requiring a force quit to the application 
recieving the dropped item. In OS X if the item is an application, X will paste the icon of the application 
(TextEdit, Stickies). If you drop a package-style application in BBEdit, it pastes a directory listing of the 
contents of the package. 

XP has no way of pasting a list of items from a window into a document. 

Drag a picture into your Desktop Picture control panel. 

XP Not supported.

OS X Sets it as your desktop picture.
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Drag a picture from the desktop into your login options to customize your User icon. 

XP Not supported.

OS X Sets the picture as your login picture.

Drag a document onto an application icon in the Dock or Taskbar. 

XP The taskbar is divided into Quick Launch icons and minimized (or available) windows. These 2 
sections behave differently when dropping an item on them. 

Taskbar Quick Launch icons do not highlight to indicate whether such an action is possible. 
When released over a supporting application, the document opens w/in that application. 
When released over a non-supporting application, an error message is generated that requires 
your attention to dismiss. Not all file types behave predictably. For instance, an .htm file can 
be dropped on a FrontPage Quick Launch icon, but not an Internet Explorer icon, even if 
Internet Explorer is set as the default application for .htm files. Third-party note: Text files (.
txt) cannot be dropped on a Word Quick Launch icon or desktop shortcut even though Word is 
capable of opening such files. 

When dropping a file onto a minimized icon in the toolbar an error message is generated 
saying, 

"You cannot drop an item onto a button on the taskbar.

However, if you drag the item over a button without releasing the mouse 
button, the window will open after a moment, allowing you to drop the item 
inside the window."

If a .txt file is dropped into an existing Word window, the contents of the file are pasted at 
the cursors insertion point. The only way to open a .txt file in Word via drag and drop is if the 
Word window is open yet no documents are open w/in Word.

OS X Dock icon will highlight to indicate whether the application can open that file type. When 
released over a supporting application, the document opens w/in that application. When 
released over a non-supporting application, the icon 'slides' back to its point of origin, 
indicating the abandonment of an action. Hold down -Option while dragging over an app 
that doesn't recognize this file in order to force that app to open that document. 

OS X provides more feedback at the appropriate time, and avoids error messages that must be attended 
to. OS X users can also use this as a method of controlling which application in which to open an item. 
XP users cannot. 
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Drag reorder Control Strip or Tray items. 

XP Not supported. 

OS X With the  key depressed, dragging left or right 
reorders items (other icons slide out of the way to 
visually reinforce what will occur when releasing 
the mouse key). Dragging downward off of the menu bar removes the item from the Control 
Strip, and it vanishes in a puff of smoke (yes, an animated puff of smoke really happens!).

Drag reorder of items in any file system window's toolbar (or sidebar). 

XP Not supported. 

OS X With the  key depressed, dragging left or right 
reorders items (other icons slide out of the way to 
visually reinforce what will occur when releasing the 
mouse key). Dragging off of the tool bar removes the item from the tool bar, (no puff of 
smoke this time). Sidebar items can be reorganized or removed without pressing any 
additional key. 

Drag reorder of Dock or Taskbar icons. 

XP Quick Launch items will be reordered when moved left to right. An I-bar appears to visually 
indicate where the icon will be placed when the mouse button is released. Dragging an icon 
off of the Quick Launch bar moves it from the bar to wherever you let go. 

OS X Dragging left or right reorders items (other icons slide out of the way to visually reinforce 
what will occur when releasing the mouse key). Dragging off of the Dock removes the item 
from the Dock, (yes, puff of smoke this time). With the  key depressed, dragging an item off 
the Dock will move it to whereever you let go. 

Drag an item into or out of the Start menu. 

XP Items can freely be dragged into or out of the Start Menu. When dropping an icon onto the 
menu, it will pop up, allowing you to navigate to valid submenus and release your icon, 
moving it to that location. Drag with the right mouse button and release, and a contextual 
menu will appear giving you choices. The choices seem to vary- sometimes they are Move Here 
or Cancel, other times they are Copy Here, Move Here, Create Shortcuts Here, Cancel. Still 
other times no choices are given at all. 

Although icons can be dragged in to the Favorite Applications (The section above the All 
Programs button) section of the Start Menu, they cannot be dragged out. To remove them, 
right-click and select Remove from This List. 
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OS X Since OS X has no close corollary to the Start Menu, such a comparison is a stretch. X's Apple 
Menu does not perform the same duties as XP's Start Menu. Particularly XP's Start Menu is used 
as quick access to all applications. An equivalent function can be achieved in OS X by placing a 
shortcut to the Applications folder in the Dock. Icons dragged onto this Dock item will be 
moved into the Applications folder (or copied there if being dragged from a separate volume). 

Drag an item onto a folder. 

XP Releasing immediately moves the item into the folder. In Explorer View only (Click the Folders 
icon in the toolbar) folders will spring open after a short delay, allowing you to navigate to 
sub folders. You can continue opening 'spring loaded' folders until you've arrived at where you 
want to release the item.ÊIf you accidentally open the wrong folder it will remain open until 
you close it manually. 

OS X Releasing immediately moves the item into the folder. In all views folders will spring open 
after a short delay, allowing you to navigate to sub folders. You can continue opening 'spring 
loaded' folders until you've arrived at where you want to release the item. If you've 
accidentally opened the wrong folder, just drag your item off of the folder and it will close. 

Though XP technically does what one expects the OS to do, OS X one ups XP by having spring loaded 
folders in all views, and by allowing folders to also 'spring closed' when you drag off of them. 

Drag a file onto a printer icon. 

XP Varied results. File formats tested: .txt (works), .doc(opens Word, prints, closes), .pdf
(works), .jpg (prints, fills page), .gif (error message). 

OS X Prints the item to that printer, without a print dialog. The lack of a print dialog may lead to 
undesirable results. For instance, I dragged a PDF onto a printer and it printed, but it failed to 
scale the output to fit the page. 

Drag a vCard into your Address Book 

XP Allows you to review the card before adding it to your Address Book. If the Name AND Email 
are the same then it considers it a duplicate and asks you if you'd like to update your card. 
Your only choices are yes or no. If just the name is the same as an existing card it is not 
considered a duplicate, so it is imported. 

OS X Notifies you that it will add the card to your Address Book. If 
the name of the person in the incoming vCard matches a 
name of a person in your address book, it is considered a 
duplicate card. In that case it asks you if you would like to 
review changes or update your original. If you want to 
review changes you are presented with a visual comparison 
of the two cards. You can review the differences and select 
which to keep (Keep Old, Keep New, Keep Both, or Update 
(old with new). 
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Drag a person from your Address Book to your IM buddy list. 

XP Not supported. 

OS X Adds that person to your buddy 
list. 

Drag folder onto a printer icon 

XP Not supported, though this functionality can be created via a script. Create a script with the 
following code:
dir /oed %1 > prn.
Drag a folder onto that script's icon to print the folder contents. 

OS X Prints a list of the folder contents (with a dialog, so you can save as PDF).

Drag a folder to the side of the screen 

XP Creates a toolbar from the folder

OS X not supported

Drag a URL from the Address bar to your Favorites/Bookmarks 

XP Adds the link to your Favorites

OS X Adds the link to your Bookmarks

Drag an HTML file (saved from your web browser) from one folder to another 

XP An associated folder containing all the images that go with the HTML file will move with it.

OS X Safari only saves the HTML when saving a web page, not the images.

Drag a file and drop it onto the "interface chrome" of an open application's window 

XP Opens the file in the application

OS X Not supported
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Drag an image file (even a PDF image) onto a person's image placeholder in Address Book 

XP Not supported

OS X Displays a dialog where you can crop the image (with the slider), 
or (if you have a webcam connected) take a video snapshot, or 
choose an image in the file system. 

Drag a song from your music player's library (iTunes/Windows Media Player) into a video project 
timeline (iMovie/Windows Movie Maker). 

XP Not supported

OS X Imports the song into your project and places it at that 
point in the timeline of your project.

If we rank  as 2,  as 1, and  as 0, XP 28 gets points, and OS X 51 gets points, out of a possible 62 points. 

Though neither OS can claim perfect intuitiveness when it comes to drag and drop, OS X has the edge in terms of its 
depth of implementation, flexibility with the user, and intuitiveness in terms of acting as you would expect it to. 

Some more Panther Drag and Drop tidbits 

●     Drag a Preference Pane onto System Preferences to install it. (only works w/simple preference panes.)
●     Drag a URL onto a tab in Safari's tab bar to open the URL in that tab
●     Drag a URL into the blank patch in Safari's tab bar to open the URL in a new tab

A matter of personal preference?
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More than one PC user has mentioned that they prefer cut and paste. And on Windows XP I prefer cut and paste too, 
not because cut and paste is an inherently superior method, but rather because XP's poor support for drag and drop 
has trained me avoid it altogether. But on Mac OS X—which has more thorough support for drag and drop—I use each 
method interchangeably depending on what best suits the current situation. 

Drag and Drop: OS X: 8, XP: 5 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Home Donate/PDF 
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Final 
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Discuss  Categories:  

Copy, Cut and Paste

Copy, Cut and 
Paste

Both OSes offer excellent (though not flawless) support for Cut, Copy and Paste as the 
preferred way to shuttle data from one location to another. Both offer several equivalent 
ways to execute these commands: Choose the command from the current application's Edit 
menu, choose the command from a contextual menu, type the keyboard shortcut for the 
command, and (sometimes) drag and drop or option-drag and drop (to Copy and Paste in 
one sweep). Drag and Drop is covered elsewhere. OS X Note: Cocoa apps also support some 
vi shortcuts familiar to Unix users: Cut (Ctrl-k) Paste (Ctrl-y).   

Let's take a look at the areas in which these 2 OSes implement Cut, Copy and Paste 
differently: 

 Fully supported.
 Support is mediocre (incomplete, inconsistent or doesn't behave as one would expect.)
 Not supported. 

XP OS X Cut and Paste Action/Notes

Select a number of files/folders in the file system, Copy. Paste into 
TextEdit/NotePad.

XP Not supported

OS X Pastes a list of the file names

Select some text in a text document and Copy. Paste onto Desktop.

XP Not supported (Apps tested: NotePad and IE). Supported in 
Outlook: creates a scrap object.

OS X Not supported

Cut/Copy/Paste within Terminal/Command prompt.

XP Copy and Paste are only available via a contextual menu.

OS X Supported
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Cut/Copy/Paste items in the file system.

XP Supported

OS X Partially supported. Cut not available in the file system.

Cut/Copy/Paste within Open/Save dialogs

XP Supported

OS X Not supported

Cut/Copy an image and Paste into a chat session.

XP MSN Messenger sends the image as a file transfer, with a 
thumbnail attached. 

OS X

Pasting into iChat pastes the image (and can be viewed 
inline in the chat session). screen shots in the clipboard 
cannot be pasted into iChat sessions. Instead, save to a 
file then drag onto buddy's icon to send. 

Select a portion of a web page from within a browser window and Copy. 
Paste into a document that supports rich text.

XP The document's formatting is preserved. (images are 
preserved, font, font weight and color are preserved, 
tables and backgrounds are preserved) (Apps tested: 
Outlook Express) 

OS X The document's formatting is somewhat preserved. 
(images are preserved, font, font weight and color are 
preserved, tables and backgrounds are lost) (Apps tested: 
TextEdit, Stickies, Mail) 

Copy a folder. Paste into a new mail message.

XP Outlook Express displays an error stating that directories 
cannot be pasted into mail messages. It then asks if you 
would like to make a shortcut to the directory. 

OS X Attaches the folder to the email. 

Copy a picture. Paste into your login options to customize your User icon.

XP Not supported. 

OS X Sets the picture as your login picture. 
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Change a file or folder icon via cut, copy, paste

XP Not supported. Icons can only be changed by browsing the 
file system and selecting them. 

OS X Supported. 

Additionally, OS X users can cut an image file and paste onto a person's image placeholder 
in Address Book (XP lacks images for address book entries).   

If we rank  as 2,  as 1, and  as 0, XP 11 gets points, and OS X 14 gets points, out of 
a possible 20 points. 

Cut and Paste: OS X: 7, XP: 6 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Discuss  Categories:  

Desktop/Windows

Maximize 
vs. Zoom

"How come the Mac's "Maximize" button doesn't actually Maximize things?"
It's because Mac OS X doesn't have a Maximize button, it has a Zoom button. 

OS X: Ok, so why is it that Mac OS X's Zoom button doesn't enlarge windows so that they fill the 
screen? 

Apple's philosophy is that a maximized environment is inherintly inefficent since it makes 
dragging content from one window to another extremely cumbersome (read the section on Drag 
and Drop). Many types of documents are vertically oriented (like a printed page) yet monitors are 
wider than they are tall. So—for instance— it doesn't make sense for a word processing document 
to fill the width of the screen. 

The Zoom button toggles its window between 2 states, the standard state and the user state. 
The standard state is determined by the manufacturer of the program being used. Apple's User 
Interface Guidelines provides this sensible direction to programmers for deciding the standard 
state of a window: 

"Don't assume that the standard state should be as large as possible; some monitors 
are much larger than the useful size for a window."

Individual Mac users can then determine the user state of their window (by manually resizing the 
window), and then use the Zoom button to toggle between these 2 states. Unlike XP's Maximized 
windows, Zoomed windows can always be resized from their resize handles (in the lower right 
corner). 

Bonus Zoom Features: Some apps contain a "mini-mode". In those cases, the Zoom button 
toggles between the user defined state and the mini-state. ITunes (seen here) has a real-
estate saving mini-state. 

 
Mini iTunes

XP: A maximized window in XP suffers from a couple of usability gaffs. First, maximized windows 
block windows behind it, thereby making drag-and-drop of content between windows extremely 
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cumbersome (though not impossible). Second, in a maximized state, a window cannot be 
resized. I can't tell you how many times I've watched people (including myself and even a former 
Microsoft software developer!) trying to resize a maximized window. I've similarly witnessed 
(myself and others) clicking the maximize button hoping that it will unmaximize a window even 
though the window was already unmaximized (though it filled the screen anyway). The result is 
that the window gets maximized, which is what I didn't want in the first place, so I have to click 
the button again. One may counter, "just look at the maximize icon to discover the window's 
current state". I would agree with that except the urge to click the button in hopes that it will 
acheive the desired state occasionally occurs faster than the comprehension of what an icon 
depicting either one or two squares means. I would not mind the fact that maximized windows 
cannot be moved or resized so much if it had some real benefit, but it doesn't. It would be nice to 
be able to unmaximize a window simply by dragging a corner or edge, thereby combining what is 
currently to steps (1) unmaximize, 2)move/resize) into one. 

It seems that in XP the user state IS the standard state (initial dimensions and position of a 
window). Once a user sets a user state (simply by resizing/moving the window) that becomes the 
"default" state for all windows in that application. You can then quit and relaunch that 
application and new windows will be created in the user state.

Though I can see the logic behind allowing the user state of a window to become an application's 
standard state, I do not agree with it. Just because I may be working with a scrunched up window 
one day does not mean that I necessarily want it that way the next day. I think it makes a 
tremendous amount of sense for new text document windows to initially appear roughly the size 
of a piece of 8.5x11 paper. However, I can also understand the opponents of Apple's treatment of 
windows— who says a programmer knows what's best for me?

OSX: Zoom 

●     Drag and drop is easier 
●     Multitasking (working with multiple applications simultaneously) is easier 
●     Zoomed windows can be moved/resized 
●     Increased screen clutter 
●     Unintentional mouse clicks outside of the zoomed window will cause the window to lose 

focus 

XP: Maximize 

●     Reduced screen clutter
●     It is impossible to lose focus of the maximized application by unintentional mouse clicks 

along the screen edge
●     Drag and drop is more difficult (though not impossible) 
●     Maximized windows thwart multitasking by only showing one application at a time 
●     Non-maximized windows in XP do not honor Fitt's law w/regards to screen edges (for that 

matter, nor do XP's maximized windows) 
●     Only Maximized windows benefit from muscle memory 
●     Maximized windows cannot be moved or resized. This may seem like a trivial complaint, 

except that it is often difficult to discern whether a window is maximized or not. I've 
witnessed advanced XP users repeatedly click the maximize button on a window because 
they couldn't tell whether or not the window was maximized or just filling the screen but 
not maximized. If you want to move or resize a maximized window, you must first un-
maximize it, then move or resize it. 
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Maximize vs. Zoom: OS X: 7, XP: 7 

Navigating 
the file 
system

XP: XP sports no fewer than 6 views— Thumbnails, Tiles, Icons, List, Details and Filmstrip (in My 
Pictures or folders that contain just images, or folders that you've customized to be a Pictures 
folder [only folders that you create can be customized this way, not system or other special 
folders]) The abundance of views occasionally seems unnecessary. 

For instance, XP cannot natively view the contents of nested directories in a window's List or 
Details view. Instead, users must click the Folders button in the toolbar to bring up a Windows 
Explorer style view in the left pane. The differences between Icons, Thumbnails and Tiles views 
are subtle, making it easy to confuse the views, or not know which view you need. I would like to 
see them combined into one view. 

Ambiguous Views 
Which View is this 
window in? The button 
in the toolbar to 
switch views doesn't 
indicate the current 
view. (The answer at 
the end of this 
section). 

The blue highlighted button in the 
window's toolbar clearly denotes that 
this window is in List View. 

The button to select different views does not visually denote which view you are currently in, so 
you must click the button to reveal the drop down menu to view your current selection. (I had to 
do this repeatedly to discern the differences between Icons, Tiles and Thumbnails views and List 
and Details views). 
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Thumbnails View will display image previews instead of icons for images, and even HTML files, 
which is impressive. Further, a folder in Thumbnails view will display up to four thumbnails of 
enclosed images or movies. 

Tiles View will display such previews in the Details pane, displaying the file's icon as-is. So, for 
instance, if you have a jpeg file with no custom icon, you will see the generic circle-square-
triangle icon for the file, while the image preview displays in the details pane. This view doesn't 
seem to have much value over Thumbnail View, except that it is more real estate efficient. 
Readers have also pointed out that Tiles View displays meta information about a file. This is 
important in XP because a file's name is often not its name. For instance, Outlook Express is 
named msimn.exe. Internet Explorer is iexplore.exe. Use Tile View to match file's names with 
their names. For those readers that would like to argue that there's nothing inherintly bad about 
the fact that application names don't match application names, Microsoft is working on this "non-
issue" for its next release of Windows (code named Longhorn), due out late 2006ish. 

 
Tiles View displays file meta data. For instance, wabmig.exe is Microsoft (R) Address Book Im... 

(or roll over it for the full name) 

Icon View is what you would think it is. Displaying the contents of your window primarily by icon. 
As with other views, you can sort by Name, Size, Type, or Date Modified. You can 'Show in Groups' 
which will group icons based on your sort criteria. For instance, if you choose to group by 
Modified, it will create groups called "Today, Yesterday, Earlier this week, Last week," etc., and 
place your icons w/in their appropriate groups. (This feature is available in other views also). One 
complaint I have about Icon View is I found its ability to arbitrarily place icons within a window to 
be flaky. The way you're supposed to enable arbitrary placement is by unchecking Align to Grid 
and Auto Arrange (in the window's contextual menu- accessed by right-clicking within the 
window). For some reason, this worked for me once, but when I change my view then went to 
change it back, it didn't work for me a second time. Icons continued to snap to a grid, even 
though both Align to Grid and Auto Arrange were unchecked. 

List View is pretty much what it's name says, listing files. 

Details View like list view, but showing additional columns for things like Size, Type and Date 
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Modified. Double-click a column header to automatically resize that column to fit the data 
displayed. If you're looking at a folder of pictures, you'll also see columns for Date Picture Taken 
and Dimensions. (Although OS X can display image dimensions in icon view, OS X doesn't display 
that information as a sortable column in List View. OS X users must use iPhoto to view the date a 
picture was taken). 

Filmstrip view will display previews of images and offers rotate 
buttons, but confusingly it's only automatically available if your 
folder contains ONLY images, except for your My Pictures folder, 
which can also contain non-images. You can manually customize 
folders that you create (rather than system folders and other special 
folders) to behave as pictures folders (Right-click, Properties> 
Customize>What kind of folder do you want?, select Pictures.) Mac OS X support for 128x128 icons 
makes it easier to identify images when in Icon view, however Filmstrip's ability display large 
previews of images directly w/in the file system is considerably more useful for identifying 
images. Furthermore, the ability to start a slide show of a folder from within the file system is a 
wonderful feature that X lacks. X users need to launch iPhoto to watch slideshows. 

OS X: X has 3 views for windows: Icon View, List View and Column View. 
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Icon View (seen here in compact mode) 
for OS X can optionally automatically line 
up icons or you can freely arrange them. 
Icon view can display icons small or large 
(128x128), and if a custom icon is not 
available, this view can be set to display 
image previews (View>Show View 
Options>Show icon preview) instead of 
the custom icon. Unlike XP, X cannot 
display HTML previews. 

While in List View X users can expand 
and collapse nested folders to view their 
contents. Display of image previews is 
not available in List View. However, List 
View will display custom icons if 
available. Additional columns of 
information are optionally available: 
Size, Kind, Date Created, Date Modified, 
Version, Label and Comments. 

Column View displays image previews when the item is selected. You can even play music and 
movies in the preview pane. 
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Column View 

OS X allows you to label items, giving them a highlight color: 

 
3 labeled items, one orange, two blue. One blue item is selected. Its label appears as a blue 

circle. 

XP users can acheive a "poor mans labels" via file comments. Add comments to a file, then display 
the comments column in Details View. 

Both OSes have toolbars at the top of their windows. OS X's toolbar can be customized so that any 
file or folder can be placed as a shortcut w/in the toolbar (not so for XP). These icons behave as 
full fledged shortcuts: drag a file or folder from within a window onto the Applications icon in the 
toolbar and you've now moved that item into the Applications folder. 
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Mounted drives, PC cards and network volumes sport eject icons in 
Finder window sidebars; Burn buttons appear next to unwritten CD-
Rs. 

While I give XP credit for Filmstrip View and the ability to sort pictures by their dimensions, the 
other assets of XPs file system navigation do not outweigh its liabilities, namely the unnecessary 
complexity and inconsistency of the interface and its features. While Apple lacks an equivalent to 
Filmstrip view (though other methods are available: open multiple items in Preview, set your icon 
view to 128x128, or use iPhoto), Apple accomplishes in 3 views (Icon, List, Column) the 
functionality that takes Microsoft 5 views (Thumbnails, Tiles, Icons, List, Details). 

The answer to Abiguous Views: Tile View.

Navigating the file system: OS X: 8, XP: 7

Sorting in 
the Filing 
System

Thanks to Thomas Davie, XP_User and DaGUY for help with this section 

Both OSes can sort file system window contents by Name, Size, Type, Date Modified, Comments 
and Product Version. When sorting by name, both OSes perform an alpha-numeric sort on your 
files— when it encounters numbers it will sort them numerically (0, 01, 1, 02, 2) rather than 
alphabetically which would result in 0, 01, 02, 1, 2. 

 
Folders created in XP remain at the end of 

the list until refreshing (F5). 

XP: XP allows sorting in all of it's views. In 
addition to Name, Size, Type and Date Modified, 
XP can also sort by these other criteria (OS X 
cannot) 

●     Attributes 
●     Status 
●     Owner 
●     Author 
●     Title 
●     Subject 
●     Category 
●     Pages 
●     Copyright 
●     Duration (can also apply to videos) 
●     Protected 
●     Camera Model 
●     Date Picture Taken 
●     Company 
●     Description 
●     File Version 
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●     Product Name 

"My Computer" has different sort capabilities (because you can't store files there). It can be 
sorted by Name, Type, Total Size, Free Space, Comments, and File System. 

In Tiles view the metadata that's shown for each icon changes depending on the sort option. For 
example, if you have a folder in Tile view and you sort by Owner, the Owner metadata is 
displayed instead of the file size. IF you turn of Show in Groups, however, the tiles will return to 
showing the standard type and file size m 

You can right click on column headings and choose which columns you want visible (in OS X, you 
have to go into View Options). Type Ctrl-+ (on the numpad) to automatically resize all the 
columns so that all their information can be read. 

Renaming an item, or creating a new item will disable your selection for sorting files. 
Unfortunately, this will not remove your selection in the menu, resulting in an ambiguous 
behavior—the menu says it's sorted by name, and yet it isn't.

XP will always split listings into a folders section and a files section, each of which is sorted 
separately. This allows you to quickly see your folders, at the top of the screen. When reversing 
the sort order folders jump to the bottom, losing any possible benefits of having folders at the 
top of the screen.

Folder Types in XP
Thanks to XP User for help with this section 

Understanding sorting in XP requires an understanding of XP's folder types. XP has 7 folder 
types (Documents, Pictures, Photo Album, Music, Music Artist, Music Album, and Videos). 
Each folder type has its own default view, details list of sortable columns, and tasks that are 
accessible from the side panel. XP has 32 different built in detail categories that can be used 
to sort data. Rather than show all 32 columns of data, XP displays the appropriate data 
columns based on the type of folder you're in. 

When you first fill a folder with files, XP attempts to "guess" the folder type based on what 
kind of files predominate the folder. For example, if you create a new folder and put 7 mp3s 
in there and 5 images, XP will assume the folder is a music folder and set the defaults 
accordingly. To change the folder type, go to the menu View> Customize This Folder 
and select the correct folder type. 

You can change how the folder appears manually using the Views button (or right clicking 
within the folder). To change the details that are available, go to the menu View> Choose 
Details... . You can select what sort criteria you want activated, and in what order you 
want them displayed. You can also set how large you want each column to be in Details view. 

XP can also sort by extra details about certain types of files. For instance, it can sort MP3 
files based on the tags specified in them, and it can sort photos by the Date Taken or 
Dimensions. 

XP also offers the ability to group files (in all views except for List View).

OS X: OS X allows sorting in List view and Icons View. Column view is always sorted by name. OS X 
can additionally sort by Date Created and Label (add the Label column from Show View 
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Options, -J). OS X cannot sort MP3 files by their tags in the file system, requiring users to 
perform such sorts in iTunes. OS X users cannot sort images by dimensions. 

XP's greater quantity of sort options is impressive. X cannot sort while in Column view, lacks the 
ability to group files, lacks keyboard shortcuts to autosize columns and its selection of sort 
criteria looks meager when compared to XP's. Though I can appreciate X's insistence on 
maintaining sort order when creating folders, it is often a nuisance to have to chase newly 
created folders that leave your view to dutifully insert themselves into proper sort order. 

Sorting in the Filing System: OS X: 6, XP: 9

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
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XvsXP.com is owned and operated by Dan Pouliot. 
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Files

Files, Folders, Copying 
 

Copying Files:
Both OSes have "smart copy" protections when moving files into a folder containing 
other files with the same name. 

 
Replacing files in OS X 

 
Replacing files in XP 

OS X: 

●     Check Apply to All and press Don't Replace to preserve all original duplicates in 
the destination location.

●     Doesn't display file dates or sizes. Users may need to compare the file sizes and 
dates in the file system.

XP: 

●     The official method of preserving all original duplicates in the destination 
location is not instantly evident. Hold down the Shift key and the No button 
becomes No to All.
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●     Displays file sizes and dates modified to help you determine which file to keep.

Copying Folders:
OS X and XP behave differently when copying a folder into a location containing 
another folder of the same name. 

XP will examine the contents of both folders and will display its smart copy dialog to 
help you determine which files to overwrite: 

 
Replacing folders in XP 

OS X won't perform such comparison, and will entirely replace the contents of the 
original folder with the contents of the folder being copied. 

 
Replacing folders in OS X 

When copying folders containing application resources, OS X's behavior is a good thing. 
In the above example, I was performing a drag-upgrade of Microsoft Remote Desktop 
Connection. If OS X had left any items from the previous folder the upgrade folder 
would contain items from the application's previous version, and that would be a bad 
thing. Since XP doesn't support drag-installs, this is unlikely to be an issue for that OS. 

OS X: 

●     OS X's dialog assumes that you realize that replacing a folder also means 
replacing the entire contents of the folder

●     OS X lacks a simple method of merging the contents of two folders
●     OS X's method works well when you want to replace the contents of one folder 

with another.

XP: 

●     Smart folder replace is an excellent method of "merging" the contents of two 
folders

●     While XP's file copying checks time stamps, XP's method of copying folders 
doesn't seem to take time stamps into account, possibly allowing you to 
overwrite a newer file.

●     XP's dialog does not tell you what will happen to files that do not contain the 

http://www.xvsxp.com/files/ (2 of 11)1/1/2005 5:48:28 AM



X vs. XP > Files

same name.
●     XP's method does not allow you to completely replace the contents of one 

folder w/the contents of another. To completely replace one folder with 
another, you must delete the original folder.

Moving files/folders 
Both OSes can drag and drop files and folders to move them. In XP users can also use 
the Cut and Paste commands to move files. OS X users can move busy files— great for 
when you're downloading something and you want to move it. 

Files, Folders, Copying: OS X: 7, XP: 8

Files, Folders, Renaming 
 

Both OSes allow you rename files in the file system. Select a file and hit the Enter key 
(OS X) or F2 (XP) to begin renaming it. You can also click-pause-and-click-again on a 
file's name to rename it (hit the enter key to accept your new file name). You can also 
rename the file from within Properties (XP) or Get Info (OS X). 

XP: XP facilitates batch renaming. Select a bunch of files, right-click on the files and 
select Rename. Select a new base file name. All selected files will get the new base 
file name. Files after the first one will be numbered sequentially (in parentheses). 
Example: 

●     Hello.gif
●     Hello (1).jpg
●     Hello (2).txt

OS X: While OS X does not facilitate batch renaming directly, several useful file 
renaming scripts are provided in the Script Menu. 

●     Add to File Names
●     Add to Folder Names
●     Change Case of Item Names
●     Replace Text in Item Names
●     Trim File Names 
●     Trim Folder Names

OS X users can rename busy files, for instance, if you want to rename a file in the file 
system while it is in use by a program. 

Files, Folders, Renaming: OS X: 8, XP: 7

Compression 
 

Both OSes natively allow you to compress and uncompress zip files. Compress files via 
the file's contextual menu. 

OS X: Compress a selection of files and/or folders in X by selecting "Create Archive" 
from the selection's context menu. 

Double click a zip archive to uncompress it. Although OS X cannot password protect ZIP 
archives, it can password protect (and encrypt) compressed disk images via Disk 
Utility. Disk Utility can also be used to create Internet Enabled Disk Images. Internet 
Enabled Disk Images greatly simplify the process of downloading software from the 
internet, since such images automatically uncompress themselves (when downloaded 
via Safari) and throw away their original compressed file. OS X also comes pre-installed 
with Stuffit Expander which can uncompress a wider variety of file formats, including .
rar, .sit, .tar and more. 

XP: Compress a selection of files and/or folders in XP by selecting "Send To 
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Compressed (zipped) folder" from the selection's context menu. XP also has the option 
to password protect ZIP folders. 

Double click a zip archive to browse or modify its contents. Right-click the archive and 
select "Extract" to uncompress it. 

XP has another method (other than zip) to compress items. From a file or folder's 
contextual menu, select Properties> Advanced> Compress Contents to Save Disk Space. 
Files are compressed (items are expanded on-the-fly when opened) and denoted with a 
blue color. 

 
Got WinZip? If so, you may get this message. 

Files, compression: OS X: 6, XP: 8

Encryption 
 

Both OSes support file encryption, though each OS takes a different approach. XP 
supports per-file encryption, while X supports encryption of a user's entire home 
directory. 

OS X: Apple calls its home directory encryption File Vault. 

 
File Vault 

Turn on File Vault and your entire Home directory is encrypted. 
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XP: Windows XP Home does 
not support encryption, though 
XP Pro does. To encrypt a file 
in XP Pro, right-click the file, 
then select Advanced, then 
check "Encrypt contents to 
secure data". The owner of the 
file will be able to 
transparently open the file. 
Uncheck the box to turn off 
encryption for the file. 

Encrypting a file that is not in 
an encrypted folder will 
prompt this warning: 

Once encrypted, trusted users 
can add or remove users who 
can transparenly access the 
file. 

X's method of file encryption is quite a bit simpler than XP's, since XP requires you to 
encrypt files or folders individually. However XP allows a greater degree of granularity, 
allowing you to specify additional users that can transparently access the encrypted 
files or folders. XP's method of allowing arbitrary file encryption makes it possible to 
encrypt files outside of a user's home directory. 

http://www.xvsxp.com/files/ (5 of 11)1/1/2005 5:48:28 AM



X vs. XP > Files

Files, Encryption: OS X: 8, XP Pro: 8, XP Home: 0 

Files, handling large numbers 
of

How do both OSes deal with manipulating large numbers of files? I ran one test, 
deleting different numbers of files. The computers used in the test were a Mac G4 
400Mhz and a PC PIII 400Mhz. I tried deleting the files from the GUI, and I also tried 
deleting the files from the command line.

Command line results, deleting 1,500 files: 

●     Mac OS X, <1 second
●     Windows XP, 4 seconds

GUI Results, deleting 1,500 files: 

●     Mac OS X, 16 seconds move to trash. 3 seconds to empty trash.
●     Windows XP, 16 seconds

Both OSes were very fast from the command line, with OS X winning command line 
deletion. Both OSes also performed admirably when deleting 1500 files (the same 
cannot be said of former versions of OS X: Jaguar took 7 minutes to delete 1500 files!) 
It should be noted that delays in deletion only occurs when selecting and deleting 
individual files. If you select a folder containing the files, both OSes perform the 
deletion instantly. 

Files, handling large numbers of: OS X: 9, XP: 9

File names, forbidden 
characters

Both filesystems have certain characters that would cause problems in file names. Each 
has different restrictions on which characters are allowed and how to handle 
problematic characters. 

XP: When you try to type a forbidden character in a file's name, XP tells you: 

 

This is a very explicit and helpful message. Additionally, XP's GUI will not let you begin 
a file name with a space or a period. If you attempt to begin a file name with a space, 
the space is ignored (reader note: a workaround is available). If you attempt to begin a 
file name with a period, you get the following error: "You must type a file name". Not a 
very intelligent error message, since it assumes that a file name that starts with a dot 
must not really be a file name, but just a dot followed by its file extension. 

So what does XP do when you try to save a file from within an application's Save dialog 
box with one of these characters? 
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File name error message (from Paint application) 

XP discloses that the problem is with the file's name, but it leaves it up to you to figure 
out which character(s) is(are) the problem. In the above example I think typical users 
would assume it's the > symbol, but one can imagine examples of filenames that had 
several potentially problematic characters. 

The way XP applications handle saving files does not seem to be driven exclusively by 
the OS. I tried this same experiment with Microsft Word, and Word produced 3 
different errors depending on the different forbidden characters: some better, some 
much worse worse. I mention this not as a third-party software example, but rather to 
illustrate that the OS seems not to be in control of how Save dialogs handle forbidden 
characters. 

OS X: The colon (:) is the only character expressly forbidden in OS X file names. 
Additionally, a file name may not begin with a period. However, X does not explicitly 
tell you that colons are forbidden. When you type a colon in a file name (in the file 
system), you get the following error: 

 

This error tells me the problem is either that the file name is too long or it contains 
forbidden punctuation. Since colons are the only forbidden punctuation it would be 
nice if X just outright said not to type colons in file names.

Attempting to rename a file to start with a period (dot) yields the following error: 

 

That's a much more informative error. It tells me the dot is the problem, and it even 
tells me why. Command line junkies know that there are times when you need to 
create a file that starts with a dot. But command line junkies also know that they are 
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free to create those file names at the command line.

The forward slash character (/) is not expressly forbidden in OS X file names, but it 
could be problematic. The file system allows you to type a forward slash in file names, 
however application Save dialogs behave differently. 

The following apps produced the above "Couldn't Save Document" errors when 
attempting to save a file with a / in the file name 

●     Script Editor
●     Preview

The following apps allow you to save a file with a / in the file name: 

●     TextEdit
●     Safari

When you try to type a colon in a save dialog in OS X, it is replaced as-you-type with a 
dash (Preview, TextEdit, Script Editor 2 and Safari tested), never producing an error. 
This type of auto-replace behavior may be undesirable in some applications 
(particularly apps for programmers). In that case, applications can opt for a different 
behavior. For example, BBEdit beeps and doesn't allow you to type the character, 
requiring you to explicitly type a different character. 

So does it cause a problem that you can rename a file in the file system to contain a 
forward slash? Not really. The only time that would cause a problem is if that file is 
being served by a web server (and web servers have lots of other characters that 
they're picky about). It's then left up to the web developer to serve files with web-
ready file names.

With essentially just one forbidden character for file names, X allows you to name your 
files just about whatever you want. XP's 9 forbidden characters is considerably more 
restrictive. OS X also uses verbiage (The name ":untitled folder" cannot be used) that 
puts the owness for the error squarely where it belongs: with the OS. XP's verbiage 
implies that the error lies not with the OS, but with the operator (The above file name 
is invalid) for attempting name a file in an 'invalid' way. One of Word's errors seemed 
particularly scolding of the operator. "The file name, location, or format of 
'sample>filename' is not valid. Type the file name and location in the correct format, 
such as c:\location\file name." Even though XP couldn't deduce what was wrong, it was 
certainly going to place the blame on the operator. 

File names, forbidden characters: OS X: 8, XP: 5
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Aliases vs. Shortcuts 
 

Both OSes have a method of creating an icon that is a reference to an item elsewhere 
in the file system. XP calls them shortcuts while OS X calls them aliases. Each OS uses a 
different method of creating these references. Both OSes allow you to manually set a 
new target to aliases or shortcuts. 

OS X: OS X's aliases are a reference to an item's internal id number within the file 
system. So if a file is moved or renamed, the alias is still aware of the item's new name 
or location. If you type in a path in a Terminal Window or in a Finder window's address 
bar, and the path contains an alias, both the Terminal and the Finder window will 
correctly resolve that path. 

To create an alias: 

●     Ctrl-click or right-click a file and select Make Alias
●     Begin dragging an item, then hold down -Option. Release the mouse in the 

location you want to create the alias. Proxy icons (the icon in a window's title 
bar) can also be dragged this way.

To locate an alias' original:
While the alias is selected, click the Show Original command from the File menu or 
from the item's contextual menu or type -R (Reveal). To see the full path to the 
original file, Switch to Column View, -click the window's title (in the Title Bar), or 
click the Path button (if you have added the Path button to your toolbar). 

XP: XP's shortcuts are files that reference the path to an item, including its file name. 

Keyboard shortcuts can be assigned to shortcuts, to facilitate locating items. 

The Address Bar does not resolve shortcuts. This means that if you type in a path in the 
address bar, but your path contains a shortcut, the address bar will not be able to 
follow that path. 

To create a shortcut: 

●     Right-click a file and select Create Shortcut
●     Begin dragging an item, then hold down Ctrl-Shift. Release the mouse in the 

location you want to create the shortcut.
●     Drag the icon in a window's title bar and release where you would like to create 

the shortcut
●     Drag a file/folder with the right mouse button then select Create Shortcut from 

the contextual menu that appears when releasing the mouse (This same method 
can be used to copy or move items). 

To locate an shortcut's original:
Right-click the shortcut, then select Properties>Shortcut. The path to the original file 
is shown in the Target field. Additionally, you can click Find Target... to reveal the 
original file. 

Aliases vs. Shortcuts: OS X: 9, XP: 8
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Handling Busy Files 
 

What should a computer do if a person renames a file (in the file system) when the 
file is open in an application? 

OS X allows the file to be renamed. XP sometimes allows it and sometimes does not 
allow it. What's the liability to OS X's method? In *some* applications if you then go 
and edit the file and try to save it (w/out closing it first), you'll get an error. I've 
tested TextEdit and Script Editor. (Third-party apps tested: Word, Acrobat 5, Acrobat 
6, and BBEdit. The only app to generate an error was Acrobat 5. Word, Acrobat 6 and 
BBEdit instantly recognized the new file name.) Script Editor instantly recognized the 
new file name. TextEdit re-saved the file to its original name. Not perfect, but 
preferable to XP. 

 
I renamed a file in the file system while it was open in Script Editor.

When I attempted to re-save this file, I was presented with this dialog. 

Reader input: "XP has the ability to detect which application has the file open and tell 
the user to close it before it can be renamed. You can see this in action if you try to 
rename a Word document. The error message tells you to close Word before you can 
rename it. This uses the running object table to map the files to the apps. 

"In other cases, when applications allow this, the file can be renamed, moved or even 
deleted while it is open. Try this on a .MP3/.WMA file that media player is accessing, 
you can rename/move/delete the file (!). This is because this application opens the 
file in a sharing mode that allows this. This is encouraged behavior for apps." 

In OS X, when you download a file from the web, the file is placed on the Desktop as it 
is being downloaded. OS X allows users to rename, move and even play (if the file is a 
sound or video file) the file while it is being downloaded. IE for XP conceals files that 
are in the process of being downloaded since moving, renaming or playing that file is 
not allowed. 

As a webmaster, I'm constantly being given files (Word, PDF, etc) to post on the web. 
The author of the file named it whatever he or she wanted, but I adhere to strict 
naming conventions on my site. So I almost always open the file up to look for a clue as 
to what to name it. Sometimes PDF files are assigned serial numbers, and these serial 
numbers are in the fine print at the end of the file. I open the file, locate the serial 
number, rename the file to the serial number, then close the file. I prefer keeping the 
file open as I do this, since otherwise I'd have to write the number down, or copy it. 
Others may disagree. I say, if someone's savvy enough to rename a file while it's open, 
let them. 

Handling Busy Files: OS X: 8, XP: 4
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Trash vs. Recycle Bin 
 

Both OSes allow you either to drag items into the Trash or Recycle Bin or delete via the 
keyboard. Both OSes allow you to empty your garbage receptacle at a later time. Each 
OSes waste basket has its plusses and minuses... 

OS X: Trash 

●     Can browse folders located in the trash
●     Secure file deletion
●     Can't delete individual files/folders while leaving other items in the Trash
●     Must manually drag files/folders out of trash to un-trash them 

XP: Recycle Bin 

●     Can't browse folders located in the Recycle Bin
●     No secure file deletion
●     Delete individual files/folders while leaving other items in the Recycle Bin
●     Right-click an item in the Recycle Bin and select Restore to put items back in 

their original locations. 

Trash vs. Recycle Bin: OS X: 8, XP: 8

Pick a topic:  
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Internet Explorer icons for OS X (above) and XP (below). The units (bottom) are pixels.

The above chart illustrates the quality differences of X and XP icons at 10 different pixel sizes, as well as the 
expanded range of sizes for OS X. Since XP relies heavily on the 3 preset icons (noted in green) those icons appear 
best for that OS, however other sizes appear blocky. OS X icons look crisp at any size. 

Icons, Overview 
 OS X and XP's icon size controls 

 

 

OS X's slider visually portrays your selected size 
relative to the minimum and maximum possible 
sizes. The only way in XP to determine the min 
and max sizes is to click and hold the up and 
down arrows until the numeric value stops 
incrementing. Even then, you have to apply the 
settings before you can see what they look like. 

XP: The specs: 72x72 
pixels max, 8-bit 
transparency (according 
to MSDN). Tweakxp.
com describes a registry 
hack to enable "Mac OS 
X Icon Sizes" in XP. 
Since XP's default icons 
are not optimized for 
that dimension, they 
will appear blocky. 
Users will have to 
download 128x128 icons 
for every item that they 
want to appear clear at 
that setting. 
Interestingly, the icon 
for iTunes for XP is 
optimized for that 
dimension, so it will 
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look clear. 

XP Icons come in three preset sizes - 48x48, 32x32, 16x16. To select the size 
of your icons, select Start> Control Panels (or right-click on the Desktop and 
select Properties). Then select Appearance and Themes and click Change the 
computer's theme. Then, from the Display Properties Window choose the 
Appearance tab. Click the Advanced button and choose Icon from the Item 
popup menu. Select a number from 16 to 72 (pixels). Click OK, then click 
Apply. The screen will dim while your settings take effect. Once the screen 
returns, view the icons. Repeat the above steps until you're satisfied. You can 
scale your icons to any size up to 72 pixels, but icons viewed in any 
interpolated size (meaning any sizes other than the 48,32,16 pixel presets) 
may appear jagged or blurry. XP doesn't indicate these 'preferred' values to 
the user. 

XP relies on image previews for the display of images-as-icons. XP does not 
support the display of image previews in List View or on the Desktop. 

  
  
  

  

XP's list view X's list view 

 

XP's Filmstrip view

 

OS X's Toolbar scripts

If XP users want to see a preview of their 
images, they need to switch to Filmstrip or 
Thumbnails view. Filmstrip view is typically 
available in directories that contain ONLY 
images (though users can edit a folder's 
properties so that Filmstrip view becomes 
available). Since OS X heavily uses both custom 
icons and image previews, users can see either 
a preview or an icon of their image in any view, 
in any directory. Filmstrip view adds some 
editing controls. OS X users can install the 
Digital Camera Toolbar scripts collection (right) to add resize, rotate and 
browse buttons to all window toolbars (and all views). 

In Lara Croft's Shadow OS X: The specs: 128x128 
pixels, 8-bit transparency. 

OS X icons look crisp at any size 
from 16x16 to 128x128. To 
change the size of icons, choose 
Show View Options from the 
View menu in the Finder (or 
type -J). Slide the Icon Size 
slider and watch your icons 
grow or shrink in real time (as in 
this movie- movie courtesy of 
the excellent Snapz Pro). 
Optionally, select if you want 
these settings to only apply to 
the current window. Close the 
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Large 128x128 pixel icons provides plenty 
of room for creativity. Notice how Lara 
casts a shadow on the Simpsons icon. 

View Options palette when 
you're satisfied. 

Icons: OS X: 9, XP: 5

Icons, Changing 
 

Both OS X and XP allow users to change a folder's icon (though XP's custom 
folder icons will not display in Thumbnails view. A separate picture can be 
selected for display in Thumbnails view). OS X additionally allows users to 
change any file's icon as well. This allows OS X users to apply custom icons to 
anything they want— applications, resumés, scripts, etc. 

OS X: To copy one file or folder's icon to another file or folder: 

1.  Select file using the icon you want to apply
2.  Get Info ( -i)
3.  Click the icon preview and Copy
4.  Select file using the icon you want to change
5.  Get Info ( -i)
6.  Click the icon preview and Paste

Any image can be copied and pasted as a file's icon, making it very easy to 
create your own icons (though custom shapes and drop shadows require extra 
work). 

XP: To change a folder's icon: 

1.  Right-click the folder and choose Properties
2.  Click the Customize tab
3.  Click Change Icon... (This brings you to a dialog that browses the 

contents of %SystemRoot%\system32\SHELL32.dll )
4.  Click Browse
5.  Navigate to the .ico or .exe file containing the icon you want to use 

and Click Apply

If you want to create your own icon, Microsoft has provided thorough 
instructions for creating an icon in XP. Here is a quick and dirty method for 
creating icons: 

1.  Open Paint, set image to 32x32
2.  Draw anything
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3.  Save as .bmp format, but use an extension of .ico

XP allows the user to change file icons for a file type via the file types tab of 
the Folder Options menu item. 

In XP you'll be fine as long as you already have an icon file that you want to 
use and you want to change a folder's icon. However if you want to create an 
icon from a picture extra steps are required. XP users cannot customize an 
icon on files or applications (though they can change the icon on shortcuts, 
which is how users typically interact with applications). 

Icons, Changing: OS X: 8, XP: 4

Pick a topic:  
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Fonts, Quantity/Quality 
 

XP: Supported font formats: 

1.  PostScript Type 1
2.  OpenType
3.  Windows TrueType

The following chart shows the Roman fonts supplied with XP (it does not show their accompanying faces- 
bold, italic, bold italic, extra bold): 
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 OS X: Apple's own OS X Features- Fonts page is worth reading. 

Supported font formats: 

1.  Mac PostScript Type 1 and 3
2.  Multiple Master
3.  Mac TrueType
4.  System (dfonts)
5.  OpenType
6.  Windows TrueType

Note: Some TrueType fonts will not display in the Preview pane of the Fonts Panel (select Show Preview 
from the Extras menu).

The following chart shows the Roman fonts supplied with OS X (and all of their accompanying faces- bold, 
italic, bold italic, extra bold): 
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Apple also offers the following 25 free fonts in their iTunes Scripts for Mac OS X 10.1 :

http://www.xvsxp.com/fonts/ (3 of 12)1/1/2005 5:48:42 AM

http://www.apple.com/applescript/itunes/


X vs XP > Fonts

 

Fun with Ligatures
Ligatures are special characters that 
replace certain combinations of 
letters. In the following example 
notice that X's Zapfino font is chock 
full of ligatures. Notice how the E, P 
and L characters display different ways 
depending on the characters next to 
them. Also notice Dr., 2nd, St., 5th 
and No. are all ligatures. These 
ligatures are "smart", applying 
themselves automatically as you type. 
(In my tests, Zapfino needed to be 
larger than 12 points for ligatures to 
apply). 

Fonts, Quantity/Quality: OS X: 8, XP: 6 
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Fonts, Previewing XP: 3 methods to preview fonts: 

1.  Character Map
2.  Double-click a font file (in Fonts Control Panel. The Fonts control Panel is really just a shortcut to 

the c:\WINDOWS\Fonts folder.)
3.  From within an Application's Font menu

 Use Character Map to view all of the characters 
associated with a font.

 

OS X: 4 ways to preview fonts: 

1.  Font Book (See Fonts, Management). Double clicking the font file will open Font Book and display 
the font's preview

2.  Fonts Panel (See Fonts, Management)
3.  Character Palette
4.  Use the Script Menu's Font Sampler Script to create a page to preview OS X's default fonts (the 

fonts graphic at the top of this page was made that way). Unfortunately, this script has a hard-
coded lists of fonts, rather than a dynamically generated list of fonts on your system. If you'd like 
to preview more fonts, you need to edit the script.

Additionally, Keyboard Viewer is used to learn how to type special characters. Keyboard Viewer is 
covered in the Keys, non-standard section. 

Character Palette
For more exotic characters (dingbats, etc.), use the Character Palette. The Character Palette can also 
be used to type other (non-Roman) character sets, such as Japanese, Chinese, Cyrillic, Tibetan and 
much more. 

Go to Edit> Special Characters from most apps to open the Character 
Palette. The Character Palette is also located in the Input Menu, which 
can be added to your menus by turning it on at System 
Preferences>International>Input Menu.

The Character Palette is a very deep palette. Here are a few sample 
screens:
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How many letter Es are there? 

 
Kanji Numerals: Guess which number this is? 
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Fonts, Previewing: OS X: 9, XP: 7

Fonts, Management OS X: Multiple locations for fonts: 

●     Library/Fonts main font library, shared by all users
●     ~/Library/Fonts fonts just for this user 
●     System/Library/Fonts Fonts used by the system (menus, dialogs, icons). Restart required when 

editing these fonts.
●     Network/Library/Fonts Fonts managed by a central network server
●     System Folder/Fonts for Classic Mac OS 9 fonts

Users do not need to manually place fonts in their proper location to install them. Installing a font is as 
simple as double-clicking the font file. A dialog asks you whether you want this font to be available for 
just you or for all users, and moves the font to the appropriate location based on your answer. 

Since designers might require thousands of fonts (but don't want font menus that are a thousand fonts 
long), they would not be interested in manually managing their fonts folders. That is where Font Book 
comes in. 

http://www.xvsxp.com/fonts/ (8 of 12)1/1/2005 5:48:42 AM



X vs XP > Fonts

 
Font Book

Font Book is Apple's answer to font management. Fonts can be previewed and users can create their own 
font sets. Individual fonts or entire sets can be enabled or disabled on-the-fly, simplifying what could 
otherwise be very long font menus in applications. Applications immediately reflect font changes without 
restarting. 

Users interested in printing out detailed font previews so would still require third party font management 
software. 

XP: all fonts must be located in c:\WINDOWS\Fonts. They cannot be placed in subdirectories. XP lacks the 
ability to on-the-fly enable or disable font sets (though XP users can purchase font management 
software).

This is a tough section to score, which I think needs to be split up into 3 separate scores. 

Fonts, Management, Flexibility: X's multiple font locations allows you to do some pretty nice things. For 
instance, a design studio could place all their fonts on a central OS X Server, and all the workstations 
would instantly share all the fonts. XP cannot do this. 

Fonts, Management, Ease of Use: Multiple font locations could lead to duplicate fonts, particularly 
duplicates to system fonts. Apple uses some system fonts (Times, Helvetica Neue, Zapf Dingbats) that 
may be slightly different than their postscript equivalents. This was a problem in 10.2, but Apple's 
resolution is to place a bullet next to duplicate/system fonts, thereby allowing designers to be certain 
that they are using the exact version of the font that they want. Since all XP fonts reside in the same 
location, font duplication is impossible. The down side of having all fonts in one location is that individual 
users will not be able to have their own personal selection of fonts, but that is a flexibility issue. What 
does hamper ease-of-use in OS X is the fact that fonts reside in multiple locations, so when a user wants 
to drag-install some fonts, they must figure out which location to place them. 

Fonts, Management, Selecting Fonts: The Fonts Panel not only allows you to select the proper font, but 
you can also select its color, the background color, and even shadow details (opacity, blur, offset, 
angle). 
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The Fonts Panel is for selecting fonts in Cocoa applications. 

As if that weren't enough, the Fonts Panel even comes with a 
Typography palette for controlling a myriad of font details like 
ligatures, ornaments, ligature variants, old style numbers, and 
more (right). 

Although Apple's Font's Panel will group fonts into their faces (Bold, italic, Normal, etc.), the Font Panel 
is only available in Cocoa apps, which means carbon apps have no built-in way to group fonts. This means 
that carbon application developers will have to build that into their application as a custom feature. 
Otherwise, font faces are organized alphabetically, which increases your fonts list dramatically and 
occasionally splits up faces that should be grouped together. For instance: 
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●     Courier Bold 
●     Courier New Bold 
●     Courier New Bold Italic 
●     Courier New Italic 
●     Courier New Regular 
●     Courier Regular 

Courier Bold and Courier Regular are both part of the Courier family, but are split up by Courier New (you 
can witness this issue in iMovie). Grouping of fonts by family is built in to XP. 

 
The Fonts Palette allows users to edit how sizes are picked. 

Fonts, Management OS X: 8, XP: 7 

Fonts, Anti-aliasing and Sub-
pixel rendering

XP: XP supports anti-aliasing of type, however the minimum font size threshold to turn on anti-aliasing is 
not user selectable, but rather part of each font (defined by the gasp record in truetype font files). XP 
also supports sub-pixel rendering. Microsoft has branded their implementation of sub-pixel rendering as 
ClearType. 

The following chart shows some type in web browsers (Internet Explorer for XP, Safari [1.1 v100] for X). 
The XP column shows ClearType off and on. The OS X column shows Standard Font Smoothing and Strong 
Font Smoothing.
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The visual effect of using colored pixels in sub-pixel rendering is of subtle but noticable noise around the 
edges of type. This will vary depending on the type of display, however the effect was noticable and 
undesirable on my CRT. This is why Apple also includes "Standard Font Smoothing", which is anti-aliasing 
without sub-pixel rendering.

The following magnified type examples compare ClearType, Standard Fonts Smoothing (anti-aliasing only) 
and Strong Font Smoothing (anti-aliasing plus sub-pixel rendering).

 

This clearly shows the colored pixels around the edges of the type (known as "color fringing"). X's strategy 
of simultaneously anti-aliasing and sub-pixel rendering means that the contrast of the edge pixels is 
reduced, meaning the visual noise introduced by sub-pixel rendering is diminished. It should be noted 
that sub-pixel rendering is intended for LCD monitors, and color fringing is less noticable on those 
monitors.

OS X: OS X supports both anti-aliasing and sub-pixel rendering, both are selectable from the Font 
Smoothing popup menu with in the Appearance Control Panel. Standard font smoothing (Best for CRTs) is 
anti-aliasing only. Light, Medium and Strong also include sub-pixel rendering. 

 

You can also turn off smoothing on smaller type.

 

OS X wins with anti-aliasing since the minimum threshold is user selectable. Sub-pixel rendering is both 
difficult to judge (since it's effects will vary from one display to another) and it seems to be a subjective 
experience- what one person likes another will dislike. 

Fonts, Anti-aliasing and Sub-pixel rendering: OS X: 9, XP: 8 

Pick a topic:  
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The Dock vs. The Taskbar

Both OS X's Dock and XP's Taskbar allow shortcuts to applications, quick access to currently open applications, 
and can be moved to any side of the screen (the Dock can't be placed along the top edge of the screen, since all 
application menus are there). But that's where the similarities end. 

OS X: The Dock is simultaneously charming and annoying. Possibly the Dock's most annoying aspect is the fact 
that items behind the Dock are not clickable, like resize corners of documents. This happens any time you 
maximize documents from apps that aren't written as Dock-aware (Internet Explorer). It's also been pointed out 
that making icons that grow and shrink makes them a moving target. However, the amount of growth is a variable 
setting, and it can be turned off altogether, so if users want their icons to grow, it's their choice. 

 
The Dock. 

 

Icons in the Dock efficiently behave as shortcuts to favorite applications (and files), as well 
as denoting applications that are currently open (via a small black arrow underneath the 
icon). 

Control-clicking, click-and-holding, or right clicking on icons in the Dock brings up a context 
sensitive menu for performing actions such as activating a window associated with that 
icon. While minimized items in XP's Taskbar can display a handful of items in its popup 
menu, such as maximizing or closing associated windows, they rarely provide application 
specific commands. The accepted method for an application to provide such controls is by 
adding an icon to the Tray, assuming the application provides a Tray icon. WMP uses "mini-
mode" [seen below] for Taskbar controls, meaning the app needs to be custom built to 
provide such functionality. In the example to the right, iTunes Dock menu allows quick 
access to common iTunes commands without maximizing the app. 
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Managing Application Windows with the Dock and Taskbar
How should an OS handle accessing and application's multiple windows? 

Click an app's Dock icon to bring all of that 
app's windows to the front (without 
altering their position or stacking order 
relative to each other). Click and hold (or 
right-click, or control-click) an application's 
icon in the Dock to see a list of windows 
associated with that application (the 
frontmost window is checked). Select the 
window you want from the list to bring it to 
the front. 

XP can have two separate menus for Taskbar 
items (if you've selected to Group similar 
Taskbar buttons in the Taskbar's Properties). 
Click the Taskbar button to see a list of open 
windows. There's no indication which window is 
frontmost, which can cause some confusion. If 
you select from the list the item that's currently frontmost, it gets minimized! Selecting an item to make it 
go away is counterintuitive behavior.

Right-click to access the contextual menu. You can choose to cascade 
or tile your windows, or minimize them all, but you can't bring them all 
to the front w/out rearranging both their order and position. 

Each OS could learn from the other here. OS X could benefit from Cascade or Tile options, while XP could 
benefit from bringing all to the front without rearranging, as well as indicating from the menu which window 
is currently frontmost. 

One of the Dock's most impressive features is its advanced real time application feedback. The best 
demonstration of this is watching a DVD while it's minimized. When an application like Photoshop or BBEdit is in 
progress of completing an operation its Dock icon sprouts a progress bar. OS X's Activity Monitor application can 
alter its Dock icon to display CPU Usage, CPU History, Network Usage, Disk Activity, or Memory Usage. Mail sports 
a red badge showing how many unread messages you have. 
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The Status Bar and the Tray 

OS X's Status Bar sits in the upper right corner of the screen and 
provides quick access to system activities, such as resolution 
switching, or changing the sound volume (a mute button would 
be nice). The Status Bar's color palette is intentionally muted to provide a visual weight that is not a 
distraction. The increased contrast provided by black icons on a light background makes them easier to 
visually target. 

XP's equivalent—Tray—is typically situated in the lower right corner: XP 
relies on the diminished size of items is the Tray, rather than color to make 
them less distracting. However, they frequently call attention to 
themselves. On a regular basis, one tray item asks me if I need help cleaning up my unused desktop icons. 
Another regularly tells me that my wireless connection signal is poor. The next second it tells me it's 
excellent. The Tray does not provide the one-click access to switch video resolutions. ;( 

When less is more: Despite the fact that OS X uses a monochromatic palette for its 
Menu Extras, the Status Bar still provides more visual feedback than the Tray. For 
instance, X notifies you of your computer's volume (muted, soft, medium, loud), whereas XP only notifies you 
if your volume is muted or not. XP's Wireless signal strength icon is equally uninformative, only notifying you 
if there is a signal or not, until you roll your mouse over it, or until it sprouts a bubble alert demanding your 
attention. 

A little bit of color goes a long way:  

XP: XP's Task Bar separates application shortcuts (Quick Launch) and active/minimized applications into discreet 
sections of the bar. 

 
The TaskBar (minus the Tray, see above). 

 
Windows Media Player in "mini-mode". 

Microsoft and Apple chose different approaches to situations when a user is running lots of apps. Apple's icons 
just keep shrinking to fit into the space, while XP first starts clumping their buttons into "application groups" to 
save real estate, then relegates extra apps to a second or even third row of the taskbar, accessible via up and 
down arrows. I've lost lots of seconds clicking up and down through those arrows looking for apps I wanted to 
access. In XP's defense, you can change the height of your taskbar to accommodate multiple rows of apps w/out 
scrolling, that's just not my preference. 

Like in OS X, resize corners can get lost behind the Taskbar, but this happens considerably less often than in OS 
X, because maximizing windows in XP doesn't place the bottom edge of the window underneath the task bar. 
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Although this isn't supposed to happen in X either, some apps (IE for instance) misbehave this way.

However, popup windows in Internet Explorer for XP seem to not respect the taskbar. It's easy to get a popup ad 
stuck behind the taskbar. Here's one example: In XP, place your taskbar at the top of the screen, and make sure 
auto-hide is turned off. Then, in your web browser, go to Sony's Station.com. Wait a moment until a "popunder" 
ad pops up and under your current browser window. You'll notice that it tucks its title bar neatly away directly 
under your taskbar. Voilà! One Stuck Window! Who's fault is this, Sony's or Microsoft's? It's Microsoft's, since they 
wrote the browser and they determine whether new browser windows respect the location of the taskbar or not.

Meaningless Menu Items?

At first glance (and second, and third), the Move and Size menu options that 
appear when right-clicking minimized items seem to serve no real purpose. 

An attentive reader pointed out that those two menu items are intended as 
keyboard controls. Select either command, then use your up, down, left, and 
right arrow keys, and the window will move or resize itself for you. This menu 
can be invoked from a non-minimized window by typing Alt-Space. 

I can (almost) appreciate the value of this, except why display these commands 
in task bar item's contextual menu? Some readers have noted that these 
commands are helpful when a window gets accidentally moved offscreen. However, an OS should never allow 
that to happen in the first place. 

Furthermore, since this command will only have value to a very, very small portion of XP users, why clutter 
everybody else's menus with it? This is the perfect type of functionality that users should be able to say "never 
show me these options, because I'll never use them." 

Are the Taskbar's text labels superior to the Docks?
Some readers have mentioned that the Dock's handling of text labels is inferior to that of the Taskbar, because 
the Dock's text labels only appear when your mouse is over an item. Whether or not that is optimal is debatable. 
What isn't debatable is that XP's handling of text labels is far from perfect: 

 
Under anything more than light use, Taskbar text labels degrade to mere visual noise. 

XP users can download Virtual Desktop Manager (part of Microsoft PowerToys for Windows XP to manage up to 
four desktops from the Taskbar. 

Dock vs Taskbar: OS X: 7, XP: 7

Pick a topic:  
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The Dock vs. The Taskbar, Nitty Gritty 

For those of you that the previous Dock vs. Taskbar page didn't suffice, this page gets into the details of 
both. Each tool has it's assets and liabilities. This Nitty Gritty section is non-scoring. Dock and Taskbar 
preferences seem too subjective to give one a winning point. 

Shared assets (Both the 
Dock and the Taskbar) 

1.  Notifications are a discreet section
2.  placement along any screen edge (Dock cannot be placed along the 

top for obvious & sensible reasons)
3.  Auto-hide
4.  Third parties can develop items for the Tray and the Menu Bar 

Taskbar assets 1.  Multiple taskbars
2.  Access to all applications via Start Menu
3.  Access to the Task Manager
4.  Toolbars can be locked/unlocked
5.  Toolbars can float anywhere on the screen
6.  Toolbars can be attached ("docked") to a screen edge. 
7.  Auto-hide and Always-on-Top settings for multiple toolbars can be 

set per toolbar 
8.  Address bar gives quick access to the web, FTP, or file system
9.  Text labels (almost) always visible

10.  When grouped, Taskbar buttons (often, but not always) display the 
number of open windows pertaining to that app 

11.  Taskbars support the display of HTML content (by virtue of Active 
Desktop) 

Taskbar liabilities 1.  It doesn't distinguish the frontmost window (when icons are grouped 
into one button by application). In this state, selecting the 
frontmost window from the list counterintuitively minimizes it. 

2.  It doesn't distinguish minimized vs. non-minimized windows
3.  Taskbar items are distinguished by application icons and text labels. 

Text labels are often insufficent to distinguish a window: Examples: 
index.html, index.html, header.jpg, header.jpg, Untitled 8, 
9012345.pdf.

4.  Text labels often get truncated, diminishing their usefulness
5.  XP has no method of returning to an application (and ALL it's 

associated windows) WITHOUT changing their order and placement. 
You can either choose: Cascade, Tile Horizontally, Tile Vertically or 
bring one window forward at a time (most likely altering their 
order).

6.  inconsistent treatment of Taskbar labels for MDI windows
7.  weak or no visual feedback (quicklaunch icons do not highlight to 

indicate whether or not they can open an item dragged onto them)
8.  The Taskbar provides no one-click way to quit applications if their 
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buttons aren't grouped. Instead, you must either close each button 
one by one, or quit the application from one of the application 
window's File menus. 

Taskbar Double-edged 
sword 

1.  Real-estate organized by task: shortcuts and open windows are in 
discreet sections (organized, yet real-estate hungry)

Dock assets 1.  Dock can be resized, icon magnification can be turned on or off, 
degree of magnification is user selectable. 

2.  Strong visual feedback 
a.  With magnification turned on, icons grow as your mouse 

approaches them and shrink as your mouse moves away. 
b.  App icons slide out of the way when dragging another app 

icon to the left side of the dock, indicating that the item 
can be added to that location (the same is true when adding 
documents or folders to the right side of the Dock). 

c.  Minimize a window and it animates (the "genie effect") on 
it's way down to the Dock. 

d.  Remove icons and they disappear in a "puff of smoke"
e.  Dock icons can display "badges" as user feedback: progress 

bars, number of mail messages.
f.  Icons highlight when dragging documents onto them to 

denote that they can open that file. Hold -Option to force 
an app to open that file

g.  Minimized icons are miniature replicas of the window, 
permitting visual identification of the item (if the item is 
distinct in shape or other appearance: color, layout, AND the 
icon is sufficiently large to permit such discernment). 
Minimized icons also sport badges of the application they 
pertain to. 

3.  Icons stay in the order that you arrange them, encouraging muscle 
memory. Caveat: Minimizing windows or opening apps not already 
in the Dock will cause Dock items to shift to the left to 
accommodate the new item, working somewhat against muscle 
memory. 

4.  Frontmost windows are distinguished with a check
5.  Hide, Quit, Show in Finder and Force Quit menu items allow one-

click access to common tasks w/out bringing the app to the 
foreground. (option-click to access Force Quit)

6.  Dock icons frequently have custom menus to control the application 
without bringing it to the foreground

7.  Click an app's Dock icon to bring the app and all it's associated 
windows to the front, preserving their placement and stacking 
order. This is significantly more useful than the Taskbar since 9 
times out of 10 when you want to switch back to another app, you 
also want to switch back the the doc you were last working on. 
Clicking the app icon accomplishes that with virtually zero effort. 
This method can also be useful if you spatially arrange your 
windows. You can bring all of them to the front and recall that you 
were working in the leftmost window. Or perhaps if you're editing 
images, bringing them all to the front allows you to SEE them and 
therefore select your file more quickly. Though this isn't a strategy 
I use all the time, I contend that this 2 step method can STILL be 
faster than the Taskbar's one step of selecting an item from a list 
of possibly indistinct text labels. With XP you can do this last 
method ONLY IF the application is MDI, AND ONLY IF it allows you 

http://www.xvsxp.com/dockvstaskbar/part2.shtml (2 of 5)1/1/2005 5:48:49 AM



X vs. XP > The Dock vs. The Taskbar, Nitty Gritty

to call the entire app forward with one click to it's app icon. 

Dock liabilities 1.  Icons are occasionally moving targets, and moving targets can be a 
bad thing: 

a.  Dragging an item slightly to the left of the Trash will cause 
items to move out of the way, assuming you want to add the 
dragged item to the Dock. 

b.  With magnification turned on, Dock icons will grow as your 
mouse approaches them (which is good, since it makes them 
larger targets). However, once your mouse passes the 
middle of the icon, the icon actually moves away from your 
mouse. Therefore scrubbing your mouse across a Dock with 
magnification on takes more dexterity than one would 
imagine. Furthermore, as you move your mouse towards a 
Dock icon (when moderate magnification is turned on) it can 
be extremely difficult to keep your eye fixed on it as it 
moves and grows. 

2.  Although Dock icons adhere to Fitt's Law when clicking on them (you 
can click on the bottom of the screen under an icon to click the 
icon), they do not adhere to Fitt's Law when dragging and dropping 
an item onto them. For instance, I can drag items completely under 
the Trash and the Trash won't highlight. Releasing the item under 
the Trash cancels the operation. 

3.  Minimized icons are occasionally visually indistinguishable from one 
another, requiring 'scrubbing' your mouse over them to reveal their 
text labels

Dock Double-edged 
sword 

1.  Text labels only appear while 'scrubbing' your mouse over the icons, 
forcing you to rely more heavily on visual cues (reduced screen 
clutter, unless you require the label to distingush the item)

2.  File system access is user selectable: add your Applications folder 
to the Dock (possibly slow, unofficial solution, yet infinitely user 
modifiable) 

3.  Magnification: strong visual feedback as to the location of your 
mouse, but moving targets can be tricky to click on 

4.  Dual use of real estate: shortcuts and running apps share the same 
space (real-estate efficient, yet possibly confusing)

5.  Non-minimized windows don't get individual icons. (real-estate 
efficient, yet possibly slower) Users MUST access them via 

a.  The app's Dock menu, 
b.  The app's Window menu, 
c.  Their arrangement on the screen (assuming they aren't 

obscured)
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Addendum 1.  XP's encouragement of a maximized environment effectively forces 
users to use the Taskbar (or Alt-Tab). OS X encourages simultaneous 
viewing of staggered windows, which is singificantly faster to target 
small numbers of windows than either the Dock or the Taskbar. 

2.  XP has only minimize or maximize-in-front-of as a method of 
concealing windows. OS X additionally has Hide. Hiding an 
application will also hide all of it's minimized icons, thereby 
reducing Dock clutter.

3.  XP windows sport the icon of the opening application. OS X windows 
sport the icon of the file type of the window. OS X only displays 
icons on windows that should be proxy-able (files/folders). XP 
displays icons on windows that should be proxy-able, as well as MDI/
application windows. These window icons do not behave the same 
as proxy-able icons. (Proxy icons can be drag and dropped to 
manipulate the file—move in file system, attach to mail message, 
etc) 

4.  The Dock has some useful shortcuts: 
1.  -option click an app in the Dock to reveal all it's windows 

and Hide the windows of all other apps
2.  Option-click the minimize button on a window to minimize 

all windows associated with that app 
3.  Hold -Option while dragging a file icon onto an app icon to 

force an app to open that file 

Application Centric or Document Centric? 
It is fair to say that XP is not an application centric OS mostly because 
of its omission of the ability to bring all the windows associated with an 
application to the front without resizing or moving them. 

Some readers have called OS X application centric, claiming it's easier 
to bring an entire application to the front (click an app's Dock icon to 
bring all its windows forward) than it is to bring just one window 
foreward. However, OS X provides plenty of ways to bring just one 
window forward: 

1.  Select the window from the app's Dock menu 
2.  Select the window from it's minimized icon (if it is minimized) 
3.  Select the window from the application's Window menu 
4.  Select the window from the app's Open Recent menu. Yes, Open 

Recent menus can include currently open windows, and will 
also display path information, if the file's path will help 
distinguish it from another. 

5.  Since OS X's windows are rarely maximized, you can often see 
the window you want staggered behind the current window, so 
you can just click it to bring it to the front. 

Regarding #1 above, some readers have made a lot out of the fact that 
application menus in the Dock require a click to access it. Well, when 
the Taskbar is under a moderate load across the bottom of your screen, 
the Taskbar's app menu (called a task menu) requires a click too. In 
fact, it requires 2 clicks. Click and release to reveal the menu. Click 
and release again to select your item. The Dock only requires 1 click. 
Click and hold to reveal the menu. Release on the item you want to 
select it. For those of you that prefer click-release-mouseover-click-
release, the Dock supports that too. The Taskbar ONLY supports the 
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latter. 

The Dock vs. The Taskbar, Nitty Gritty: No Score

Pick a topic:  
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Search for movies in Sherlock and see 
theaters and times in your 
neighborhood, and even the trailer! 

 
Third party channels are also built-in 
to Sherlock 

OS X: With OS X, Apple has rightly separated searching into hard drive 
searches vs. everything else. Let's look at the "everything else" searches 
first: 

To search for anything else (meaning: search the internet), use the 
Sherlock application. You can search the internet, lookup movie times in 
your area (including video trailers), lookup flights, track packages, search 
eBay, lookup words in the dictionary, translate text ( back and forth 
between any of the supplied languages, including Korean, Japanese and 
Chinese), and much more. Here are a few samples: 

●     Pictures (10.2 shown)
●     Stocks (10.3 shown)
●     Yellow Pages (10.3 shown)

Searching for a file on your hard drive doesn't require bringing up a separate 
interface. Just type your search in the toolbar, and away you go. From an 
Interface usability perspective, the 2 pane search design shows results above, 
and the path to the selection below (see shots below). You can double-click any 
icon in the path to open that folder. 

X's searches start as soon as you begin typing. A simple way to see this in action 
is to select a folder, pick Selection from the magnifying glass menu, then start 
typing a search query. You'll notice that search results appear almost 
immediately, and the results continue to narrow as you type. Talk about 
responsive! 

The screen shots below show how you can search directly within any window. Just type into the search box (I 
typed in save) and X will search the locations that you specify (from the magnifying glass dropdown menu) for your 
request. 

OS X's search makes good use of real estate and will dynamically alter the display of the file's path depending on 
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available real estate. Notice in both of the following examples that the path starts with the home directory, rather 
than with file system root. 

 
With lots of real estate,it displays the path (in the lower pane) vertically. 

 
Shrink the window and the path displays with arrows—

rather than the more cryptic (though familiar to developers) "/" character that XP uses.
Notice also that paths simply start at Home, rather than /Users/username/Home... 

The location of an item is often a critical bit of information in determining if it's the thing you're searching for, so 
X includes a Parent column in the find result window:
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The Parent Column clarifies this find result in a real estate efficient manner. 

If you want a more advanced search, type -F (Find) to bring up a Find window that supports more complex find 
criteria. 

Find: 
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OS X's Find window and Find result window

XP: One thing XP has over X is that the keybooard shortcut to invoke a file system search (Windows-F) works even 
when another application is in the foreground (though I wonder if Windows-F is common knowledge amongst PC 
users, since so many of Window's other keyboard shortcuts use the Control key rather than the Windows key). 
Additionally, you can right-click on any folder and select Search to search the contents of that folder (similar to 
searching Selection in OS X's Finder window Search box). 

XP's search result is functional but cumbersome. Here's an example: I'll search for Photoshop. I type in Windows-F. 
The first thing displayed in XP's search application is an instruction "To start your search, follow the 
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instructions 
in the left 
pane". That the 
application 
requires written 
instructions is 
evidence of poor 
design. Next I'm 
instructed to select 
what type of item 
I'm looking for. 
There's no choice 
for me to look for 
an Application, so I 
choose All files and 
folders. 
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After clicking my 
choice, I need to 
read some more, 
and then finally 
I'm presented 
with a place to 
type in my 
search. I type in 
Photoshop. 
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Although XP found many items with the 
word Photoshop in it, including a shortcut 
to Photoshop, it never actually found 
Photoshop, because it's actually named 
Photoshp.exe. 

Readers' rebuttals: 

1.  8.3 file names are not a failing of the OS, but rather a failing of the application authors. However even 
Microsoft's own Internet Explorer is unobviously named iexplore.exe.

2.  It is incorrect to think that anyone would ever search their hard drive for "internet explorer", and even 
if they did, they could select one of the shortcuts and just locate the original. I would not presume that 
everyone will go about locating all of their applications using "acceptable" methods, and further I would not 
presume that everyone knows how to locate an original file if all they have is a shortcut. 

 
The Path column in the search results pane makes things less visually appealing, but one need not click each item 

individually to see the complete path. 

I disagree with readers that want to forgive XP for 8.3 file names and insist that users would never actually search 
for an application. 
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Locating files in XP could benefit from: 

●     Fewer instructions in the search screen to wade through
●     a search type-in box in every window (though per-folder searching is available by clicking the Search button 

or by right-clicking a folder and selecting Search)
●     fewer cryptic file names

Find/Search: OS X: 8, XP: 5 

Pick a topic:  
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XP: XP's Help and Support Center is a dizzying array of buttons and links: Home, Index, Favorites, History, Support, 
Options, Search, Add to Favorites, 
Change View, Print, Locate in 
Contents, and that's just the 
navigation buttons. The Help home 
page has no less than 4 major sections, 
one with 4 subsections, each section 
with between 2 and 5 text links. 
Depending on who's counting, the 
home page has more than 25 links to 
choose from. Someone in need of help 
does not want to wade through this 
amount of stuff to find what they're 
looking for. 

If you are connected to the internet, 
XP's Help and Support Center will 
search Microsoft's knowledgebase. 

You can often right-click an item and 
select "What's This?" from the context 
menu that appears in order to view a 
quick explanation of the item. 

While XP's Help and Support Center will provide some help for many applications (in the form of Overviews, 
Articles and Tutorials), and in-depth help of some applications (Troubleshooting applications, for instance), users 
would be wrong to assume that it is where they should go for all application-specific help. XP offers application-
specific Help from the Help menu within any application. So, if a user is in NotePad, and they want help, they 
must go to NotePad's help menu. Selecting Help and Support from the Start menu will not provide help for 
NotePad. 
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OS X: It's hard to imagine a more sparse Help 
interface than OS X's Help. Their design 
philosophy starts with the notion that a user in 
Help is only interested in either searching or 
browsing. As such, it has a search box and back, 
forward and home buttons. 

OS X's Help is context sensitive—if you select Help while in TextEdit, for instance, you'll automatically be taken to 
Help for that application. Since there is only ever one Help menu on the screen at a time, it is impossible to invoke 
help in a way that would not provide help for the application you are working in. 

Mac help seems to cover the basics only (maybe that's why I have yet to find error in their help docs). There is a 
channel in Sherlock to search Apple's technical knowledge base, but it's inconveniently not cross-referenced here. 
Like XP, the home page presented to you varies based on where you invoked Help. 

10.3's Help interface is snappy. Searches seem instantaneous. Help's Library menu provides a centralized repository 
of all currently installed application-specific Help topicsp.

Though both apps have their assets, both also have lots of room for improvement. OS X's Help needs more valuable 
info, while XP's help needs less clutter.

Help: OS X: 7, XP: 7 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Discuss  Categories:  

Keyboard

Keyboard shortcuts, Universal 
 

Keyboard shortcuts are great time savers for power users. To cut down on 
learning so many shortcuts, they should be easy to remember and consistent 
from one app to the next. 

Both OSes list keyboard shortcuts next to their corresponding menu 
items: 

  

OS X allows users to modify/create any keyboard shortcut, so for instance, if you 
don't like that -Q is right next to -A, you can change either one. 

The table below is my collection of what I think are the most critical keyboard 
shortcuts for every day computer use. 

OS X XP
Undo -Z Ctrl-Z 

New (File) -N Ctrl-N

New (Window) -N

Windows-E
(Ctrl-N in IE, not 
available at the 
command line) 

New (Folder) Shift- -N

Context key (the key in 
between Windows key 
and Right-Ctrl), W, F
or
Alt-F,W,F (not on 
Desktop) 
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Open -O

Ctrl-O 
(within applications)
Enter or Alt-F,O (open 
window or file in file 
system) Context key 
(the key in between 
Windows key and Right-
Ctrl), O (open window 
or file on desktop)

Close -W

ALT-F4 or
Alt-F,C (not available at 
the command line or 
NotePad)
Ctrl-F4 (to close a child 
window in an MDI 
interface)

Close All (Files, Windows) Option- -W (Finder, IE) Shift+Alt+F4

Save -S Ctrl-S

Don't Save (within Close 
dialog)

-D Alt-N

Cancel -. Esc

Copy (Selection, File) -C Ctrl-C (Enter key at the 
command line) 

Paste (Selection, File) -V

Ctrl-V (not available at 
the command line- 
Right-click and select 
Paste)

Beginning of line -left arrow home

End of line -right arrow end

Beginning of document -up arrow Ctrl-home 

End of document -down arrow Ctrl-end 

Find -F
Ctrl-F (within apps)
Windows-F or Windows,
S (from Desktop)

Quit -Q Ctrl-Q

Desktop (within Save dialog) -D
Tab key to Save in 
menu, then Arrow up to 
Desktop

Next App -Tab Alt-tab (Next Window)

Previous App Shift- -Tab Shift-Alt-tab (Previous 
Window)

Rename Selected File Enter F2

Select All -A
Ctrl-A (Doesn't work in 
IE's location bar or at 
the command line) 

Eject Disk/Volume -E

Send to Trash -Delete Delete

Delete Immediately (bypass 
Trash/Recycle Bin) Shift-Delete

Empty Trash Shift- -Delete

capture screen to file Shift- -3
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Ctrl-Shift- -3
Print Screen
Alt-Print Screen 
(Window to clipboard)

crosshair screen selection to 
file Shift- -4

crosshair screen selection to 
clipboard Ctrl-Shift- -4

Minimize All F11 Windows-M

Un-minimze All F11 Windows-Shift-M 

Out one folder -Up Arrow Backspace

In one folder -Down Arrow Enter

Expand selected folder Right Arrow Right Arrow

Collapse selected Folder Left Arrow Left Arrow

Connect to Server -K 

Ctrl-Windows-F 
(Searches for Comuters 
only, cannot browse the 
network) 
Windows-R (invokes the 
Run command, then 
type server destination. 
No ability to browse) 

Force Quit (brings up dialog 
w/list of apps to quit) -Option-Esc Ctrl-Alt-Del

Force Quit frontmost 
application Shift- -Option-Esc   

Both OSes impressed me that Undo can be used to undo file deletions and 
renamed files in the file system.

XP lacks shortcuts for some of these items, implements shortcuts incompletely or 
inconsistently and makes shortcuts that I find more difficult to remember than 
their Mac counterparts. 

It's also troubling that XP relies on the Windows key for system shortcuts, since 
not all keyboards have a Windows key (my IBM ThinkPad lacks a Windows key).

OS X goes out of its way to perform operations the way they *should* perform 
based on the context. For instance, I'm in a Finder window, I select a group of 
files and type -C (Copy). If I subsequently type -V (Paste) in another Finder 
window, it pastes those files into that window. However, if I pull up a text editor 
window and type -V, OS X pastes the names of the files. If I perform the latter 
in Windows XP, I get an error. More Apple keyboard shortcuts can be found in 
this Apple Tech Document. 

Keyboard Shortcuts, Universal: OS X: 8, XP: 7 
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Menu Navigation via the 
keyboard 

Both OSes support full keyboard navigation of their menus. Windows is on by 
default, while Mac users need to turn this feature on. 

OS X: Once turned on at: 
System Preferences>Keyboard & Mouse> Keyboard Shortcuts
Mac users get full keyboard access to the Dock, Active window, Toolbar, and 
Utility window (palette). Mac users can further set which modifier keys (when 
pressed with the Ctrl key). Either predefined letters, Function keys, or select 
your own custom keys. 

Unfortunately, navigating the menus via the keyboard looks like this: 

●     Type Control-F2 (or whatever keys you've assigned) to activate your 
application's menu

●     Hit your right arrow several times until you've arrived at the menu you 
wish to traverse

●     Start typing the first couple of letters of the command you wish to use, 
and/or hit your down arrow several times until you've selected the menu 
item you wish to use.

●     Hit enter

XP: Navigating menus in XP behaves like this: 

●     Hold down the Alt key, and the menus will Underline the letter you need 
to click to access that menu (In Outlook items are always underlined. I 
don't understand the difference.)

●     At this point, you can release the Alt key (though you don't need to) and 
type the letter corresponding to the menu you want to access

●     Continue clicking letters corresponding w/submenus. If the item you 
selected has no nested submenu, it will be activated. No need to hit 
Enter.

Frequent users of keyboard menu navigation will memorize the applicable keys, 
making this method of navigation lightning fast. 

Menu Navigation via the keyboard: OS X: 5, XP: 9 

Dialog Box Navigation via the 
keyboard 

OS X: To control 'Any control' in windows and dialogs, go to: 
System Preferences>Keyboard & Mouse> Keyboard Shortcuts 
and check "Turn on full keyboard access" at the bottom of the window. 

Navigating dialogs via the keyboard in OS X is thorough and consistent throughout 
all applications. Use the tab key to move from one control to the next. Use the 
space bar to open a drop down menu. Use the up and down arrows to navigate 
drop down menus, or just begin typing the first letters of the item you want to 
select. 

XP: Navigating dialogs via the keyboard in XP is thorough and consistent 
throughout all applications. Use the tab key to move from one control to the 
next. Use the up and down arrows to navigate drop down menus, or just type the 
first letter of the item you want to select. If there are several items that begin 
with the same letter, you may need to use your down arrow to select the correct 
one. 

Navigating dialogs in both OSes is quite good, but incomplete. I do not see the 
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value of having such a powerful feature turned off by default in OS X (in fact, I 
don't see the value in ever having such a feature turned off. XP dissappointed me 
in that it was unable to select an item from a menu when typing the first 2 
letters of the item. This makes selecting Missouri (MO) from this list of states : 
( MA, MD, ME, MI, MN, MO, MS ) more difficult than on OS X. This limitation of XP 
is true of all dropdown menus, and not just limited to dropdown menus in dialog 
boxes. 

Dialog Box Navigation via the keyboard: OS X: 8, XP: 8 

Navigating the file system via 
the keyboard 

Let's look at just the keyboard shortcuts that are used when navigating the file 
system. 

OS X XP

New (Window) -N Windows-E

New (Folder) Shift- -N

Context key (the key in 
between Windows key and 
Right-Ctrl), W, F
or
Alt-F,W,F (not on Desktop) 

Open -O

Enter or Alt-F,O (open 
window or file in file system) 
Context key (the key in 
between Windows key and 
Right-Ctrl), O (open window 
or file on desktop)

Close -W ALT-F4 or Alt-F,C 

Close All (Files, Windows) Option- -W Shift-Alt-F4

Rename Selected File Enter F2

Select All -A Ctrl-A

Eject Disk/Volume -E

Send to Trash -Delete Delete

Empty Trash Shift- -Delete

Out one folder -Up Arrow Backspace

In one folder -Down Arrow Enter

Expand selected folder Right Arrow Right Arrow

Collapse selected Folder Left Arrow Left Arrow

OS X: X's keyboard shortcuts are based one one modifier key, , plus one key 
(often a mnemonic). A third key is used to modify a command (Close vs. Close 
All, or Send to Trash vs. Delete Trash). 

XP: XP does not have keyboard shortcuts for every item. Some items can be 
invoked by using keyboard navigation of the menus, but that requires a multi-key 
combination (hold one or two keys, release, click a third key). Use of mnemonics 
seems virtually non-existent, making shortcuts more difficult to remember. 
Three of the above shortcuts use function keys, requiring even skilled typists to 
look down at the keyboard and lift their fingers away from their home keys. The 
unnecessary complexity required for these operations discourages Windows users 
from navigating the file system via the keyboard. 

Navigating the file system via the keyboard: OS X: 9, XP: 5 
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Application/Document 
Switching 

This section was originally Application/Document Switching via the keyboard, but 
that seemed to narrow. 

XP: XP supports window switching via the keyboard: 

●     Alt-Tab once to bring the window you were in most recently to the front
●     Alt-Tab repeatedly to cycle through all windows
●     Shift-Alt-Tab repeatedly to cycle through all windows in reverse

 
Alt-Tab to display XP's window switching interface. 

 
Download XP's Taskswitch Power Toy to display thumbnails of the selected 

window (left). Thumbnails of minimized windows are... minimized windows 
(right). 

XP also supports document switching within MDI applications only: 

●     Ctrl-Tab to cycle through open documents in the frontmost MDI 
application

XP has another method for application/document switching. Window key-tab to 
cycle through Taskbar items. Then you can up arrow to select a specific window 
w/in an app, and click return to select it. A little heavy on the number of 
keystrokes to get what you're after, but it certainly works. 

OS X: OS X supports both application and document switching via the keyboard: 
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-Tab to display Panther's application switching interface. Icons here sport the 

same badges as Dock icons, increasing their informativeness. 

●     -Tab once to bring the window you were in most recently to the front
●     -Tab to cycle through all applications
●     Shift- -Tab repeatedly to cycle through all applications in reverse
●     -` to cycle through open documents in the frontmost application
●     Ctrl-F4 to cycle through all open (non-minimized, non-Classic) documents
●     Bonus! -Tab once, then (while continuing to hold down  the key) type 

Q, Tab, Q, Tab, etc. to repeatedly quit applications. You can also type H 
while -Tabbing to Hide applications. 

OS X has another method for application/window switching, although you need 
to turn on full keyboard access first from the Keyboard Control Panel. Once it's 
turned on, you can click Control-D (Dock), then use your arrow keys to navigate 
your way through the Dock. You can select any menu item of any Dock icon, 
including Hide, Show in Finder, Quit or select any open window by name. You 
can also select any other custom menu items an application's Dock icon may 
contain. For instance, you can get mail or compose a new message, pause, play 
or advance MP3s or empty the trash. You can even launch non-running 
applications. 

Panther introduces a method of window switching that has no equivalent on any 
other platform: Exposé. 

 
Exposé in action. Roll over image to see these cluttered windows after Exposé 
rearranges them for selecting. Unfortunately, this rollover does not show how 
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the windows actually move and resize themselves into their new locations. A 
much better animation is available at Apple.com. Also, the good folks over at 

Ambrosia have created a jaw dropping video of Éxpose in action (MPEG-4, 
10MB). 

Can't see the window you want because others are in the way? Invoke Exposé and 
windows fly to their own discreet corners of the screen. Mouse over them to see 
their names. Click the one you want and windows fly back to their original 
positions, but this time with your selected window on top! While Exposé is 
invoked, you can type ` or tab to cycle through applications. As you cycle, 
Exposé will sequentially reveal (and arrange) all the windows of an application, 
dimming all others. 

Exposé has 3 different behaviors: show desktop, show all windows, or show 
windows of current application. It can be invoked either by function keys (user 
selectable), or by moving your mouse to different screen corners (also user 
selectable). 

Exposé has taken some to get used to, but it has definitely been worth the time 
invested in understanding it. I consider Exposé to be a little advanced for 
novices, and apparently so does Apple, since it is turned off by default. Windows 
flying across your screen could be confusing to the uninitiated. Apple's choice of 
screen corners for Exposé makes it very easy to invoke—I think a little too easy. 
I've accidentally invoked it at least once a day, which is mildly annoying. I could 
turn off the screen corners and rely solely on function keys, but on my 
PowerBook G4 function keys are actually a two key combination, making them 
less desirable as shortcuts. 

Which OS handles application switching better? XP's Alt-Tabbing is window 
centric, while Panther's -Tabbing is application centric. Panther enables 
document cycling via -` or Ctrl-F4. Like OS X, XP's Window key-Tab method 
allows for more precise cycling first through applictions, then through 
documents, as long as Taskbar items are grouped. Panther's Control-D method 
offers considerably greater control but this feature must be turned on. However, 
for Application/Document switching, Exposé takes the cake. It is much more than 
a welcome addition to my computer—the concept of minimizing Windows has 
seen its heyday. 

Application/Document Switching: OS X: 9, XP: 7 

Shutting down via the 
keyboard 

Let's look at keyboard shortcuts that are used shutting down the computer: 

OS X XP

Shut Down (prompts to save docs) Control-Option- -
Eject 

Power Key or 
Windows, U, U 

Restart (prompts to save docs) Control- -Eject Windows, U, R

Sleep -Option-Eject  

Dialog to choose Shut down, Restart, 
Sleep, or Cancel. Control-Eject

Alt-F4 or Power 
key (if you 
modify that key)

OS X: Upon initiating a shutdown sequence, busy applications ask you what to 
do. If you find that an application was doing something that you don't want to 
stop, you can cancel the shutdown sequence. For instance, if Safari is 
downloading files, it will prompt you with, "There are downloads in progress, do 
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you want to quit? Don't Quit—Quit." Selecting Don't Quit cancels the shutdown 
sequence (and a subsequent dialog says so). 

XP: (Thanks to UnnDunn for this explanation) 
"There are three 'standard keyboards': 101-key, 104-key, and 107-key. 101-key 
are basic and are almost impossible to find in stores anymore. 104-key are the 
ones which include Windows and Context keys. 107-key also add the 'Power/
Sleep/Wake' keys. 

"The location and design of the power/sleep/wake buttons really depend on the 
manufacturer of the keyboard. But they are usually identical in design to 
standard keys, and are located above the six keys above the arrow keys. 

"If you are asked to save your document and you elect to cancel, the shutdown 
process is stopped (but you are not notified). 

"It is also worth mentioning that the power button on the front of the computer 
does the same thing as the power button on the keyboard. However the keyboard 
power button cannot be used to power on the machine."

The default behavior of the Power button on these keyboards is to immediately 
shut down, only prompting you if an application is busy or if a document is 
unsaved. This default behavior can be changed: "right-click on the desktop, go to 
Screen Saver, click Power Options at the bottom, then click over to the 
'Advanced' tab. At the bottom is the option to change the behavior when the 
'power' and/or 'sleep' buttons are pressed." For instance, you can change the 
Power button to 'Ask me what to do'.

More ways in X to shut down your computer...
In addition to shutting down your computer via the keyboard, OS X can 
schedule automatic startup and shutdown. XP lacks this feature. 

 
Schedule automatic startup and shutdown 

It seems to me that it is a mistake to have the default behavior of a Power 
button that resembles standard keys (and is mixed in with standard keys) be to 
shut down without prompting the user "Are you sure you want to shut down?". 
Accidental key presses could yield highly undesirable results. 

Furthermore, since keyboards vary from one manufacturer to the next, it would 
be preferable to have a multi-key sequence to perform these operations: multi-
key sequences are harder to accidentally invoke and they can use keys found on 
all keyboards. For instance, I've spotted 3 different models of IBM ThinkPads that 
lack Windows keys. Yet another option is to have the power key be physically 
separated from the rest of the keys and to have it not protrude above the 
surface of the keyboard (like most modern Mac keyboards). This seems to be an 
issue that is difficult to separate from being either hardware or software.

Furthermore, OS X deserves kudos for its ability to schedule startups and 
shutdowns. 
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Shutting down via the keyboard: OS X: 9, XP: 8 

Keys, non-standard (accent 
marks, mathematical 
operators, etc.) 

©, ç, ñ, É, — (m-dash),– (n-dash), ° “” ‘’ ≥≠, etc, etc. Since none of these 
characters has its own key on a keyboard, typing them can be a challenge.

OS X: Characters with accent marks are easily learned (via Keyboard Viewer) and 
typed on the Mac, as are common typographic characters such as em and en-
dashes and curly quotes and apostrophes. Most non-ascii characters are an easy 
to remember 2 key sequence. For instance, ñ is option-n n. É is option-e E. ≥ is 
simply option->. 

Keyboard Viewer 
Apple's Keyboard Viewer shows you what characters are made by typing 
modifier keys. 

Keyboard Viewer is a very interactive program. This screen shows that I was 
holding down the Option key (the light gray key). All the other keys show 
what character would be typed if I clicked that key at the same time. The 
keys with the solid white outline are accent marks. Hit the accent mark, 
then type the letter that you want to apply the accent to. 

To get Keyboard Viewer, go to: System Preferences>International>Input 
Menu, and check Keyboard Viewer. Once checked, it will show up in your 
Input Menu (the menu with the flag in the upper right corner of the screen). 

The Character Palette 
provides quick access to 
typing dozens of non-
standard characters. 

The Character Palette is 
located in the Input Menu, 
which can be added to your 
menus by turning it on at 
System Preferences> 
International> Input Menu. 

For more exotic 
characters (dingbats, 
etc.), use the Character 
Palette. The character 
palette can also be used 
to type far eastern 
characters, such as 
japanese and chinese. 

XP: PC Users have no equivalent to Keyboard Viewer. They must use the 
Character Map application to type most non-standard characters, or remember 
their 3 digit numeric value and type them in on their numeric keypad. 

An alternate strategy to typing accented characters is to use the US-International 
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 Need to type Ñ in Windows? 
No problem! Just type Alt
+209. Can you remember 
that?

 Microsoft's Character map 
app includes advanced 
browsing. 

keyboard layout. You can 
do this from Start-
>Settings->Control Panel-
>Regional and Language 
Settings, Language Tab, 
Details button. Then you 
can type ñ by typing ~ 
followed by n. However 
the US-International 
keyboard layout has its 
liabilities too. For 
instance, the double-
quote key stores the 
Umlaut accent mark. 
Type "E and you'll get Ë. 
To get "E you need to 
type "[space]E. By 
contrast, OS X stores the 
Umlaut under Option-U, which is easy to remember since umlauts are most 
commonly seen over the U character. 

Here's a decent chart of keyboard shortcuts from Harvard of Accents & special 
characters for Mac and Windows.

Keys, non-standard: OS X: 9, XP: 5 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Discuss  Categories:  

Applications, adding/removing

In both OSes quality of installation of applications is left up to the manufacturer of the software, with each OS 
providing guidelines for what they recommend as the 'correct' way installation and uninstallation should work. 

Both OSes application updaters are not perfect. Occasionally, application installers will require that the user quit out 
of certain programs before the installer will proceed. This behavior has been witnessed in Windows Messenger for XP 
and both iLife and iCal for OS X. 

OS X: OS X seems to have an equal mix of installer apps and 'drag-install' apps: they can be dragged to any location on 
your hard drive (accompanying Readme files will explain if the app needs to reside some place specific). Most apps will 
say "drag this into your Applications folder", which is simple enough for even the most novice Mac users. Apps that 
must reside someplace specific require a little more effort on the users part. 

 
A Drag-Install App. This is a standard window with a custom background image. The background image contains the 

instruction, to drag the folder to your Applications folder. Since the Applications folder is in the toolbar (the A icon), 
just drag onto that and your done). 

Packages: OS X has interesting way of packaging applications. Application folders behave like files. These file-like 
folders are called Packages. It allows application developers to store all the various files related to the application in 
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one place, but to the user, the whole package is one file. So the user can move this file anywhere on the hard drive 
and all the related components will go with it. 

Virtually all OS X apps can be uninstalled just by throwing it's package away and then emptying the trash. The 
exceptions are Control Panels and 'haxies', apps that alter the way the operating system behaves. These items should 
come with uninstallers, but that is left to the discretion of the software developer. 

One large advantage to drag-installations is that multiple versions of an application can easily be installed on a 
machine, and can even run simultaneously. When Internet Explorer 5 first came out, I often ran IE5 and IE4 
simultaneously so that I could compare differences. I also have Office 98 and Office X on my computer, because I 
prefer Word 98's Save as HTML feature over that of Word X. Neither of these to examples are possible on XP, or if they 
are, they are very difficult to make happen. 

The drag-uninstall method is not perfect. For instance, I opened my Firewall Preference Pane to edit my firewall and I 
got a dialog notifying me that I was already running a third-party firewall and that I had to disable it before I could 
continue. This puzzled me for some time, since the dialog did not tell me what third-party software was controlling my 
firewall, requiring me to figure it out myself. I had installed BrickHouse a long time ago and threw it away not too long 
after installing it. Little did I know that throwing it away isn't sufficient to get it to relinquish control of my firewall. I 
had to re-download it and read the FAQ to learn that I had to throw away an additional folder located in my /Library/
StartupItems/ folder. This issue could have been resolved by the application developer providing an uninstaller. 

XP: Windows XP has an Add/Remove Programs control panel. Though not particularly useful for installing software, it 
can be very useful for uninstalling programs or system enhancements on your machine. In order for an application to 
recieve Microsoft's XP Certified label, it needs to come with it's own uninstaller application (which can be invoked from 
the Add/Remove Programs Control Panel). Drag uninstall is not recommended, as this method doesn't remove any 
references to the app that may be in the system registry. 

PC installs/uninstalls frustrating? Don't take my word for it: 

"Windows users just get used to annoyances that Mac users don't have to put up with. Exhibit A: the Registry. 
That nightmarish Microsoft innovation means it's far easier to move applications between Macintoshes than it is 
to go through the grueling reinstallation process that keeps PC users clutching their current machines rather 
than upgrading." 

Stephen Manes, PC World
Full Disclosure: Sick of Blue Screens? Get a Mac! September 2002 

"I tried reinstalling Medal of Honor, a WWII game. For whatever reason, it stopped while it was installing this 
massive game before it was finished. The system frooze complelety. I had to turn the power off and then try to 
install MOH again. MOH wouldn't install because it told me it was already installed. I ran the uninstaller, but 
Windows still thought that Medal of Honor was installed so it wouldn't let me install it. I ran the MOH "Repair" 
from the install disk and the "Modify" and nothing worked. I finally had to download RegCleaner and delete the 
references of MOH in my Windows registry before I could try to install MOH again." 

Mac Fan
My Wonderful Day with Windows XP 

"This is a classic problem," said Ivo Salmre, .Net and developer tools and technology manager at Microsoft, 
speaking to ZDNet UK. "We have been beaten over the head about this for years now. You ship an application 
that uses component A. Someone else writes an application that also uses component A, but installs a newer 
version, and this breaks the first application." 
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Matt Loney, ZDNet (UK)
Microsoft promises end to 'DLL hell' March 3, 2003 

XP's uninstaller service isn't perfect either. For instance, look at what happens when you try to remove a program on 
XP that has 'shared dlls'. First of all, a user shouldn't even have to know what a dll is, but XP expects them to not only 
know what a dll is, it expects users to decide which dlls to keep and which to remove when uninstalling a program. 

 
Huh? Like ANY user is supposed to know the answer to this question??? 

To get the screen shot above, I uninstalled one program I never used. I was asked to decide whether to keep no less 
than 8 shared dlls! How am I supposed to know if any other application needs npmod32.dll??? To any PC user that is 
planning on emailing me to defend this practice, I have one answer: OS X never asks users to make such a decision. 
Never.

Another flaw in XP's Add/Remove Programs service is that it relies on the application developer to provide the 
uninstaller. This means that application developers that don't want their product to be uninstalled will simply not 
provide an unintstaller. Gator acknowledges that that their GAIN product is not listed in Add/Remove Programs. 
Symantec considers adware to be such a problem that they Norton Antivirus 2004 now detects adware, even though 
adware is considered legitimate software, since at some point a user must consent to its installation (even though the 
user may not realize it). 

Though neither OS's method of adding and removing programs is perfect, X's has considerably fewer opportunities for 
failure. XP's reliance on uninstallers means that XP users are at the mercy of application developers to create safe and 
thorough uninstallers for every single application on their computer. It also means that XP users should never move or 
rename application folders, since XP's uninstaller service relies on the exact path to the uninstaller at the moment it 
was installed. 

Applications, adding/removing: OS X: 7, XP: 5
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Pick a topic:  
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Discuss  Categories:  

Applications, Audio

Audio, Overview 
 

OS X ships with iTunes for playing music, while XP supplies Windows Media Player. Both 
OSes audio applications support integrated burning, graphic equalizer, visualizers (WMP 
supplies more), album art, internet radio and play a variety of audio formats. Both apps 
offer 'smart playlists': dynamic playlists based on listening trends ("last 25 songs") or MP3 
tags ("60's Music"). (XP calls them "auto playlists" and I found them considerably more 
difficult to create in WMP than in iTunes). Both apps offer the ability to burn CDs of 
playlists (iTunes 4 offers the ability to burn DVDs of playlists. It also automatically spans 
large playlists over multiple CDs or DVDs when burning). Both apps can protect your ears 
from loud spikes in music: iTunes calls it Sound Check while WMP calls it Quiet Mode. Both 
apps can burn MP3s (though iTunes supports more bit rates). Both apps have a "quick 
search" feature, though only iTunes' is search-as-you-type (WMP's you must click the 
Search button.) Both apps allow you to download purchased music. (which is covered in 
the next section).

Both iTunes and Windows Media Player are available for their non-native platforms 
(iTunes for Windows and WMP for OS X) though WMP for OS X is just a bare bones video 
player, lacking almost all of its XP features (media library, album art, music stores) and is 
sluggish playing all but the simplest videos.

 
iTunes is elegant and minimalist. Buttons are well organized. (iTunes 4 shown here). 

OS X:(Thanks to Thomas 'Beelsebob' Davie for help with the following section.)

OS X comes with iTunes , which is a full featured audio application, with built in MP3, AAC 
and Apple Lossless encoding, integrated burning, graphic equalizer, visualizers, 
Rendezvous-based music sharing, integration with iPod, online music purchasing and 
internet radio. 

Apple's Lossless encoder will import music into iTunes without losing any quality (unlike 
the MP3, AAC and WMA formats). The party shuffle feature makes iTunes intelligently 
build a play list for your party as it happens. You can drag new songs into the mix, move 
songs you don't want on out of it, and shuffle songs around to your heart's content. 
Finally, iTunes 4.5 allows you to produce CD inserts for your music - once you have 
downloaded your music from the iTunes Music Store, you can simply select the album and 
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chose print, upon which iTunes will make you a CD insert.

If your track names need fixing, select your songs, then select Advanced > Get CD Names 
to use the online CDDB to correct your tags. You can the easily fetch info about the track 
by clicking the little arrow next to it - this will take you to the iTunes Music Store page 
for the track/artist/album.

iTunes can be operated even when hidden, via its Dock menu (left). 

iTunes' Rendezvous music sharing means you can stream your MP3 library to anyone on 
your local subnet, and you can stream your songs purchased through the Apple Music 
Store with up to 3 of your own computers. 

Purchase AirPort Express to wirelessly play iTunes 
through your home stereo (right). 

iTunes has its gaffe moments. Burning a CD is one of them. If you put a blank CD in the 
drive, and click the burn button, the CD drive will confoundingly open up and tell you to 
put in a blank CD. When this scenario happens, users will end up having to hit the burn 
button a total of 3 times in order to initiate the burn. 

XP: (Thanks to many forum members for help with the following section.)

Whereas Apple has separate applications for audio, video and DVDs, Microsoft has chosen 
to place all of these tasks in one application, Windows Media Player. 

WMP10 finally offers free MP3 encoding, though only at 128, 192, 256 and 320kbps (as 
opposed to iTunes which offers 16 different bit rates from 16 to 320kbps, as well as 
Variable Bit Rate Encoding). 

Windows Media Player 10: 
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If you want to control WMP from the Taskbar, enable 
mini-mode (right) when minimizing. (WMP9 
Powertoys allow WMP to be controlled from the 
Tray). 

Pressing the little down arrow brings up a hierarchical menu of 
all the artists, albums, playlists, radio stations and videos in 
your media library.

Online Services: If you have MP3 files with incorrect MP3 tags, you can use the 'Find 
Album Info' feature to search allmusic.com for information on your song, and have that 
information applied to your file. (Searching DVD data searches allmovie.com)
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All of the file's tags are corrected, and the file is automatically renamed and moved to its 
rightful folder in your file system. WMP also supports more tagging options than iTunes - 
support for multiple artists per song allows much more easy tagging of tracks that were 
performed by multiple artists.

Info Center View allows you to get all sorts of extra information about the artist/album 
you are listening to:

 
Info Center View (WMP9 shown here) 

WMP too has its gaffe moments. Microsoft has chosen to place some important functions 
under some small buttons. Your CD drive is accessed via a small downward facing arrow 
next to the Now Playing menu (though computers with auto-play enabled will display CDs 
automatically when inserted). Another small arrow near the upper right corner of the 
interface accesses the File, Edit, View, etc. menus. 

In order to get to the bottom of which player is better, lets read how a few industry 
experts compare iTunes to WMP10: 
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●     Paul Thurott of WinSuperSite.com: "Apple's iTunes is the simplest, most elegant 
media player available for any platform, and the release of WMP 10 doesn't change 
that... 

"iTunes also offers some basic features that WMP 10, tragically, lacks. First, it's 
compatible with the iPod, the world's best-selling portable audio player, a feat 
Microsoft can't seem to manage. Second, iTunes lets you easily share music from 
PC to PC (or from Mac to Mac or Mac to PC), a feature that WMP, inexplicably, still 
lacks... Microsoft will argue--wrongly, I think--that there are ways to share music 
from PC to PC. These methods, however, require customers to understand home 
networking concepts that are typically more advanced than one might expect from 
an average user. With iTunes, sharing music just works. If I'm not mistaken, 'it just 
works' is one of Microsoft's favorite terms. They might start practicing what they 
preach."

●     C|Net "The app still isn't as user-friendly as Apple's iTunes"

Audio formats supported out-of-the-box by OS X and XP

OS X (full list) Windows XP

3GPP, 3GPP2 yes

AAC yes

AC3 yes yes

Apple Lossless yes

Au, Snd yes yes

Audiobooks yes

AIFF yes yes

MIDI yes yes

MPEG-2 AAC sold separately yes

MP3 (MPEG-1, Layer 3) yes yes

M3U (MP3 playlists) yes yes

MPEG 4 (ISO standard) yes

MPEG 4 (Microsoft's proprietary version) yes

WAV yes yes

WMA converts non-Copy Protected 
WMAs to AAC yes

WMA Pro yes

WMA Lossless yes

WMP10 

●     More skins (iTunes doesn't have any), and more customization options for the 
interface

●     More built-in visualizers 
●     View Album art of any song 
●     SRS WOW Effects
●     Play speed settings, to play it using various speeds from slow to fast
●     No music sharing feature (though files may be copied to other computers)

iTunes 

●     Fewer built-in visualizers 
●     No skins
●     iTunes only fetches art of songs purchased through iTMS
●     Simpler interface
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●     search-as-you-type
●     More flexibile MP3 encoding
●     Party shuffle
●     CD insert printing
●     Rendezvous Music Sharing

Envious XP users can download iTunes for Windows, and envious Mac users could 
download WMP for OS X, though WMP for OS X is just a player, lacking the music/video 
library features, skins, visualizers, album art, SRS WOW effects (basically all the unique 
benefits of WMP for XP)

Applications, Audio, Overview: OS X: 9, XP: 8

Audio, Purchasing 
 

this section is incomplete 

Both iTunes and Windows Media Player 10 allow you to download purchased music. WMP 
has more stores (five), while the iTunes Music Store has more songs (1 million). Music 
purchased through WMP will not play on the iPod. Music purchased through iTunes will 
only play on the iPod (or on your computer, of course). 

(Thanks, UnnDunn for the following paragraph). All media sold through the WMP10 Digital 
Media Mall (DMM) is encoded using Windows Media 9 with DRM 7.1. While Windows Media 
Player 9 for Mac plays WM9 files, it doesn't support DRM 7.1 (it only supports DRM 1.2). 
Also there is no Mac player that supports DRM 7.1. 

OS X: 

Apple's iTunes Music Store:

 

The site is very well designed- both beautiful and easy to navigate. Even if you aren't 
interested in purchasing, browsing the store is very entertaining, because you can listen 
to 30 second clips of every one of the 1,000,000 songs in the store. If you purchase music, 
the audio quality is great, the prices are reasonable (.99/song, and often $10/album), and 
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the digital rights seem sufficiently liberal that only blatant music swappers will complain. 
Read what others have to say about the music store and Apple's digital music rights:

●     Apple's music: Microsoft's sour note? C|Net News
●     Steve Jobs blesses DRM, and nothing happens The Register
●     About Authorization and Deauthorization Apple Knowledge Base 

XP: 

Microsoft's MSN MUSIC:

 

If you think MSM MUSIC looks familiar, you'd be correct. A Microsoft spokesperson told 
New York Times writer David Pogue that "Apple set the bar very high. ... We're trying to 
match that. We told our developers, 'Look at how Apple does it.'" Pogue goes on to say 
that MSM MUSIC "couldn't look more like Apple's iTunes music store (itunes.com) if you ran 
it through a copying machine." 

WMP now allows users to purchase and download music. Rather than build their own 
store, Microsoft has created a "framework" for third parties to sell music directly through 
WMP. So rather than having one store, WMP has many: 

●     MSN Music
●     Napster
●     CinemaNow.com
●     MusicNow!
●     MusicMatch
●     Walmart Music Store
●     XM Radio
●     Court TV Extra
●     f.y.e. download zone
●     Puretracks.com
●     Audible.com

http://www.xvsxp.com/applications/audio/ (7 of 8)1/1/2005 5:49:24 AM

http://news.com.com/2100-1027-998880.html?tag=cd_mh
http://www.theregister.co.uk/content/6/30458.html
http://docs.info.apple.com/article.html?artnum=93014
http://www.nytimes.com/2004/09/16/technology/circuits/16POGUE-EMAIL.html
http://www.nytimes.com/2004/09/16/technology/circuits/16POGUE-EMAIL.html


X vs. XP > Applications, Audio

●     MLB.com

Napster requires a $9.95 monthly subscription fee (though "Napster lite" does not). 

●     Walter Mossberg, the WallStreet Journal: "Microsoft Challenges Apple's iTunes 
Store, But It Isn't There Yet"

WMP10 

●     Multiple music stores
●     Licensing varies from store to store, and may even vary from song to song

iTunes 

●     Online Music Store has just one licensing policy for all purchased music
●     OS X users only have ONE online music store to choose from

Applications, Audio: OS X: ??, XP: ??

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 
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Video, Playback 
 

Dan's Book Recommendations: 

Let me start by saying that Microsoft and Apple have competing video solutions: 
Windows Media and QuickTime. There is no single application that plays both file 
formats, however each company's player is available for both platforms: 
QuickTime Player is a free download for XP users and Windows Media Player is a 
free download for OS X users (caveat: XP users can install QuickTime Alternative 
in order to play QuickTime movies in WMP). Disappointingly, the Mac version of 
Windows Media Player does not play all avi files. The good news is that QuickTime 
is plug-in based, meaning you can download free third-party plugins to enable 
other video formats (like avi). For more exotic video formats (3ivX, DivX), Mac 
users can download the freeware VLC or MPlayer. Windows Media Player will 
automatically download and install a required plugin if it can find it. 

OS X: OS X ships with QuickTime 6 for video playback. 

QuickTime 6 is the first video player to support the 
excellent MPEG-4 file format. Although QT Basic doesn't 
have a Full Screen command (the $30 QT Pro does), 
there are workarounds. Apple provides 100 free 
QuickTime Script Menu scripts, enabling workflows like 
SMIL creation, Export to DV stream, HTML Embed Tag 
Wizard, and much more. 

$30 for Full Screen Playback? That Sucks!
Well, yeah, it does suck. However, 

1.  there are workarounds
2.  That $30 gets you a whole lot more than just full screen mode

The $30 gets you QuickTime Pro (which just happens to have a Full Screen 
menu command built-in). QT Pro allows editing of video content- Cut, Paste, 
Trim, Add Tracks, Remove Tracks. You can compress (or recompress) your 
video or audio to a wide variety of file formats (the file formats the QT Pro 
imports is formidable). You can create media skins, slide shows, automate 
your workflows and more. So don't spend $30 just to get full screen. Spend 
$30 for a lean and mean video editor. 

Expect to shell out another $20 if you want to play back MPEG-2 content. XP 
doesn't charge for this. 

Ok, so what's good about QuickTime? In addition to it's well laid out interface, it 
supports 'live scrubbing' of the video. That means that as you drag or 'scrub' the 
playhead left and right over the timeline, the video will keep updating itself to 
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correspond with wherever your playhead is. And it does an excellent job at it. You 
can even live scrub MPEG-4 streams with virtually the same quality as if the video 
was on your hard drive. Play VCDs and SVCDs directly in QuickTime by selecting 
the .dat file from the File>Open menu (SVCDs requires the separate MPEG-2 
component). 

XP: XP (home and professional) ships with Windows Media Player (renamed 
Windows Media Player 9 Series) for watching videos (covered in the Audio 
section). Just as QuickTime supports most video formats except for .rm, certain .
avi files and .wmv, Windows Media Player supports most video formats except for 
QuickTime, MPEG-4 and Real format. WMP additionally supports VCD and SVCD 
format.

Video in Mini-Mode: The double-headed arrow in 
the upper-right hand corner of WMP9's mini-
mode allows you to play videos in a small 
window attached to the Taskbar.

Windows Media Player doesn't support live 
scrubbing. To find a section of video you need to 
drag the playhead and release it in order for the 
screen to update. (Mplayer2, however, has 
limited live scrubbing support. Invoke it by 
typing mplayer2 in the Run dialog.Windows users 
wanting live scrubbing can also install QuickTime or AVIPreview.) 

WMP's playlists are handy, and it's full screen mode is versatile. While in full 
screen mode, move your cursor to the bottom of the screen and your player 
controls will appear.

Neither OS's solution is nirvana. WMP lacks live scrubbing and support for MPEG-4. 
QuickTime Basic requires the download of a script to enable full screen mode, and 
lacks free MPEG-2 support. While I'm a massive fan of live scrubbing, I've heard 
plenty of WMP fans claiming that built-in full screen support and MPEG-2 playback 
far outweighs live scrubbing and MPEG-4. WMP edges out QuickTime with a more 
versatile full screen mode. 

OS X:

●     Live scrubbing
●     Brightness/Contrast control
●     Bass/Treble/Pan control
●     Upgrade to QT Pro for editing/exporting control
●     No native full screen support in QT Basic (via AppleScript or upgrade to 

Pro)
●     No free MPEG-2 support (means no free SVCD support)
●     No Hue/Saturation control
●     No on-screen controls during full screen mode (keyboard controls)
●     Annoying "Upgrade to Pro" advertisement appears every time you launch 

QuickTime

XP:
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●     MPEG-2 SVCD support
●     Hue/Saturation/Brightness/Contrast control
●     Equalizer
●     TruBass SRS Wow sound
●     Video playlists: queue up parts 1 and 2 of a movie and watch them without 

interuption
●     On-screen controls during full screen mode
●     No MPEG-4 support
●     No live scrubbing

Video, Playback: OS X: 7, XP: 9 

Video, Editing, Overview 

Dan's Book Recommendations: 

OS X: OS X ships with iMovie for video editing. All models that contain DVD 
burners also ship with iDVD. The good news about upgrading to QuickTime Pro 
(the $30 upgrade), is that in addition to full screen playback you get a bunch of 
other great video and audio editing features, including: encode and transcode 
media in dozens of formats, including MPEG-4 and edit video and audio using 
simple cut, copy, and paste functions. 

iMovie has been widely acclaimed as the 
best free video editor on any platform, and 
even outperforms editors that cost 
hundreds of dollars. 

Cons? iMovie edits in uncompressed DV format, which requires lots of disk space.

 

Windows Movie Maker 

 

Windows Media Encoder 

XP: XP (Home and Professional) ships with 
Windows Media Encoder for encoding 
videos, Windows Movie Maker for editing 
videos and Windows Media Player for 
watching videos.

Windows Media Encoder won't win any 
beauty contests, but it does support 
screen capture to video, one thing none 
of Apple's products can do. (Mac users will 
have to get Ambrosia Software's $49 
SnapzPro to capture their screens to 
video). Unsurprisingly, Windows Media 
Encoder encodes all its files to one format 
(.wmv, Windows Media format). 

Likewise, Windows Movie Maker only 
supports .avi, .wmv and .mpg for video 
import formats and only exports videos 
to .wmv or DV-AVI. 
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I won't score either OS here, since these topics are scored in the following in-
depth sections. 

Video, Editing, Overview: No Score 

Video, Editing,
Adding Video to your project

Both OSes are comparable at importing video from a camcorder. 

Video, Editing, Adding Media: OS X: 9, XP: 9 

Video, Editing,
Adding Audio to your project

Both iMovie and Windows Movie Maker support recording live audio to import into 
your movies. Both allow you to traverse the file system to add music to your 
projects. 

OS X: iMovie's Audio pane allows direct access into your iTunes library so you can 
add your favorite songs to your movies. They also supply 27 sound effects create 
by Skywalker Sound, as well as 10 other sound effects. You can visually edit the 
sound volume of sounds in your timeline, creating nice fade ins or fade outs.

 

Drag songs from iTunes directly into 
your iMovie timeline

Because iMovie has an integrated iTunes 
library pane, you can browse any albums 
or smart (keyword/meta data-based) 
albums you created in iTunes, thereby 
allowing you the benefit of using the 
organizational structure you have 
established there to manage your media. 
As nice a feature as that is, sometimes a 2 
inch by 5 inch window into a 1000+ song 
music library just doesn't cut it. OS X 
users are covered there too, since they 
can drag songs from their iTunes library 
(shown here) directly onto the timeline of 
their iMovie project. 

XP: WMP 10 has the ability to create playlists and "auto playlists" as an 
organizational structure for managing music (I found WMP's auto playlists 
considerably more confusing to create than iTunes' smart playlists.) 

Once you locate the perfect song in Windows Media Player you cannot drag it into 
your Movie Maker timeline (you cannot drag it from WMP into WMM at all). This 
means that you'll need to locate the song in the file system. Windows Media 
Player doesn't have a method to directly locate the song file in the file system, 
but rather has the Open Containing Folder command, which requires you to again 
select the song file once the containing folder is opened. At that point you can 
add the song to your project by dragging, but you cannot drag it directly to the 
point you need it in your timeline. Drag-importing it will only add it to your 
project's Collections area. You need to select it a third time from your Collections 
area and drag it to the timeline. For those of you keeping track, XP requires that 
you select a song file three times in order to get it from Windows Media Player 
into your project's timeline, whereas you can do all of this in one drag in OS X. 

Windows Movie Maker doesn't have any built-in sound effects to add to your 
movies, however 50 sound effects and 3 full length songs are available for 
download in the Windows Movie Maker 2 Creativity Fun Pack.

Video, Editing, Adding Audio: OS X: 8, XP: 4 
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Video, Editing,
Adding Photos to your project

Both OSes allow you to traverse the file system to add pictures or music to your 
projects. 

OS X: OS X's iMovie has an integrated view directly into your iPhoto library. So you 
can browse any albums or smart (keyword/meta data-based) albums you created 
in iPhoto, thereby allowing you the benefit of using the organizational structure 
you have established there to manage your photos. Additionally, OS X users can 
drag photos directly from iPhoto onto the timeline of their iMovie project. 

iMovie's Ken Burns effect brings still images to life by adding a pan/zoom effect 
that's very easy to master. Still images brought in to the timeline via the Photos 
pane get the Ken Burns effect (stills dragged from the desktop don't get the Ken 
Burns effect automatically). To disable the Ken Burns effect, Cancel effect from 
the keyboard (Command-.), or upgrade to version 3.0.3 for a checkbox to disable 
this effect. 

XP: While XP users could create their own organizational structure in the file 
system, XP has no method of creating meta-data driven collections of photos. 
Furthermore, the file system expects a file to reside in one location. XP users 
wanting to recreate the "libraries" behavior of iPhoto in their file system would 
have to spend time creating shortcuts of any files they wanted to reside in more 
than one library. This method would quickly become too tedious when attempting 
to manage thousands of photos. As with importing audio, XP users cannot drag 
photos from the file system directly on to their timeline. They must first import 
the photo into the project, at which time they can drag the photo from their 
collections area onto the timeline. 

In Windows Movie Maker it was very easy to alter the duration of a still image in 
the time line, simply by dragging its right edge left or right. I could make still 
images last for under one second, or longer than 25 seconds. Setting the duration 
of a still image in iMovie was considerably less intuitive. The edges of clips in the 
timeline are not draggable. You alter the duration of a clip by selecting the clip 
and then dragging the speed slider (indicated by hare and tortoise icons at either 
end of the slider). If you want a clip to last shorter than one second in iMovie, 
double-click the clip to edit its duration numerically (Using iMovie 3.0.2). 

XP users can download Photo Story 3 to create video slide shows. While Photo 
Story 3 is quite good at creating video slide shows, it is solely for creating video 
slide shows. If you want your project to contain a mixture of photos and videos 
you must use Windows Movie Maker. 

Video, Editing, Adding Photos: OS X: 8, XP: 6 

Video, Editing, Filters
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Here's a screen grab of the effects pane in 
Windows Movie Maker showing their list of 
effects (Watercolor not shown). I want you 
to notice their 3 Film, Age effects- Old, 
Older and Oldest. 

Now here's the video effects panel in iMovie 
3, showing the Aged Film effect. Notice that 
Apple only has one effect for Aged Film, but 
its effect has three adjustable sliders, 
allowing you to control the aspects of aged 
film, Exposure, Jitter and Scratches. In 
addition to the three adjustable settings, 
they have Effect In and Effect Out sliders, 
allowing your effect to gradually ease in 
and out of your film clip. 

Which would you rather have, three filters 
for aged film with no adjustable settings, or 
one filter with five adjustable settings? 

http://www.xvsxp.com/applications/video/ (6 of 15)1/1/2005 5:49:31 AM



X vs. XP > Applications, Video

Effects compared 
iMovie Windows Movie Maker
Adjust Colors Hue, Cycles Entire Color Spectrum

Aged Film Film Age, Old
Film Age, Older
Film Age, Oldest

Black & White Grayscale

Brightness & Contrast Brightness, Decrease
Brightness, Increase

Earthquake  

All iMovie filters have Ease In and Ease Out 
sliders

Ease In
Ease Out

Electricity  

Fade in and out are available as transitions
Fade In, From Black
Fade Out, To Black 

Wash In and out are available as transitions Fade In, From White
Fade Out, To White

Fairy Dust  

Flash  

 Film grain

Fog  

Ghost Trails  

Ken Burns Effect  

Lens Flare  

Letterbox  

Mirror Mirror, Horizontal
Mirror, Vertical

N-Square  

 Pixelate

 Posterize

Rain  

 
Rotate 90
Rotate 180
Rotate 270 

Sepia Tone Sepia Tone

Sharpen  

 Smudge Stick

Soft Focus Blur

 Threshold

Speed Up and Slow Down are available in the 
timeline

Slow Down, Half
Speed Up, Double 

 Watercolor

Total: 23 Total: 18

Video, Editing, Filters: OS X: 8 , XP: 7 
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Video, Editing, Transitions Windows Movie Maker clearly has more transitions (60) than iMovie (13). 
 

Applying Transitions: 

XP: Creating transitions is a piece of cake in Movie Maker. If you have two clips 
adjacent to each other in the time line, simply drag the rightmost clip to the left, 
and a transition bar will display indicating the duration of the transition (based on 
how much you overlap your two clips). It automatically assigns a Fade transition. 
You can assign a different transition just by dragging a different transition from 
the transitions pane. 

 

Here I'm dragging the xp-search-result2 clip to alter the duration of 
the transition between it and the preceding clip (cursor not shown). 
The dark blue bar in the video layer indicates the duration of the 
transition. The Transition layer shows the transition's name. 

http://www.xvsxp.com/applications/video/ (8 of 15)1/1/2005 5:49:31 AM



X vs. XP > Applications, Video

OS X: In Windows Movie Maker transitions appear as a layer underneath the video 
layer in the timeline, and the name of the transition is displayed. In iMovie 
transitions appear on the same layer, between the 2 clips, and the name of the 
transition is not indicated in the timeline. To alter the duration of a transition you 
drag the Tortoise and Hare slider (you cannot drag a transition by its edges, even 
though they clearly look like they have handle bars). To use a different transition, 
you must select your new transition, then click the Update button. I found this to 
be both more labor intensive and less intuitive than Windows Movie Maker. 

 

iMovie's timeline is considerably less informative than 
Windows Movie Maker's. I cannot see the name of 
either clip or the name of the transition (in order to 
see the name of the transition I must first select it, 
then the selected transition is highlighted in the 
Transitions pane). Unlike Movie Maker, the duration of 
still clips and transitions cannot be resized by dragging 
the edges of the object. 

Video, Editing, Transitions: OS X: 6 , XP: 8 

Video, Editing, Titles Let's see how much overlap there is between these 2 apps. The following table is 
WMM's Titles and their iMovie equivalents:

Titles compared 
Windows Movie Maker iMovie

 Bounce Across
Bounce Across Multiple

 Bounce In To Center

 Cartwheel
Cartwheel Multiple

 Centered Multiple

 Converge
Converge Multiple

 Converge to Center
Converge to Center Multiple

 Cross Through Center
Cross Through Center Multiple

 Drifting

Flashing  

Fly In, Top Left Flying Words (from top or bottom)

 Flying Letters

 Flying Words

 Gravity
Gravity Multiple 

 Music Video

News Banner Stripe Subtitle

Scroll, Perspective  

 Scroll with Pause
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 Scrolling Block

 Spread from Center
Spread from Center Multiple 

Ticker Tape  

 Twirl

Typewriter Typewriter

 Unscramble
Unscramble Multiple

Zoom, Out  

Zoom, In Zoom
Zoom Multiple

Spin, In  

Spin, Out  

News Video, Inset  

Fade, Slow Zoom  

Zoom, Up and In  

Stretch  

Subtitle Subtitle
Subtitle Multiple 

Basic Title  

Video, In Text  

Wow!  

Fade, Wipe  

Fade, Bounce Wipe  

Fade, Ellipse Wipe  

Mirror  

Scoll, Banner  

Scroll, Inverted  

Paint Drip  

Fade, In and Out Centered Title

Fly In. Fades  

Fly Out  

Fly In, Fly Out  

Moving Titles, Layered  

Exploding Outline  

Fly In, Left and Right  

Sports Scoreboard  

Newspaper  

Credits: Scoll, Up Stacked  

Credits: Zoom, In  

Credits: Fade, In and Out  

Credits: Scroll, Up Side-by-Side Rolling Credits Centered

 Rolling Credits

Credits: Mirror  

Credits: Exploding  

Credits: Fly In, Left and Right  

Credits: Video Left  

Credits: Video Top  
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Total: 40 Total: 25

Quantity/Quality of Titles: 

The only difference between Bounce Across and Bounce Across Multiple is the 
ability to add additional text boxes, therefore Bounce Across Multiple makes 
Bounce Across unnecessary. So in the table above I've grouped together redundant 
titles. 

I also have to say that I found Movie Maker's titles much more interesting. For 
instance, Wow! creates 1960's Bat Man style BAM! effects. Scroll, Perspective 
creates the famous scrolling Star Wars effect. Credits: Video Left creates the 
style of credits popular with TV shows today, where the video scrunches on one 
side of the screen while the credits roll on the other side. Compared to these 
types of titles, iMovies titles seemed uninspired, and uninspiring. Microsoft's free 
Windows Movie Maker 2 Creativity Fun Pack contains 16 static titles slides. 

Ease of applying Titles: 

XP: I found Movie Maker's 'Task Based' method to applying titles to be 
cumbersome. I wanted to simply place my cursor at the point I wanted the titles 
to start, select the type of title, and type in the text. But instead I had to bring 
up the Tasks pane (Titling is not available from the toolbar, although Transitions 
and Effects are), answer a question about where I wanted the title to appear, 
type in the text, then locate the link to 'change' the title effect (Change? I hadn't 
even selected an effect yet!). 

Text options for Movie Maker's Titles

The text options are on a separate screen (above). Movie Maker bests iMovie with 
a Transparency slider and the ability to alter the text alignment. However, their 
method for altering the size of type is poor, forcing you to click repeatedly on the 
smaller or larger buttons until you find the size you want. (This is the same 
complaint I levied against XP's icon size contols.) 

The good news is that once the title was applied, it was easy to move them 
around on the timeline, even straddling transitions. This is possible because titles 
occur on a separate track of the timeline. You could then immediately preview 
your video without having to re-render it (iMovie requires a re-render each time 
you make a change). 

OS X: iMovie's approach to adding titles seems more effective. First you look for 
the type of effect you want. Once you select the type of effect, the Titles pane 
displays options for that Title, like the direction of the effect, speed, pause, and 
more. The type slider makes it quick and easy to change the size of your text. On 
the down side, rather than have Bold, Italics or Underline buttons, iMovie wants 
you to select the appropriate font. That means that every font is listed multiple 
times: 

●     Courier Bold
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Text options for iMovie's Titles 

●     Courier New Bold
●     Courier New Bold 

Italic
●     Courier New Italic
●     Courier New Regular
●     Courier Regular

Further complicating 
matters, strict alphabetical 
order separates faces that 
should be grouped. In the 
above example, Courier 
Bold and Courier Regular are unfortunately separated by the Courier New face. 
This usability disaster could be easily rectified by allowing iMovie to use X's great 
Fonts palette. 

iMovie's titles aren't applied beginning at the point of the play head. Rather they 
are applied to the selected clip. Since titles are not on a separate track it is 
impossible to 'slide' a title foreward or backward on the timeline. 

Importing file types: iMovie will import a wide variety of picture formats, 
including PDF. I tested GIF, JPG, BMP and PDF, and all imported. Of all the 
tested picture formats Windows Movie Maker would not import PDF files. 

Though it seems both applications had their strengths and weaknesses, Windows 
Movie Maker clearly wins for the quantity and creativity of their titles, as well as 
the ease of applying, moving along the timeline and viewing titles. 

Video, Editing, Titles: OS X: 6 , XP: 8 

DVD Playback 
 

Both OSes will play DVDs (although XP requires a third-party decompressor). DVDs 
may contain additional content aside from video. Both OSes understand 
DVD@ccess web links. Occasionally DVDs may supply Windows software. For 
instance, Alien comes with a screen saver. For obvious reasons, OS X can not play 
any Windows software supplied on DVDs. 

OS X: OS X comes with DVD Player. 

 
DVD Player (horizontal mode, with side tray expanded) 

DVD Player is pretty straight forward. Pop in a DVD, the player launches, switches 
your screen's resolution if necessary, and starts the DVD. Control it with the 
control panel or via the menus. After a moment the control panel disappears so 
you can watch your movie w/out obstruction. You can watch movies full screen or 
in a window. You can resize the window to just about any size, play DVDs in the 
background and the eject DVDs directly from the controller. 
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DVD Player has some impressive 
user settings. Users can select 
whether to play discs (upon 
insertion) from the beginning, last 
position played, bookmark (yes, 
you can create your own 
bookmarks!), or always ask. I 
personally appreciate this, since 
now when I pop in my yoga DVD, I 
can skip the FBI warning and other 
messages and get right to my 
workout! You can enable closed 
captioning when the player is 
muted, and you can select 
whether to mute or pause DVDs 
when connecting to an audio or 
video chat. You can select 
different languages for Audio, 
Subtitle and DVD menu, and if you 
have a Quartz Extreme capable 
Mac, you can set the transparency 
of the floating controller. 

XP: XP comes with a DVD player in the form of Windows Media Player. However, it 
does require a third party decompresser to be used. Almost every machine 
capable of running XP has one installed. It's a safe bet that if your computer came 
with a DVD drive, or you purchased a DVD drive, within the past 4 years you will 
have a suitable DVD decompresser. 

Microsoft's Windows Media Player is capable of playing DVDs, but you must supply 
a DVD decompressor engine (software). Once you supply a DVD decompressor, 
WMP can fetch all the info about the DVD you are viewing. Chapter listings, Cast 
and crew, the studio, even the cover art are all retrieved. WMP will display your 
DVD full screen or in a window.

 
DVD Playback in WMP9 (video not shown).

One could speculate that Microsoft's decision to not supply a DVD decompressor 
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with WMP may have something to do with them trying to avoid more anti-
competitive accusations (purely speculation). The unfortunate result for XP users 
is that DVD Playback is dependent on which third-party player they own. 

Microsoft's lack of inclusion of a DVD decoder in Windows Media Player is 
disappointing, but not a show stopper. However OS X outshines XP with its more 
intuitive player controller and its extras: the ability to create DVD bookmarks, the 
ability to auto-play DVDs from the bookmark, and the ability to eject DVDs 
directly from the controller. 

Applications, DVD Playback: OS X: 9 , XP: 6

DVD/VCD Creation Most people have heard of DVDs, but many have not heard of VCDs. VCD (Video 
CD) is basically video on a CD disk rather than a DVD disk and is supported by 
virtually all DVD players. The quality is not as good as DVD, but if you don't have a 
DVD burner, you can still burn your own VCDs to play in you DVD player. Neither 
OS includes DVD authoring software. 

OS X: Apple offers iDVD. iDVD is bundled with all Macs that come with combo DVD/
CD burners (called Super Drives by Apple). If you got iDVD 2 with your Mac in 
2002, you'll need to pay for iDVD 3. For Mac owners who didn't get iDVD with their 
Mac and want to use it, it's available as part of the iLife 2 CD set, for $49, and it 
supports ATA (internal) DVD burners, but not Firewire burners. 

To create a VCD from iMovie, export to Toast-VCD format (Under Export> 
QuickTime> Expert Settings). 

iPhoto can archive your photo libraries to data DVDs.

XP:Microsoft does not make any DVD authoring software. Windows Movie Maker 
requires additional burning software in order to burn DVDs. 

Windows Movie Maker does not allow export to VCD format. To create a VCD of a 
Windows Movie Maker project, you need to export to DV-AVI, then locate third-
party software to convert that file to a VCD format. 

Neither OS has the ability to burn a VCD natively, but at least iMovie can create 
the VCD file (then you burn it w/the third-party Toast software). WIndows Movie 
Maker can't even do that. Though Super Drive equipped Macs ship with iDVD, iDVD 
is not part of OS X. 

DVD Creation: OS X: 1, XP: 1 
VCD Creation: OS X: 4, XP: 4 

Pick a topic:  
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Applications, Internet

Web Browsing 
 

Both Safari and Internet Explorer are fairly capable web browsers. Both fully 
support HTML 3.2, both support Javascript, Java and plugins. Both support 
bookmarking of pages and viewing your browser history. If you type "yahoo" in 
the address bar, both browsers will assume you meant "www.yahoo.com". Both 
have popup blockers (SP 2 required for XP). 

OS X: Apple's Safari— though basically a 1.0 release (technically 1.2)— is leaving 
IE in the dust. Safari loads pages fast, and is pretty solid with its support for web 
standards (though not perfect). Safari has a number of niceties that IE PC lacks: 

●     Tabbed browsing (and tabbing of bookmark folders)
●     A download manager 
●     Ability to pause and resume downloads 
●     A "snap back" button to return to the last page that you typed in
●     A Google search built in to the top of the browser
●     Built-in spell checking 
●     Status bar notifies you if a link is a script or will open a new window
●     A more reliable method of increasing or decreasing font sizes on any web 

page
●     Transparent PNG file support
●     Support for file formats other than .ico (.jpg, .gif, .png) for favicons 
●     Single, double and triple-clicking in the address box behave as expected: 

insert cursor, select word, select line, respectively (IE PC doesn't support 
select word in address box via double-click)

●     More thorough CSS support. For instance, Safari 1.1 supports CSS3 rgba 
color, CSS3 opacity, and CSS2 text-shadow. Panther users will notice a 
subtle drop shadow underneath the page headings on this site. 
Unfortunately, widespread adoption of these tags will be unlikely until IE 
supports them.

●     Developers will appreciate that Safari has a complete implementation of 
the XUL box model

Safari also features incredibly easy bookmarking. Just drag a link to your 
bookmarks bar or hit the + button. A dialog asks you what you want to name the 
bookmark (which is pre-filled with the page's title). If you clicked the + button, it 
also asks you where you want the bookmark to go. Apple's inclusion of a system-
wide spell checker means that form fields can be spell checked as-you-type, a 
big boon for bloggers and frequenters of bulletin boards.

Safari's tabbed browsing (using system-wide spell checker)
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A Safari feature that web geeks will appreciate is that it displays full URLs in its 
status bar (rather than IE PC, which truncates URLs in the status bar to 131 
characters). And if you're browser is too narrow to display the full URL in the 
status bar, Safari will truncate it in the middle, because often the end of a long 
URL is more important than the middle. Another feature web developers will 
appreciate is that if you View Source, then edit the web page and refresh, the 
View Source window refreshes too. 

 
Command click Safari's title bar to the web page's path on the server. 

Safari brings to the Mac a feature that PC users have 
enjoyed for a while: form field auto-completion 
menus. For instance, when typing in a search engine 
form, if you've typed in that form before, it will show 
you a drop-down list of your previous searches that 
match what you've typed so far. I'm sure some users 
out there would rather that their searches be forgotten, which is why Safari 
includes a Reset Safari command. Reset Safari to empty your browser's cache, 
your browsing history, clears your Downloads window, removes cookies, and 
deletes all AutoFill text and Google search entries. Great for those stealthy 
surfers out there.

Apple is good at adding nice little touches to its apps. For instance, you can 
invoke contextual menus on links of background browser windows without 
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bringing the window the foreground. (For some reason, this only works from a 
right-mouse button, not from a control-click). I suspect this is an ability of Cocoa 
(OS X native) apps, so try it in other applications.

You can search your bookmarks right from within Safari's Bookmarks Collection's 
pane. This aids in managing large amounts of bookmarks. Whichever item you 
select in the Colletions pane is where your search will start. As you hit Find Again 
( -G) Safari will continue searching the other folders in your bookmarks, 
springing them open to highlight found results. 

IE for XP also allows you to search your bookmarks (by right-clicking a bookmark 
folder and selecting Search), but IE then brings up that bookmark's location in 
the file system. Furthermore, it will only search that folder in the file system, 
and will not continue searching other bookmarks folders unless you manually 
alter your file system search to search your Favorites folder. Arriving at the file 
system when searching bookmarks in IE can be confusing to novices. 

The lack of an URL column in XP's Favorites window means that you have to roll 
your mouse over each link one-at-a-time in order to see their URLs.

While Safari offers generally superior CSS support (see css/edge tests), it's not 
complete. Safari does not render this site's own Final Score page correctly. It 
also lacks support for some HTML 4.0 tags (for instance, the <label> tag). 

Safari's Javascript support is also incomplete. The following test case relies on 
the javascript command document.testForm.yesNo.value ='Yes' in order 
to have the text field be auto-populated with Yes or No, depending on which 
radio button you select. Calling this script using the onFocus or onChange 
attribute works fine in Internet Explorer, but doesn't work in Safari: 

 Yes  No  
In order to function correctly in Safari, the onClick attribute must be used: 

 Yes  No  
XP: Ships with Internet Explorer 6. Web designers design their sites for their 
target audience, and if their target audience is largely PCs (which it is more than 
90% of the time), then that's what they'll design for. Good designers mostly 
create web sites that work on all browsers. But in places like corporate intranets 
the good of the company is seen as overriding the needs of a few Mac users. In 
those cases, proprietary web technologies may be used that only work in 
Microsoft's Internet Explorer for Windows. 

One feature of IE for XP is that when you encounter a web site that requires a 
plugin that you don't have, IE prompts you. Once you grant the browser 
permission to get the plugin, IE goes ahead and installs it for you. No need to 
quit the browser. No need to run an installer. The page just starts working once 
the process is done. OS X can't claim that level of simplicity w/respect to 
plugins. Caveat: more than one reader has pointed out that this seamless-plugin-
installation is also responsible for tons of horrible plugins that users didn't 
realize they didn't want (often called spyware or adware), so IE's plugin install 
feature is not necessarily all good. 

IE for XP has a number of features that Safari lacks: 

●     Auto-install of plugins (this is a double-edged sword, since this is a 
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delivery mechanism of spyware and adware) 
●     Support for richly formatted text editing directly within the browser 

window
●     Support for Active-X objects
●     Support for page transitions 
●     Multiple undo in form fields (Safari has no undo at all!)
●     Faster rendering of javascript intensive pages 
●     XML source tree view
●     Downloading a file will prompt you for a download location (this is a 

personal preference issue)
●     Send web page by email
●     When viewing an image in your browser, IE will auto-resize it to fit the 

browser window. IE overlays a handful of buttons on the image, including 
email, print and view full size. Personally I dislike this "feature" since I 
NEVER want to view an image smaller than actual size.

●     When posting on this site's forum, clicking the B button correctly inserts 
[b] into your posts at your current insertion point. Clicking that button (or 
any text formatting buttons) in Safari incorrectly places the tags at the 
end of the block of text.

●     Print Selection 

Of course, IE for XP has its pitfalls too. I could talk about its lack of adherence to 
standards, but there are other sites that do a better job of that. One issue that 
recently bothered me happened when I downloaded an installer. This was a 
brand new computer, so IE downloaded it to the default location, the Desktop. 
Upon completion of the download, IE dutifully notified me that it was done, and 
considerately provided me with an Open Folder button, so I could reveal the 
downloaded file in the file system.

 

I clicked the button, looking forward to having my file served up in a window 
meant just for me, when I got the following error:
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Hey! You offered to Open the Folder for me, so I click it and you take back your 
offer??? Why didn't they just write the dialog like this: 

 

One may rebut, "the Desktop isn't a folder, so the error was perfectly 
appropriate". Well, the desktop IS a folder, located at C:\Documents and Settings
\username\Desktop, so XP could have honored the button click by opening that 
folder (which—by the way—is how Safari handles this exact scenario). 

Though web purists will insist that web sites should be platform and browser 
agnostic, the reality is that sites are sometimes optimized for IE for the PC. Even 
though it's rare, there are web sites that don't work on Macs. Both Safari and IE 
Mac lack some of the proprietary Microsoft web technologies, like support for 
page transitions and Active X objects. Some web sites are coded specifically for 
IE (shame on you web developers!), so Mac users may want to bounce back and 
forth between Safari and Internet Explorer. 

Web Browsing: OS X: 7, XP: 8 
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Email Both OS X's Mail and XP's Outlook Express manage multiple email accounts. Both 
can connect to IMAP or POP mail boxes. 

XP: In addition to IMAP and POP accounts, Outlook Express (OE) can connect to 
HTTP mail accounts (MSN, Hotmail, or other services). Outlook Express supports 
rich text and HTML formatted messages. It provides Source, Edit, and Preview 
tabs when editing HTML formatted emails (when in Source Edit mode). Outlook 
Express provides one-click access to a full array of rich text settings, and even 
many HTML settings. Attaching items is a lot more flexible in XP. In addition to 
dragging files into a New Message window and clicking the Attach button to 
attach files, you can also Copy (Ctrl-C) files from the desktop and Paste (Ctrl-V) 
them into your message window. If that's not enough, you can also right click on 
files and choose Send To> Mail Recipient. That's versatile. 

Sending web pages via email is also easy. In Internet Explorer, choose File> 
Send> Page by Email. 

Apple's PIM (Personal Information Manager) strategy: Separate the distinct 
activities that people associate with PIMs into separate applications, then 
allow any application to interact with these apps, thus eliminating the need 
for redundant data. Apple has an address book application (Address Book), a 
calendar application (iCal) and an email client (Mail). With these applications 
separate, any other application that requires- for instance- an address book, 
will simply hook in to Address Book. No need for the user to enter in 
addresses into a new application. A good example of this is iChat. iChat's 
buddy list IS Address Book. 

Apple is taking their strategy one step further with iSync, allowing users 
with .Mac accounts to synchronize their addresses, bookmarks and 
appointments across their disparate Macs, and even other devices like iPods 
and mobile phones. 

From what I can tell Microsoft is mounting a similar strategy, but it's not as 
far along. For instance, here's a quote from a 3/4/03 CNET News article 
discussing a leak of Microsoft's next operating system: 

"Microsoft has added a 'My Contacts' folder that could 
eventually act as a common database of contact information, 
in a similar fashion to the Address Book found in Apple 
Computer's Mac OS X."

OS X: Finally, Apple has created a world class Mail client. In addition to their 
best-in-class spam filter, managing multiple email accounts and setting mail 
rules is a breeze. I take my laptop back and forth to work, and my workplace's 
firewall prevents me from getting my home email from work and my work email 
from home. Apple's Mail is forgiving of such scenarios. When a mail server is not 
accessible, a warning triangle appears next to each folder for that account. 

Mail can natively view many file types inline. In addition to the expected file 
types: .jpg and .gif, Mail can also view some file types the Outlook Express 
cannot: .png, .pdf and .psd. 
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X's Mailboxes

Mail now supports organizing 
of messages in threaded form, 
indenting replies underneath 
the original email, and 
strategically shading items to 
visually reinforce messages' relationships to each other. Subsequent messages 
can be revealed or concealed via a disclosure triangle. A "Jump to Reply" curly 
arrow button appears next to emails to which you've replied. Click the button 
and your reply pops open with a swoosh sound. 

If you quit Mail with a draft email opened, next time you relaunch Mail your draft 
will be in its same location so you can pick up where you left off.

Though Mail is a solid app, it could be better. Mail doesn't support composing 
HTML formatted messages. Bulletted and numbered lists, indenting and 
outdenting buttons aren't available. Many formatting commands are buried in 
menus. 

Attaching items isn't as flexible as XP. You can attach by clicking the attach 
button, by dragging an item into a message window and if you have an item 
selected on the desktop you can select Finder> Services> Mail> Send File. 
Unfortunately this only works if you have one item selected (though that one 
item could be a folder with multiple items in it). You can also attach a file by 
control-clicking or right-clicking the file, selecting Open With, and choosing your 
email program. Not quite as smooth as XP's Send to Mail Recipient since OS X 
tries to only show you applications that are applicable to the item you've 
selected, and so your email program will only show up in the default list if you 
have a text file selected. You can still select Other... and browse to your email 
program, but that's more effort. 
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It's not as easy to email someone a web page in OS X as it is in XP. I wish Apple 
would add formatting buttons (bold, italic, bulletted list, etc.) to their compose 
window, and I wish it were as easy to email a web page as it is in XP, but those 
seem to be my only complaints in an otherwise solid product. Apple's PIM 
strategy makes for tight integration between Mail and iChat. That said, XP's 
offering has plenty going for it as well. The ability to compose HTML formatted 
messages is nice, as is the ability to connect to popular web email accounts (MSN 
and Hotmail). Attaching files is more integrated into XP's OS and other 
applications than it is in OS X. 

Email: OS X: 8, XP: 7 

Email, Junk Mail Filtering 
 

Junk mail has become a hot topic for home users who's In boxes can quickly get 
flooded with unwanted spam. 

OS X: Mail has a wide array of junk mail filtering options. In 
addition to its own junk mail filtering algorithm, Mail 
leverages your ISP's junk mail filters by allowing Mail to 
honor junk mail headers set by your service provider. You 
can exempt email addresses in your Address Book, previous 
recipients, or messages addressed using your full name from junk filtering. You 
can leave junk mail in your Inbox or automatically move it to a Junk mailbox. To 
quote Apple's own literature, "you can also direct Mail NOT to download images 
included in junk messages, thus circumventing a common trick used by 
spammers." 

XP: Outlook Express lacks junk mail filtering, though XP users could attempt to 
create their own mail rules to filter junk mail. 

Junk Mail Filtering: OS X: 8, XP: 2

HTML Editing Neither OS ships with a WYSIWYG HTML editor. Since HTML is just text, you can 
use the text editors that ship w/each OS to edit HTML, but they don't offer any 
features of commercial HTML editors like tag assistants. There are quite a few 
shareware, freeware and commercial editors for either OS (like BBEdit Lite for 
OS X, HTML-Kit for XP or Mozilla's Composer for both). 

XP: Even though it's not intended as such, Outlook Express can be used as a 
WYSIWYG HTML editor. When creating an email, go into Source Edit mode and 
the HTML Editing features are unlocked. Make your page and save the source to 
your drive for uploading to a web site. Not that I'd recommend this to anyone, 
but it's free and comes with the OS. (Anyone advanced enough to figure that out 
on their own is also advanced enough to download Mozilla Composer.) If you 
prefer editing code directly you'll need to use NotePad.

If you're editing ASP.NET code, you can download ASP.NET Web Matrix, but this 
can't be used as a straight HTML editor. 
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XP has a Web Publishing Wizard built into the Tasks Pane of all its windows, but 
the wizard requires that you select a service provider for publishing, it cannot 
publish web content locally for later uploading.

Web photo galleries can be created with the HTML Slide Show Wizard (part of 
Power Toys for XP). 

OS X: TextEdit is equivalent to Window's NotePad, about as basic a text editor as 
you can get. TextEdit can edit HTML once you alter its default behavior for 
opening HTML files in a WYSIWYG view by selecting "Ignore rich text commands" 
in TextEdit's preferences. 

If you're looking for more features, you can use Project Builder (part of Apple's 
free Developer's Tools). It includes syntax coloring and a split screen function as 
well as plenty of propeller-head tools. However, since it's not intended as an 
HTML editor, it lacks commands a web developer would expect, like tag 
assistants. 

For true code warriors, OS X ships with GNU Emacs. Emacs is not for the faint of 
heart. It's intended as a programmer's tool (sorry, you can't use your mouse with 
this program!) but I'm told it's quite capable of editing web pages. If you're 
interested, GNU.org has an online manual. 

Web photo galleries can be created with iPhoto or Image Capture. 

So OS X has TextEdit, Emacs, Project Builder and iPhoto (for web galleries). XP 
has NotePad, Outlook Express and ASP.NET Web Matrix. Outlook Express is an 
accidental HTML editor, so shouldn't really be counted. 

HTML Editing: OS X: 5, XP: 5 

Web serving

 
Your Start Page contains a 

Quick Start Guide.

OS X: Apache for web serving, Perl for web 
scripting, WebDAV to access compliant web 
servers easily.

Turn on Personal Web Sharing in the Sharing 
Control Panel. Once on, it tells you how to 
view your computer's web site as well as your 
own personal web site (see right). Visit either 
in your web browser to learn how to edit your 
sites. Sadly, their overview on how to create 
web pages only mentions commercial 
applications that create web pages: this is 
because OS X ships with no decent HTML 
editor. 

Apple provides QuickTime Streaming Server (QTSS) and QuickTime Broadcaster 
for video streaming. Broadcaster is a video encoder for live video events, while 
QTSS will stream live and on demand video (including MPEG-4) and MP3s. Become 
your own online radio station for free! Both apps are free. QuickTime Streaming 
Server is available for Mac OS X Server, Linux, Solaris, NT and Win 2000. 
According to Apple's FAQ, QTSS will "run on Mac OS X (Desktop) but this 
configuration is not supported by AppleCare". Windows XP is not mentioned. 

XP: XP Professional ships w/IIS 5 as an optional install. XP Home does not (nor 
does it ship with Personal Web Server, a product supplied with Windows 98, 2nd 
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Edition) and Microsoft does not support installing PWS/IIS on XP Home. IIS (I am 
told) has a decent management console, as opposed to Apache's text based 
config files. However IIS is not intended for personal web sharing, and thus is not 
pre-configured for one-click web sharing like in OS X. 

For video streaming, XP users can use Windows Media Encoder. (If anyone has 
gotten QTSS to work on Windows XP, please let me know in the forum.) 

XP users can download and run Apache, Perl and WebDAV, but will need to keep 
track of updates manually.

Web serving: OS X: 7, XP Pro: 7, XP Home: 1 

Web serving, vulnerabilities SecurityFocus is the web's premier site dealing with internet security issues. 
Their Vulnerabilities search engine allows you to look up all known security 
vulnerabilities for just about any version of any application on any operating 
system. 

On June 13, 2003 I looked up the vulnerabilities for the current web servers for 
OS X (Apache 1.3.27) and Windows XP Professional (IIS 5.1) 

●     IIS 5.1, 19 vulnerabilities
●     Apache 1.3.27, 8 vulnerabilities
●     Apache 1.3.27 Mac OS X (ANY version), 0 vulnerabilities

There are 2 vulnerabilities for Apache 2, however Apache 2 is not OS X's default 
web server. That said, Apple still released patches for these vulnerabilities. 

XP's historical track record is even worse. Searching for IIS 5 on XP yields no less 
than 28 vulnerabilities (XP's vulnerabilities are dated 1/16/2002 to 2/10/2003). 
Given this poor track record, it should be no surprise that www.army.mil moved 
to Mac OS X "in the aftermath of a successful attack on its then Microsoft based 
web site".

Consider the remarkably ironic truth of security today: "after Microsoft sites 
were cracked, IT director decides to use Microsoft everywhere". 

Though some may believe that IIS is not as secure a web server as Apache, that 
conclusion cannot be drawn by simply listing the most recent vulnerabilities. For 
that reason I will give both OSes an equal score. 

Web serving, vulnerabilities: OS X: 7, XP: 7 

Pick a topic:  
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Applications, Internet- Chat

Basic Chat OS X comes with iChat AV, while XP comes with Windows Messenger. Both clients support 
buddy lists, the ability to chat with multiple buddies simultaneously, and 'typing 
indicators', notifying you when one of your buddies is typing a message to you. Both 
clients allow you to share files through your chat window, and both clients support 
'emoticons', those smiley/frowny faces you see (XP's array of icons is wider). iChat is 
basically an AOL Instant Messenger (AIM) client, and Windows Messenger is an MSN client. .
Mac users can also use their .Mac email addresses as their iChat buddy name. (Users can 
get a .Mac buddy name for free. Just sign up for the free trial period, then don't proceed 
with the full service. You get to keep your buddy name.) 

OS X: Integration with Address 
Book means that your buddies 
are centrally managed and 
accessible via any other program 
that interacts with Address Book. 
This also eliminates the need to 
maintain redundant contact lists. 
IChat can log chat sessions to 
files, and you can chat initiate a 
chat by looking up a person's real 
name if you can't remember their 
buddy handle. You can drag-and-
drop photos into your identity to 
personalize your icon. iChatAV 
has a library of previously used 
icons you can select from. You 
can switch users by selecting a 
different Screen Name in the 
Accounts Preferences pane. You can apply custom background images to your chat 
windows. 
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But enough about overt features. Let's talk about iChat's most 
compelling feature, its interface. The interface draws you in with 
its style that seems best described as seductively cute. 

●     Animated chat bubbles (w/bubble-
inspired sounds)

●     Cartoon-like thought bubbles indicate 
a buddy is typing a message to you

●     Animated buddies changing their 
online status (Buddy lists are sorted by online status. As a 
user's goes offline, their icon pulsates momentarily, then 
dims, then the newly offline buddy slides down the buddy 
list to be with the other offline buddies.)

●     Menu bar integration so you can see who's online w/out 
bringing up your buddy list. 

●     Group buddy lists (Friends, Family, Work, etc).
●     If you receive a message while iChat is in the background, 

the message appears translucent. 

 

The high degree of effort that was put in to creating an enticing chat environment pays 
off. IChat quickly draws you in to its environment. These little interface touches make 
the chat experience more interesting. 

XP: XP comes with Windows Messenger. Windows Messenger has an abundant array of 
emoticons to make chatting more fun. But for basic chat functionality, that's about all 
that I can say positively about this program. 

 

Windows Messenger's interface seems needlessly cluttered. Icons intended as buttons 
seem arbitrarily located on the buddy list window. Other than emoticons, there's nothing 
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about the chat screen to get excited about. This would not be such a big deal were it not 
for the fact that iChat demonstrates the possibilities of having a more interesting chat 
interface.

Windows Messenger's Liabilities:

●     Can't create or modify your status notices
●     Can't personalize your buddy icon (though MSN Messenger can [see below])
●     No user switching-- only one primary identity can be used.

Windows users can also download MSN Messenger. MSN Messenger is a chat app for 
consumers, but with advertisements. It has a few features missing in Windows Messenger: 

●     Group buddy lists (Friends, Family, Work, etc)
●     If you receive a message while MSN Messenger is in the background, the message 

pops up
●     display contacts as email addresses only
●     Save and importing contact lists to/from files
●     Play games with your contact
●     Send messages to mobile devices (free)

iChat and Windows Messenger handle buddies coming online and offline differently. 
Windows Messenger's Taskbar item doesn't display online buddies, but rather springs up a 
notification whenever a buddy comes online or offline (if the buddy list is displayed, 
buddy status changes are reflected there as well). iChat relies on the buddy list as a 
visual notification about buddies changing their online status. If your buddy list is hidden, 
the iChat menu bar will display a list of your currently omline buddies. iChat can 
optionally verbally notify you of any event: when a buddy comes on- or offline, when they 
sent you text or audio chat invitations, etc. 

The advantage to Windows Messenger's method is that notifications will spring in front of 
open applications so you can see when someone comes online. If such alerts are a 
distraction, you have some control over when they pop-up: 

●     Tools>Personal Tab> Check (Show me as "Busy" and block my alerts when I'm 
running a full screen program such as a slide presentation) 

●     Tools>General Tab> Check (Display alert when contacts come online) 

Basic Chat: OS X: 8, XP: 7 
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Video/audio 
Conferencing

OS X: iChat AV is Apple's video conferencing client (it is 
part of 10.3, $29 for 10.2). According to Apple's own 
collateral, it supports full screen mode, picture-in-
picture, and buddy lists will automatically display an 
icon corresponding w/your buddy's current level of 
conferencing support (a phone, a video camera, or no 
AV icon). You can also use the web cam to create your 
buddy icon, and you can view and switch to any of the 
16 most recent pictures used. The down side? You can 
only use the AV features with other iChatAV users 
(which is the same as XP, since Messenger's AV features 
will not interoperate with other applications). Also, to 
video conference you need a broadband connection or 
better. (Of course, good video conferencing on any 
program requires a broadband connection. Apple has 
opted to not allow video on slower connections. By 
contrast, XP permits video conferencing on slow 
connections, but the video quality suffers greatly.) 
iChatAV allows audio conferencing over 56k modems, as long as you meet the minimum 
system requirements (600 MHz G3 or any G4). Mac and PC users that want to 
videoconference can use Yahoo Messenger. iChatAV 2.1 supports cross-platform video 
chat with AIM clients. 

iChat AV has a number of niceties. It appropriately flips local video left to right, so your 
own image will behave just like a mirror. When you plug in iSight and open the shutter, 
iChat AV launches automatically. If you're listening to music in iTunes, music play will 
stop when you accept an audio or video message. 

(I'm told that you can also use Apple's free QuickTime Broadcaster to video conference-- 
though it's considered a pro tool, I hear it works perfectly fine to conference with another 
friend.) 

XP: Windows Messenger supports audio and 
video conferencing. It works on dialup (albeit S 
L O W L Y). Full screen mode is not supported. 

XP has no fewer than 4 conferencing applications: 

1.  Windows Messenger
2.  MSN Messenger
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3.  ThreeDegrees (discussed in the next section)
4.  NetMeeting

Windows Messenger supports audio and video conferencing. Users must have a .NET 
passport account. Windows Messenger is targetted at business users. 

MSN Messenger is a chat for consumers, but with advertisements (MSN Messenger is also 
available for Mac, but the Mac version—3.5—lacks video conferencing). Version 6 adds 
Buddy Icons (known in Messenger as Display Pictures), and can log conversations to an 
XML file. You can subscribe to a service to make Voice over IP (VoIP) calls from your 
computer to telephones, as long as the other party is also using MSN Messenger. 

NetMeeting is included in XP for legacy support. Use NetMeeting to videoconference with 
older versions of Windows or for improved functionality in some firewalled environments. 

Industry Press:
Read what the New York Times has to say about iChat vs. Windows Messenger (free 
registration required). 

And Popular Mechanics had this to day about MSN Messenger vs. iChatAV for 
videoconferencing: 

"MSN Messenger for Windows has a similar offering, but we found it to 
be a stuttering, herky-jerky experience. By manufacturing the camera, 
the software and the computer, Apple is able to create a smooth 
experience that is out of sight." 

Video/audio Conferencing: OS X: 8, XP: 9

Advanced 
Conferencing

Advanced conferencing encompasses such abilities as shared whiteboard, application 
sharing and remote assistance. 

OS X: iChatAV contains none of these features. 

XP: Windows Messenger users can:

●     Share applications
●     Ask for remote assistance
●     Share a whiteboard

MSN Messenger bundles games like checkers or minesweeper to play while you chat. 

ThreeDegrees is a beta plug-in for MSN Messenger for XP that enables a handful of 
additional features in Messenger: 

●     Listen to a shared play list simultaneously, created from music that you own.
●     Create Groups with Your Friends and Family 
●     Share Files
●     Throw Desktop Animations to Your Groups Desktop 
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It's targeted towards a younger, hipper audience, and it requires a broadband connection. 

XP users looking to share applications or a whiteboard with users of older Windows 
versions can use NetMeeting. 

Advanced Conferencing: OS X: 1, XP: 9 

Pick a topic:  
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Calendar 
 

OS X: iCal is the calendaring application that comes with OS X. Calendars 
can be shared across the internet. Users can receive special calendars from 
Apple's Calendar Library. Users can publish their calendars to WebDAV 
servers (or, with a paid .Mac account, to their .Mac site). Calendars can be 
synched to mobile devices such as Palm or iPod. Disappointingly, birthdays 
entered into Address Book do not show up in iCal without third party 
software. iCal does not interoperate with Exchange calendars. The 
freeware GroupCal handles this. 

XP: Microsoft offers free MSN and Hotmail accounts to users and they 
include the online MSN Calendar tool. Microsoft also supplies a calendar as 
part of Microsoft Outlook (not a part of XP). Outlook is a component of all 
versions of MS Office. Outlook is also distributed standalone as part of the 
Client Access License with Exchange Server or MS Small Business Server 
(includes Exchange). A calendar is also available in Microsoft Works, which 
is bundled with many inexpensive to moderately priced consumer PCs. 
Many other freeware, opensource, and commercial options are available as 
well." 

Calendar: OS X: 8, XP: 1

Calculator OS X: OS X's Calculator has standard and scientific functions as well as 
paper tape and unit conversions, such as volume, temperature, currency 
and more. Currency conversions can be updated online so that currency 
conversions are always up-to-date. 

 
Converting currency in Calculator 
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Every Mac Application is a Super Calculator!
Use Script Editor Service to perform calculations in any application 
that you can type in. Just type your math—for instance (26*234)/3— 
then select it, then hit -* (Or select Get Result of AppleScript from 
the Script Editor menu in the Services menu), and voila! Your selection 
is replaced with the result. Since the command is Get Result of 
AppleScript, you can type any string that AppleScript knows how to 
process. For instance, you can type: length of "http://www.
xvsxp.com/" and it will return 21. Or type 

set x to 12
repeat with i from 1 to 10
set x to x*i
end repeat

and it will return 43545600. Or type current date and it will return 
date "Thursday, April 24, 2003 6:59:42 PM". Or type tell 
application "Finder" to return (free space of startup 
disk ) and it will return something like 3.684204544E+9. Ok, so 
that last one is pretty geeky, but you get the idea. 

XP: Microsoft's calculator has standard and scientific functions, but no 
paper tape, and no unit conversions. Microsoft offers Power Toys 
Calculator as a free download (part of MS's free Power Toys). Power 
Calculator includes graphic capabilities and many unit conversions and has 
a history window and the history window can be saved to file or copy and 
pasted to other documents. Microsoft also offers the free download for 
Calculator plus that offers Standard, Scientific, and Conversion features. 
Calculator Plus has fewer default currency conversions than OS X's 
Calculator but it can be customized to include any currency of your choice 
(additional currencies have to be looked up manually). 

OS X: 

●     Standard and Scientific Functions
●     Paper Tape
●     unit conversions
●     more built-in currency conversions
●     Any application can calculate
●     no graphing capabilities

XP: 

●     Standard and Scientific Functions
●     History window
●     Graphing capabilities (separate download)
●     Unit conversions and currency conversions are available as two 

separate downloads
●     Fewer default currency conversions
●     Additional currencies must be looked up manually

Applications, Miscellaneous, Calculator: OS X: 9, XP: 8 
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Developer Tools OS X: OS X includes (for free) a thorough suite of developer tools: Script 
Editor for making AppleScripts and Xcode and Interface Builder for full 
blown applications and AppleScript-based applications (known as 
AppleScript Studio). OS X also includes other tools for miscellaneous 
functions, like: 

●     IconComposer for turning images into icons
●     MRJBuilder for building Java applications
●     Pixie for close ups to check if you are displaying things correctly 
●     Quartz Debug, that shows you how much you are redrawing and how 

inefficient your drawing code may be 
●     PackageMaker for making application packages 

and many more. Also included with the developer tools is documentation 
and sample code. 

 
Using AppleScript Studio within Xcode 

Xcode updates are available for free (to members of Apple's Developer 
Connection, membership is free). 

XP: Microsoft's free offerings for developers aren't as thorough. Microsoft 
offers a free compiler and linker and free diff tools (OS X's free diff tool is 
FileMerge). Microsoft also offers a free beta of its Visual Studio 2005 
Express suite. Since vbscripts just text files they can be created in 
NotePad, but there's no syntax coloring, syntax checking or code assistance 
(Script Editor for OS X has syntax coloring, code auto-complete and code 
samples accessible via right-clicking). 

XP users looking for more thorough offerings of free developers tools will 
have to rely on third parties. For instance, Borland provides free JBuilder, 
Delphi, C++ and C# Builder personal editions for Windows XP. 

Apple offers a more complete suite of free developer tools for OS X than 
Microsoft offers freely for XP. 
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Developer Tools: OS X: 9, XP: 3 

Image Creation XP: XP comes with Paint. XP users can download Expression. XP users 
looking for other free image creation software can also download 
WinGimp. 

OS X: OS X comes with Icon Composer, which is no good for creating 
anything larger than an icon. OS X users looking for free image creation 
software can also download Expression or MacGimp. 

Applications, Image Creation: OS X: 1, XP: 7 

Games 
 

OS X: OS X comes with Chess. 

XP: XP comes with: 

●     Freecell
●     Hearts
●     Internet Backgammon
●     Internet Checkers
●     Internet Hearts
●     Internet Reversi
●     Internet Spades
●     Minesweeper
●     Pinball
●     Solitaire
●     Spider Solitaire

Since this site is about productivity and creativity, games will not be 
scored. 

Games: No score

Pick a topic:  
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Legacy OS X: Apple has 2 strategies for dealing w/legacy applications: 

1.  OS X supports 'carbonized' applications (OS 9 apps that have been stripped of a small amount of 
legacy code). Developers only needed to make minor adjustments to their OS 9 apps to make 
them run natively in X. These 'carbonized' updaters have been supplied for free by application 
developers.

2.  OS X supplies Classic mode, for non-carbonized legacy apps. 

Classic mode requires that you have a copy of OS 9 on your computer. The vast majority of Macs 
capable of running OS X 10.3 has a legal copy of OS 9 (The original PowerMac G3 tower officially 
supports 10.3 and yet did not ship w/OS 9. Owners of that computer will have to pay $20 for OS 9 
disks). Older computers shipped with it as the default OS, newer computers have it supplied as "Classic 
support" on an installer CD. Since it is a separate install, installation requires extra effort from the user. 
Once installed, when you launch an appication that requires classic, the classic environment will 'load', 
and it resembles Mac OS 9 booting 'within' OS X. This 'classic boot time' creates a lag when initially 
launched. You may then leave classic running and continue to run as many OS 9 apps as your machine 
can handle (memory-wise). 

On the down side, Classic apps don't inherit the benefits of OS X. For instance, they don't get protected 
memory. This means that if a Classic application crashes, it is likely that it will crash the entire Classic 
environment, including all currently running Classic applications. 

Classic applications that make direct hardware calls using unsupported methods will not work (for 
instance, using Rave or Glide video acceleration, or the third-party Free Midi framework). 

XP: Since XP is an incremental upgrade from former OSes, XP doesn't have the same compatibility issues 
with applications as OS X. All NT compliant legacy applications are supported (as well as DOS 
applications), but it should be noted that there is a small sub-set of 9x software that is incompatible 
with NT. These programs won't run in XP (or Windows 2000). For the programs that do work, most run 
fine with little to no change in speed. However, legacy applications may not have the same rigid rules 
regarding sharing/registering of dlls, so installing or uninstalling legacy applications may overwrite or 
remove shared libraries, that may cause other applications to behave undersirably. It should be noted 
that XP protects shared libraries (dll's) that it deems to be "system-critical". If one of these dlls is 
removed or overwritten, XP restores it upon reboot. 

Reader Note: "If you come to a program that doesn't work in Windows XP, you can run it in 
Compatibility mode. To use it, right click the programs shortcut, and then select Properties. Click the 
Compatibility tab, and then choose a Windows version that the program did work with. It may work 
better then, but there is no guarantee." 
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So both OSes have commendable though incomplete support for legacy applications, however it seems 
that X's Classic has some additional liabilities 

●     Because it is it's own environment, it has a separate 'boot' time
●     It's lack of protected memory can cause the entire Classic environment to crash, bringing with it 

all currently running Classic apps.
●     OS 9 is not supplied with OS X (although almost all 10.3 capable Macs have a legal copy of OS 9), 

so it is a separate installation.

Applications, Legacy: OS X: 7, XP: 8 

Pick a topic:  
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Digital Photos

Photos, Importing 
 

OS X: (Thanks to Nick Mediati for help with this section)

The first time you connect digital camera media to your Mac, Image Capture 
will launch. Image Capture allows you to choose where the contents of your 
media will be downloaded. 

 
Image Capture 
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You can set options for downloading images 

 
You can also select a post-processing task, such as making a web page. 

Power User Tip: The items in the Automatic Task menu are scripts located 
in /System/Library/Image Capture/Automatic Tasks/. Build Slide Show and 
Build Web Page can be run independently of Image Capture, so for instance 
you can build a web page from your photos just by dropping a folder onto the 
Build Web Page application. Conversely,ou can modify the contents of the 
Automatic Task menu by placing any application (like Photoshop 7 action 
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droplets) or script in this folder, making Image Capture extensible.

You can preview the images on your media, rotate the images prior to 
download, select which images to download, or simply download everything. 

 

You can share the contents of your digital camera over the web via 
Rendezvous! Just enable web sharing from Image Capture's preferences, then 
other computers within your subnet will automatically see a link to your digital 
camera's images in Safari's Rendezvous bookmarks menu (which may need to 
be turned on in Safari's Tabs preferences). This feature can also be password 
protected. You can even remotely control supported cameras (read more 
about this at MacDevCenter.com). 

If you would prefer to use an application other than Image Capture to import 
your camera's contents, you can set that in Image Capture's Preferences. This 
alters the default behavior of your computer whenever you plug in a camera. 
You can also choose to have no application run, so that you can copy the files 
manually from the camera. 

Apple's iPhoto is the 'other' application that ships with OS X for importing 
photos. It has a lot of great features, but it's not perfect (for instance, iPhoto 
cannot import videos from digital cameras, nor can you select which images to 
automatically import), which is why Image Capture exists. 

The first time you launch iPhoto, it asks you if you want to choose it as your 
default Photo importing application. 

 

Once you've selected iPhoto from either iPhoto's dialog or from Image Capture, 
iPhoto will then automatically launch every time you connect your camera to 
your computer. 
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iPhoto's import button 

Once you click import, all the camera's photos will be imported into your 
iPhoto library.

Since iPhoto can be used as your master image library, you may want to 
import images that you receive in ways other than a digital camera (for 
instance if someone emails you some images). Simply drag and drop your 
images from your computer onto iPhoto's window and the images will be 
imported. 

●     Automating iPhoto with AppleScript

Both iPhoto and Image Capture can be set to delete the camera's contents 
after downloading.

XP: (The following section courtesy of Uchendu 'UnnDunn' Nwachukwu, www.
unndunn.com) 

Here's a brief look at how you import pictures using Windows Image Acquisition 
in Windows XP. 

Step one: Connect the Camera
Shortly after you connect the camera to your USB port, you will see a screen 
similar to this one: 
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This wizard steps you through the process of importing the pictures from your 

camera. 

Step Two: Select Your Pictures
Select the pictures you want to copy: 

 
The three buttons on the lower left allow you to rotate clockwise, counter-

clockwise and to view the picture information for the selected pictures. 

Step Three: Name the pictures
Assign a name and destination folder for the batch of pictures: 
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You can opt to have the pictures deleted after they have been transferred. 

Step Four: Copy the pictures
Next, the pictures are copied to your chosen folder. 

 

Step Five: More Options
And finally, you have some additional options for working with the pictures 
you just copied. 
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And your pictures will appear in Explorer. 

Working with pictures directly from the camera
It is also possible to view the pictures directly on the camera by using 
Explorer, without having to launch the Scanner and Camera Wizard. When you 
connect the camera, an Icon for it will appear in My Computer. 
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Clicking on that icon (above) lets you view the pictures directly on the camera 
(below), and you can copy them to wherever you wish, or view the picture 
information. 
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It seems that both OSes make the importing of digital photos simple. The 
default importing tool for each OS features a handful of post-processing 
features, although post-processing starts to spill over onto what to do when 
the photos are done being imported, which has been talked about elsewhere 
in this article. 

Importing Digital Photos: OS X: 8, XP: 8 

Photos, Managing When importing photos in XP or in X (using Image Capture), you can select an 
automatic process to generate a web gallery. 

OS X: If you're using Image Capture as your 
import tool, you can select from a handful of 
automatic tasks to perform: Build Slide Show 
Format (3x5,4x6,5x7,8x10), open in Preview, or 
Other... which allows you to select any post 
processing script or application (AppleScripts or 
PhotoShop droplets). This allows for a virtually 
unlimited number of "post processing" tasks to be 
performed automatically upon importing images. 

OS X ships with iPhoto 2, which acts as digital camera image import and 
management. You can organize, search, view slide shows to music (and send 
the slide shows to friends), make screensavers, email, order prints, create and 
order books, mail photos, set your desktop background and you can make web 
galleries (with Apple's paid .Mac internet service or export a web page to 
upload to your own site). The interface is very easy. You can zoom in and out 
of your thumbnail library in real time, which is breathtaking. 

Editing tools include a decent home user's suite of rotate, crop, red eye, 
brightness, contrast and black & white. You can also add keywords to photos 
so you can search by keyword. New to iPhoto 2 is one-button enhance, scratch 
removal and archive to CD or DVD. 
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The crop tool is very intuitive. Once in Edit mode, just drag a box over the 
area you would like to select. A crop box overlays on top of your image, with 
the areas to be cropped ghosted back. You can then grab an edge of the crop 
area to move your crop box, or drag a corner to resize it. Then click the Crop 
button to apply your crop, or just leave the Edit screen to ignore your crop. 
You can adjust the brightness and contrast with real time sliders, or click 
Black & White. You can also remove red eye. 

When creating a slide show you can easily look up and use any songs from your 
iTunes library. If you have a .Mac account, you can create a screen saver slide 
show and share it w/other OS X users online. 

If you select to email your photos, the following dialog appears, showing you 
the number of selected photos to email, and an estimate of their file size at 
the selected dimensions 

 

You can opt to keep the images original size, or resize them to one of 3 
predefined dimensions. 

 

●     iPhoto can burn archives to CD or DVD, enabling your photo collection 
to span as many discs as you need.

●     iPhoto 2 can't catalog remote volumes, CDs etc., w/out importing the 
images to your startup drive

●     Image rotation is lossy (rotating images in XP's file system is lossless)
●     iPhoto is S L O W
●     No support for camera RAW mode

●     C|Net rates iPhoto 8 out of 10
●     the Wall Street Journal calls iPhoto "a winner"
●     TechNews.com: Mac OS X vs. Windows XP: It's No Photo Finish 

XP: XP relies on the file system windows to navigate/manage images, 
particularly by storing all of your images in your My Pictures folder. Folder's 
containing just images have an additional view option of Filmstrip view. With 

http://www.xvsxp.com/photos/ (10 of 12)1/1/2005 5:49:56 AM

http://www.cnet.com/software/0-429627-1204-8446137.html
http://ptech.wsj.com/archive/ptech-20020124.html
http://www.washingtonpost.com/ac2/wp-dyn?pagename=article&node=&contentId=A64882-2002Jun29&notFound=true


X vs XP > Digital Photos

this view you can scroll through your images below and view them enlarged 
above. You can also rotate your images from within Filmstrip view. 

Picture folders also contain special commands within their Tasks pane. From 
the Picture Tasks pane you can view a slide show, order prints online, print 
selected pictures, or set a selected picture as the desktop background. 

Image editing is performed with Paint. Paint really has no business editing 
photos, since it was originally designed as a crude drawing/painting 
application. It has a few tools for editing images, like the ability to flip/rotate 
or resize an image, as well as the ability to convert the image to a handful of 
different file formats. Owners of Office can use the slightly better Microsoft 
Photo Editor.

Microsoft supplies Image Resizer as part of PowerToys for XP. This PowerToy 
enables you to resize one or many image files with a right-click. 

XP has an assistant to resize an image for you when sending it via email (when 
you select Send To> Mail Recipient from a file's contextual menu w/in the file 
system). 

 

Clicking the "Show more options" link allows you to set the dimensions of the 
resized image. 
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This dialog box contains a usability gaff, allowing users to make contradictory 
selections. Though it's unlikely that someone would click "Show more options" 
after selecting "Keep the original sizes", it's still poor usability design to allow 
contradictory options to be selected (See iPhoto's Mail Photo dialog above for 
one solution to this problem). 

Photos, Managing: OS X: 8, XP: 6 

Pick a topic:  
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Printing and Faxing

Thanks to Mac Fan and UnnDunn for help w/this page. 

Printing Overview Both OS X and XP support sharing printers via USB (and obviously printing to shared printers). For designers, 
OS X can print EPS content and PostScript documents to any raster printer. XP requires that EPS or 
PostScript documents either be sent to a PostScript printer or sent through an EPS Rip. OS X also supports 
CUPS. CUPS is a cross-platform IP printing solution for all UNIX environments. OS X users can point their 
browser to http://localhost:631 to manage their printers. 

Print dialogs should be consistent 
I've always maintained that OS X's print dialogs are consistent, thereby increasing familiarity with new 
dialogs and reducing "discovery" time. Given that OS X's print dialogs aren't 100% identical, PC fans have 
rebutted that Apple's print dialogs are no more "standard" than XP's! So I decided to see who was right by 
comparing 3 print dialogs: Apple's "standard" dialog, iPhoto's dialog and Address Book's dialog and shading 
the differences. 

●     Regions that are 100% consistent on all 3 are not shaded.
●     Regions that are used differently on each dialog are shaded pink.
●     Regions that are used the same way on at least one other dialog are shaded green.

Here is Apple's "standard" print dialog: 
 

Here's iPhoto's print dialog: 
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And here's Address Book's print dialog: 

 

Let's compare that to 2 XP print dialogs: 
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Paint's Print dialog 

 
Photo Editor's Print dialog 

While OS X's print dialogs are "sensibly similar", XP's print dialogs seem to be completely different for no 
good reason. 

Starting a Print Job (Assuming you already have a printer set up), printing from applications that support printing in either OS is 
as easy as selecting Print from the File menu. 

Docked Printers 

Printing from the file system: In OS X, create "desktop printers" by dragging your 
printers from the Printer Utility into the Dock or the desktop. You can then drag any 
file directly onto a printer to print it. Files that OS X supports natively (.pdf, .jpg 
tested) will print automatically. Other files (e.g. Photoshop files) will open the 
associated application and print. XP users can also make a shortcut icon for their 
printer and drag a document onto it however results varied— File formats tested: .txt 
(works), .pdf(works), .doc(opens Word, prints, closes), .jpg (prints, fills page), .gif (error message). A more 
reliable (and more likely) solution for XP users is to right-click a file and select Print, which will always 
open the file in its associated application and print it. 

Both OSes also have a Page Setup menu item for setting things like the page dimentions and orientation. 

Page Setup: OS X allows users to set the Scale in Page Setup. 
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OS X's Page Setup Dialog 

 
XP's Page Setup Dialog 

In XP the location of the Scale command will vary 
from one printer driver to the next. In one printer I 
found it under Page Setup > Properties > Paper/
Quality > Advanced. In another printer (Epson Stylus 
Photo 1270) I couldn't find it at all! 

Print: OS X and XP's Print Dialogs have more or less the same options. XP allows you to print just a 
selection, while OS X allows you to choose from your Preset settings and Save as PDF. XP users can purchase 
PDF creation software separately (Adobe Acrobat, for instance) which will add save as PDF buttons to 
applications. 

 
X's Print Dialog 

Both OSes Print dialogs can be extended to allow additional items that may be required by various 
applications. XP accomplishes this by adding tabs to its Print dialog while OS X accomplishes it by adding 
items to its Copies and Pages dropdown menu. Also in that dropdown menu are additional job settings. 
Some settings are customized based-on the printer you are using (such as layout, paper type, ink and 
quality settings, etc.) while other settings are printer agnostic: save as postscript, page order, scheduler 
(sets when to print). XP has all these same options, but they are on a separate dialog, accessible by clicking 
the Preferences button. 
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XP's Print Dialog 

A Tale of 2 Printouts 
Try printing a wide web page (greater than 670 pixels wide) and fitting it to the printed page... 

XP: Click File> Page Setup, then Properties, then Paper/Quality, then Advanced..., then look for 
Scaling. If your printer driver lacks this (e.g. Epson Stylus Photo 1270), then you're out of luck. If you're 
the lucky owner of a printer that supports scaling, locate the Scaling box and select a percentage 
reduction in the page that will fit it to the page. Print that to see if you got the percentage right. If you 
didn't, just repeat. 

OS X: In Safari, Print. Pages automatically shrink to fit! In IE, click Shrink pages to fit from File> Print 
Preview. 

What XP's Print dialog has going for it is the ability to print just a selection, which would come in handy 
when you want to print part of a long web page. However if you want to print a web page wider than 670 
pixels, good luck. XP needs to have the scale feature more prominently available, and have it be consistent 
from printer to printer (some printers lack a scale feature altogether). The Print command in a file's 
context menu is a nice feature, although it would be even better if files that XP supported natively didn't 
need to open their associated application. OS X deserves kudos for its native Save as PDF feature, but that's 
tangential to starting a print job. OS X's drag and drop printing to desktop printers is nice, and the fact that 
native files print w/out opening any application is nicer, though a Print command in a file's context menu 
item would be appreciated too. The ability to scale a page is something I took for granted until trying it on 
XP. XP's poor implementation of this feature is not something that should be dismissed as trivial. 

Starting a Print Job: OS X: 8, XP: 7 

Managing Print Jobs Both OSes maintain print queues for every printer set up for that computer, whether it is a network or local 
printer. Use the print queues to manage print jobs and configure printers. (In XP, use the print queues also 
to set default printing preferences). 

OS X: To manage print jobs, just double-click the printer's icon in the Dock (every printer will show up in 
the Dock while printing). Alternatively, you can open the Printer Setup Utility (in the Utilities folder) and 
select the printer to manage, or if your printer is on the Desktop you can double-click its icon. 

 
The Printer List window of the Printer Setup Utility 

Once you've selected your printer, you can hold, resume, reorder (if all jobs are yours) or stop print jobs. If 
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Viewing a printer's jobs in OS X 

your printer has a utility dialog (for cleaning and 
aligning heads, etc.), you can access it here by 
clicking the Utility button. 

XP: The Print Queue is used primarily to manage existing print jobs. There are 
several ways to get to the print queue. If you are currently printing a document, 
you can use the Taskbar Icon to open the queue. If not, you can also go to the 
Printers and Faxes Control Panel and select the desired printer. Or you can right click inside a Print Dialog 
and select 'Open'. 

The print queue.

If you are an Administrator, you can change the order of the print jobs, and you can pause, resume or 
cancel any job by using the 'Document' menu or right-clicking on the job(s) you want to manage. Normal 
users can only manage their own print jobs, and they cannot reorder jobs. You can also see who owns the 
job and where it came from (if it came from a different computer.) If there is a problem with a print job, 
double-clicking on it will show details of the problem and allow you to retry the job once the problem has 
been fixed.

Managing Print Jobs: OS X: 6, XP: 6 

Configuring Printers OS X: Configuring printers is handled by the Print Center application. There are multiple ways in OS X to 
access Print Center: 

1.  In any Page Setup dialog, select Edit Printer List... from the Format Menu.
2.  In any Print dialog, select Edit Printer List... from the Printer Menu (or if you want to print to a 

shared USB printer, select if from the Shared Printers submenu).
3.  Run the Print Center application (located in the Utilites folder within the Applications folder).

 
Printer List 

Click the Add icon to add a printer. Select Rendezvous or AppleTalk from the popup menu and Print Center 
will auto-detect those printers on your local subnet. Select USB to locate printers connected to your 
computer via USB. If someone else is sharing their USB printer, select Rendezvous to locate it. Other 
printers (IP Printing, Directory Services) require that you know the printer host name or IP address.
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XP: XP's Print Queue is used to configure printers.

 

The Printer Properties Dialog

Configuring printers: To configure your printer, go to the Print 
Queue and click on Printer -> Properties.

You can click around the various tabs to configure your printer. 
Configure its port settings, security, sharing and more. You can 
even print a test page which will print a listing of all the files used 
by the printer driver. Most of the tabs in this dialog can only be 
used by administrators.

XP has some additional options for administrators that X lacks. XP admins can set the hours of operation of 
a shared printer, as well as define who can access it.

While OS X's printer configuration is adequate for typical home users, XP provides additional functionality 
to control who can use a shared printer and when they can use it. 

Configuring Printers: OS X: 7, XP: 8 

Printing Preferences Setting printing preferences deals with creating a set of printing preferences that can be recalled later 
(default page setup, quality, ink, paper type, etc.). Users may want to print photos always the same way, 
and print web pages always another way. 

OS X: OS X users create, modify, delete and select presets from within the 
Print dialog. Simply set up your print settings for the file you want to print, 
then save your settings in the Presets dropdown menu. You can store 
multiple presets, and recall them by name (Dan's Draft, Photo on Matte 
Paper Heavyweight, etc.). 

XP: Printing preferences are set in XP's Print Queue. By clicking on 'Printing Preferences', you can set up a 
default set of preferences which will be used every time you print unless you change them manually. For 
example, you can specify that the printer should print in black and white with draft quality by default, and 
every document you print will use those settings unless you change them on a per-job basis.

XP: 

●     Can only store one set of settings per printer
●     Setting printer defaults is not located withing the Print dialog

OS X: 

●     Store many presets, and recall them by name (Dan's Draft, Kathy's high quality, etc.) which is 
valuable to photographers who may store different print settings for different paper types and 
qualities. 

●     The ability to select and modify print settings is in the appropriate point in a work flow (in the Print 
dialog).

Printing Preferences: OS X: 8, XP: 3 
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PDF Creation 
 

Since PDF creation has historically been associated w/printing, I figured this is as good a place as any to 
talk about it. 

Neither OS is capable of creating PDFs with all the functionality that PDFs are capable of (Forms, Links, 
Bookmarks, Page Thumbnails). That is why people purchase apps like Adobe Acrobat. 

OS X: Save as PDF is built-in to every Print dialog in OS X. Generated PDFs will not retain links, and page 
thumbnails won't be created. (Preview can also rotate and crop PDF images as well as exporting them to 
alternate file formats.). The PDF workflow scripting menu makes creating workflows easier. You can 
Convert any Postscript document to PDF with a double-click. 

XP: XP requires a third-party product (such as Adobe Acrobat) in order to create PDF files. 

PDF Creation: OS X: 5, XP: 1

Faxing Both OSes can send and receive faxes (although XP's fax service is not part of the XP standard install 
package, it must be installed separately). Both OSes use the computer's built-in modem to send and receive 
faxes. Additionally, OS X can send and receive faxes via bluetooth capable cell phones. According to 
bluetake.com, XP can also use bluetooth cell phones to send and receive faxes, but they must be physically 
connected to a fax machine or a modem with fax funtion. 

OS X: Faxing if built-in to the Print dialog. To send a Fax, click the Print Dailog's Fax button. 

 
Sending a fax 

To receive faxes, set up what your computer should do with incoming faxes... 
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Configuring your Mac to receive faxes 

You can set faxes to be automatically saved to a folder, emailed to an email address, and/or printed to a 
printer. Apple's support doc: How to Get Notified When a New Fax Arrives explains 3 methods you can be 
notified: 

1.  Get notified by email.
2.  Get notified by automatic printing.
3.  Get notified by onscreen message.

I would qualify the third method as a "kludge" since it requires that you enable Folder Actions then assign a 
folder action to the folder that receives your faxes. Though functional, it requires too many steps on the 
part of the user. There should be a checkbox in Fax preferences to receive onscreen notifications. 

XP: The following information was gathered from Sharon Crawford's article: Faxing in Windows XP, 
Windows XP Expert Zone. 

Faxing for XP is not installed by default— it must be installed separately. Once installed, the Fax Service 
must then be configured. 

Use Fax Console for managing incoming, outgoing and archived faxes. 

To send a fax, select Fax as the printer from your Print dialog. This will launch the Fax wizard. In order for 
dialing rules (for instance, a dialing prefix) to be applied, XP's Fax Wizard requires strict phone number 
syntax. 

"Telephone numbers must be in the canonical form in which a U.S. number would appear as 
+1 (626) 555-1212. If you use even a slightly different form such as (626) 555-1212 or 1-626-
555-1212, the dialing rules won't be applied and the fax transmission will fail." 

If you don't have any dialing rules then you won't have any problems. I suppose this could could be a 
feature, since phone #'s entered in other forms could be internal speed dial, for instance. In that instance 
check the Apply Dialing Rules checkbox. 

When an incoming fax arrives, Fax Monitor opens. To view a fax, go to the Inbox of Fax Console. You can 
then email it or print it. 

Microsoft Outlook requires additional configuration to send faxes and the steps for sending a fax in Outlook 
are different from sending faxes from other apps.

XP's faxing has a few advantages over OS X's 

1.  Greater flexibility in creating cover pages
2.  History logs of sent/received and errors
3.  Fax Manager provides a single location to manage faxes 
4.  Ability to change header information, including the TSID (transmitter subscriber identification) and 
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CSID (called subscriber identification)
5.  Faxes can be manually accepted

XP's faxing has a couple of liabilities: 

1.  Faxing Service must be installed separately
2.  Received faxes cannot be automatically emailed

Faxing in OS X is part of OS X's default installation. OS X does not require fax numbers to be in strict 
canonical form in order to apply a dialing prefix. 

Faxing: OS X, 7, XP: 7 

Pick a topic:  
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Voice 
Recognition

Voice recognition can be used for dictation or to control your computer using spoken 
commands. Neither XP nor X ship w/built in dictation, (though it is an optional addition of 
Microsoft Office for XP). 

XP: Though XP Tablet Edition supports voice recognition to control your computer with your 
voice (requires training), XP Home and Pro don't. If you own Home or Pro and want voice 
recognition, you'll need to get Microsoft Works or Office. 

OS X: Voice recognition to control your computer is excellent in OS X, and has been around 
since OS 7. Just turn on Listening in your System Preferences, and your computer will start 
listening for voice commands. It also provides a floating palette for feedback, so you can see if 
it heard you. You can optionally have it listen only if a key is pressed, or after you say a key 
word, like "Computer". There's also a Speakable Items palette that shows you what commands 
the computer knows, and you can add your own commands.

 

OS X supports full menu navigation via speech (see above). That means that you can say "File 
Menu", and the File menu of the current application will drop down. Then say, for instance, 
"Open", and the Open command will be selected. Unfortunately it can't navigate sub-menus, 
but amazingly it can navigate the buttons on front application windows (Save, Cancel, etc.). 
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Even on my 266 Mhz G3 I was very impressed at how well speech recognized my commands, 
even as I was listening to grunge radio with the speaker not even 2 feet from the microphone. 

Speakable items is also extensible. The Speakable Items folder can contain XML files that 
associate spoken commands with keyboard shortcuts. "Make this bold," for example, sends 
Command-B; "Copy this to the Clipboard" sends Command-C. The Speakable Items folder 
contains an Application Speakable Items folder, which contains a subfolder for each 
application, so that you can create spoken commands that apply only to your application. 
Items in your application's folder are speakable only when your application is active 
(frontmost). 

Voice Recognition: OS X: 7, XP: 1 

Speech 
Synthesis

XP: XP's help is virtually non-existent about how to get the computer to speak text. After 
hunting around, I found Excel supports speaking the text of spreadsheet cells (Tools>Text to 
Speach>Show Text to Speech Toolbar). I could find no such ability in Word, the one application 
I would most expect to support text to speech. In fact, searching in Word Help for "Speak Text" 
only brings up speech recognition topics, nothing on speech synthesis. The Speech Properties 
control panel doesn't provide any clues either. You can select one of three voices and preview 
it, but there's no further information on how to use this feature. 

XP's Speech Synthesis program is called Narrator (below), and it can be access by typing 
Windows-U. Narrator can read aloud menu commands, dialog box options, Announce events on 
screen and Read typed characters. It comes with one voice, Sam. It doesn't appear to be 
capable of reading selected text. 

 

OS X: X supports supports system wide voice synthesis and has over a dozen voices in it's 
speech repertoire. Just check the Use key to speak selection check box in the Spoken 
User Interface tab (below) of the Speech Control Panel. You can have the computer announce 
when an application requires your attention, speak the text under the mouse (menus, dialogs, 
buttons, but not document text), or speak selected text when you press a hot key of your 
choosing. 

In the Services menu, there's a Speech option to start or stop speaking text, however this 
selection is dimmed in non-Cocoa apps. This means that there aren't many apps that will 
support this command, but to name a couple, Stickies and TextEdit work. This issue is 
diminished by the fact that any X application supports speaking selected text when your hot 
key is pressed.
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Speech Synthesis: OS X: 8, XP: 3 

Talking 
Dialogs 

OS X: Just check Speak the alert text in the Spoken User Interface tab (above) of the 
Speech Control Panel, and your Mac will speak all alerts out loud. You can specify which voice 
to use and you can specify a delay before speaking the alert. This is great if you have your 
back to the computer, or you walk away during an installation. Your Mac can tell you from 
another room that the installation is complete! 

XP: XP's Narrator speak dialogs, but it also speaks the contents of every foreground window, 
which makes it extremely annoying if all you want is verbal notification of a dialog when your 
back is to the computer. Furthermore, Narrator doesn't just read the text of the dialog, it also 
reads the title, says it's a dialog and reads the buttons (twice), saying that they're buttons. 

●     Listen to XP speak a Save dialog (MP3, 160K)
●     Listen to OS X speak a Save dialog using:

❍     Agnes
❍     Albert
❍     Bad News
❍     Bahh
❍     Bells
❍     Boing
❍     Bruce
❍     Bubbles
❍     Cellos
❍     Deranged
❍     Hysterical
❍     Junior
❍     Kathy
❍     Pipe Organ
❍     Princess
❍     Ralph
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❍     Trinoids
❍     Vicki (new to Panther, default voice)
❍     Victoria
❍     Whisper
❍     Zarvox

Talking Dialogs: OS X: 8, XP: 4 

Pick a topic:  
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Networking 
 

Both OSes support separate network settings for different network interfaces (i.
e., multiple Ethernet slots, wireless cards, etc). Both support TCP/IP thoroughly. 
Both support IP over Firewire and internet sharing over Firewire (read about OS 
X's support). They both support sharing an internet connection (good for home 
networks), and both support printer sharing. 

OS X: Out of the box OS X additionally supports SSH, FTP serving, NFS, AppleTalk 
(over IP as well), WebDAV, mail serving, Samba, Rendezvous (ZeroConf), 
Bluetooth, IPv6, IPSec (L2TP IPSec-based VPN), 802.1X, jumbo packets for GB 
ethernet, half duplex/full duplex selection, Active Directory authentication, 
offline authentication and secureID authentication (for security reasons, several 
of these protocols are turned off by default). OS X lacks user-friendly interfaces 
on WebDAV, FTP (read AND write) client, NFS and IPSec. OS X ships w/Apache, 
the world's most popular web server, according to NetCraft. In the Sharing 
Control Panel is a Firewall tab where you can view and configure what traffic 
you allow in and out of your computer. 

(Thanks, daGUY)

Rendezvous?
Rendezvous' "zero configuration networking" has been integrated into lots of 
Apple apps and third party products: 

●     iChat AV: automatically generate a buddy list of everyone on your 
local network. Rendezvous chat messages are sent as-you-type, 
enabling a more real-time experience.

●     iTunes: automatically share music libraries between Macs (or PCs 
now) on your local network

●     Safari: automatically displays bookmarks for web services on other 
computers on your local network

●     Terminal: connect to local servers via ssh, sftp, telnet, etc. 
●     XCode: automatically distribute code compiles to idle network 

resources
●     XGrid: automatically distribute computationally intensive tasks to 

idle nodes, creating a mini-supercomputer cluster out of your shared 
Macs

●     Image Capture: share the contents of your digital camera over the 
web. This feature can also be password protected. If that's not 
enough, you can even remotely control supported cameras (read 
more about this at MacDevCenter.com). 

In addition, two or more Rendezvous-enabled Macs are able to set up file 
sharing between themselves, automatically. Rendezvous is also being built 
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into printers and other hardware to allow instant, automatic configuration 
with computers. Even games are being programmed with Rendezvous built in 
to make it easier to set up network games. The groundbreaking shareware 
app SubEthaEdit is Rendezvous-based text collaboration. Combined with OS 
X's Web Kit, SubEthaEdit is also a collaborative HTML editor with a real-time 
WYSIWYG preview. 

Setting up and switching 
between multiple 
network locations (for 
instance, one each for 
home and office) is very 
easy. Just add a new 
location within the 
Network Control Panel. 
Locations can be switched back and forth without rebooting. XP cannot easily 
create multiple network settings to switch between.

Basic file sharing is a snap. Just turn on File Sharing in your System Preferences. 
Now anyone can share files through your Public folder, and you can remotely log 
in to access your entire drive. If you want anything more exotic, good luck; you'll 
have to dust off your Unix netInfo manual or download the shareware app 
SharePoints. 

Browsing the network is accomplished by clicking the Network 
icon in any Finder window. You can also connect to another 
computer by selecting Connect to Server from the Finder's Go 
menu or type the keyboard shortcut -K in the Finder. You can browse the 
network to locate the computer you want to connect to, or if you know the 
server's address, you can type it in directly. 

Unfortunately, browsing vs. connecting via a URL seems to be an either/or 
scenario: each interface is separate from the other, and URLs to connect to 
servers are not "discoverable", meaning it is not obvious how to find out the URL 
string to use in order to connect to a computer. Inconsistently, when you 
connect to a server via a URL string, the server icon gets a disconnect button in 
the sidebar, but when you connect to a server by browsing it lacks a disconnect 
button. 

 
Browsing the network in OS X. 

OS X also has built-in support for multihoming, which means it auto-detects 
which network port is attached to an active network, and uses that port. This is 
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great news for portable users who find themselves frequently connecting to 
different networks (sometimes wired, sometimes wireless). Although XP will also 
detect the current active interface, in my experience its auto-detection 
capabilities aren't as robust as X's. 

A read-only FTP client is built directly in to the OS. Typing in an FTP URL in the 
Connect to Server dialog box will mount the FTP site right on your desktop. 
Unfortunately, read-only status severly limits the usefulness of this feature. 
Occasionally it didn't know how to traverse symbolic links, a frequent issue with 
virtual hosts. It also has difficulty connecting to directories outside of a users 
remote home directory. It appears to not cache directory listings, which can 
slow things down, however it admirably displayed large preview icons of an 
images folder.

As for Windows File Sharing, I was able to successfully mount my Mac on a PC, 
but only when my Mac login and username matched my Windows login (this issue 
appears to be because my computer is on an Active Directory network). This 
seems a little restrictive, because if I want to give another Windows user access 
to my computer, I'd need to know their password (until OS X includes FULL 
support for Microsoft's Active Directory). 

And for corporate users, OS X supports Active Directory (though set up requires a 
little bit of effort) and Apple's own Open Directory.

XP: Windows XP Professional can reliably connect to other Windows machines 
and supports IPSec and 802.1X. AppleTalk services, FTP client, WebDAV and IIS 
are optional installs. IIS acts as a web/FTP/SMTP server. XP lacks an SSH client. 

IE can be used as an FTP client, and is occasionally sufficient, but not perfect. 
For instance, IE will always place you in your home directory, and figure all 
paths based on that, making it impossible to navigate to a directory outside of 
your home directory. 

XP Home Edition lacks all of those optional installs and cannot connect to an 
Active Directory Domain (OS X can). Though I am told it is possible, I have not 
been successful at getting XP Home edition to mount shared folders from a 
Windows 98 computer.
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XP's My Network Places Window 

XP's My Network Places fails to emphasize the most likely task at hand, 
connecting to a network server. Rather than centering the user's attention on 
this task, browsing the network is inappropriately tucked away under the Entire 
Network link. 

If you shrink the window, the 
link for browsing your Windows 
network disappears 
completely. 
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Using My Network Places to connect to FTP servers is problematic. For instance 
it failed to log me in to my root /web/ directory, instead logging me in to /users/
myusername/web/. 

That said, the task-based interface to My Network Places should make it easy for 
novices to both connect to network locations and to browse their current 
network connections.

Networking: OS X: 9, XP Pro: 8, XP Home: 5 

Pick a topic:  
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I've created the Power User category to talk about topics that the average computer user wouldn't care about, but 
more advanced users would.

Screen capture keyboard 
shortcuts for 
screen shots: 

OS X XP

Screen to file Shift- -3

Screen to 
clipboard Ctrl-Shift- -3 Print Screen

Crosshair screen 
selection to file Shift- -4

Crosshair screen 
selection to 
clipboard

Ctrl-Shift- -4

Window to file hit spacebar after invoking Shift- -4, then click 
the appropriate window

 

Window to 
clipboard

hit spacebar after invoking Ctrl-Shift- -4, then 
click the appropriate window

Alt-Print Screen 

Menu to file or 
clipboard

First, click the appropriate menu to invoke it, 
then (as above), hit spacebar after invoking Ctrl-
Shift- -4 or Shift- -4, then click the menu. This 
method can also be used to take a picture of the 
Dock or an application's menu or palette.

  

XP: As noted above, XP supports 2 different types of screen grabs, both going to the 
clipboard (have to then paste into a document to see the shot). Windows Media Encoder 
(a free download from WindowsMedia.com) supports screen capture to video. 

Screen Grabs and Windows Media Player
A couple of readers corrected me when I 
claimed that taking screen grabs of 
Windows Media Player resulted in black 
where the video was supposed to be. I 
neglected to turn off Video Acceleration 
(under Options>Performance) which sends 
video directly to the video card, bypassing 
the CPU). Sure enough, with Video 
Acceleration set to None, screen shots of 
videos works fine. My bad. 

OS X: Though Apple has no free software 
to screen capture to video (Ambrosia 
Software's excellent utility SnapzPro is 
$49), it does support 6 different still 
screen grab shortcuts, plus you can use 
the preinstalled Grab application for 
greater variety, including timed screen 
grabs. You can also invoke screen capture 
from the Unix command line using the 
screencapture command, which 
facilitates scripting of screen capture. 
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I use the crosshair-screen-selection-to-clipboard all the time, however it could benefit 
from guide rules to help determine the first corner to begin your selection. 

All screen shot files are saved as PDF. Double clicking a screen grab in 10.2 opens it in 
Preview. From within Preview, you can export to about a dozen different formats (Export 
Formats). You can also access different saving options for each format ( Export Options). 
A major omission is the ability to export to GIF format. 

Despite OS X's lack of screen capture to video, I find it considerably more useful than XP's 
for its variety of still screen capture options. As a web developer I use still screen 
capture all day long, and seldom need to capture videos. That said, I wouldn't pass it up 
if Apple added it (hint hint!). 

Screen Capture: OS X: 8, XP: 5 

Schedule Tasks OS X: iCal's alarm feature can be used to schedule tasks on your Mac, though OS X seems 
to make no mention of it (even iCal's "Setting an alarm" help topic fails to mention this 
feature). You can specify to open a file (or launch an application) as your alarm. Using 
this method, you can schedule any task on your computer, and you have all of the 
versatility built-in to iCal for scheduling it. MacDevCenter.com shows how to schedule 
tasks using iCal and/or cron. 

For command line junkies OS X has Unix's venerable cron scheduling utility built in. If 
you're not familiar w/cron, you can download a 3rd party product like Cronnix for a more 
user friendly interface. 

For scripters, Folder Actions Scripts are now available in OS X 10.2. This means that 
rather than having repetitive tasks be time driven, they can be event driven. For 
instance, you can set a folder to automatically upload any file placed into it to some 
destination. Users no longer have to wait for a task's scheduled time to kick off. Now 
tasks can occur whenever you are ready for them. 

XP: XP's Scheduled Tasks Console is a very user friendly product. I found it a snap to 
schedule or remove tasks. Here is a screen shot walk through of the Schedule Tasks 
Wizard: 

●     Schedule Tasks icon
●     Wizard welcome screen
●     Select a program to run
●     Name the task and set when to run
●     Refine when to run
●     Assign the user to run the task as
●     Finished
●     Task Properties, Task Tab
●     Task Properties, Schedule Tab
●     Task Properties, Settings Tab
●     Your Task's icon

OS X: 

●     No documentation of iCal's ability to schedule tasks
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●     No "list view" of tasks
●     Setting the "stop time" of a task involves writing an AppleScript like tell 
application "iTunes" to quit. Not as elegant as XP.

●     Decent integration with iCal

XP: 

●     No calendar view of tasks
●     Option to set when to stop a task
●     Option to set task to run during idle time or NOT to run if in battery mode

The utter absence of documentation on Apple's part (man cron notwithstanding) 
diminishes what is otherwise a fine feature. XP's product is quite good, though a 
calendar-style view of scheduled tasks might be nice. XP seems to have more options 
with regards to when to start or stop tasks (during idle time, not during battery mode, 
set when to stop a task). 

Schedule Tasks: OS X: 7, XP: 8 

Remote Control OS X: OS X supplies multiple methods to acheive remote control: 

1.  OS X machines can be set up to allow remote ssh (command line) login. 
2.  Apple's X11 also allows remote control of other X11 apps. 
3.  You can set up your OS X computer to receive "Remote Apple 

Events" (AppleScripts). This is a great way to have 2 Macs talk to each other. For 
instance, I've used this as a way for one Mac to query FileMaker Pro on another 
Mac and then automatically generate a web page based on the result. Here's a 
sample script to make 3 computers literally talk to each other. 

4.  Apple Remote Desktop Client 2.1 comes with its own VNC server so that VNC 
clients on any platform can connect to and control your Mac. (Apple's language 
can be confusing: what VNC considers to be a server— a computer that can be 
remotely controlled— Apple considers to be a Remote Desktop client). 
Unfortunately, Apple does not supply a free viewer to connect to VNC servers and 
Remote Desktop clients. Mac users will have to download a third party VNC 
client. Users wanting any an Apple-supplied way to connect to Remote Desktop 
clients will have to either shell out $299 for Apple Remote Desktop, which works 
with any VNC enabled computer, even PCs. 

XP: XP Professional's Remote Desktop Connection allows you to remotely log in to your 
computer and take control of it. Its remote interface is responsive. Microsoft even 
supplies a free OS X client so PC users can log in to their machine from a Mac. RDC for 
Mac is very well designed. It automatically supported my right mouse button, and 
windows interface sounds (mouse clicks, folders opening) even played on my Mac, a little 
spooky! And the interface was snappier in the Mac version of RDC than either Apple 
Remote Desktop or VNC. 

XP Home edition lacks Remote Desktop Connection. 

The lack of a free Apple-supplied VNC client (Remote Desktop server) is disappointing, 
however power users will appreciate the variety of Unix (X11) and command line 
methods of remote controlling their Macs. 
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Remote Control: OS X: 4, XP Pro: 9, XP Home: 1 

Booting from 
alternate drives 

Thanks to Scot Walker for help with this section. 

In the days of less stable OSes, the ability to boot from alternate drives was an important 
resource in troubleshooting. The stability of X and XP may have made this a thing of the 
past, however it's still occasionally useful for power users to boot from an alternate 
drive. 

OS X: There are 3 methods in X for booting from alternate drives. 

1.  If you're currently booted into one OS, you can select the alternate drive (as long 
as it contains a valid OS) from the Startup Disk icon in System Preferences.

2.  Use Apple's NetBoot to boot off of a remote server. (A close-up look at Mac OS X's 
NetBoot - Computerworld) handled by Open Firmware 

3.  You can hold down a key (or a combination of keys) while booting. Here's a list of 
startup key combinations for booting from alternate drives (source: AppleCare 
Document 75459) handled by Open Firmware

Hold down Option- -
Shift-Delete   

Bypass primary startup volume and seek a different startup 
volume (such as a CD or external disk) 

C Start up from a CD that has a system folder 

N Attempt to start up from a compatible network server (NetBoot) 

T Start up in FireWire Target Disk mode

Hold down Option key A GUI displays which lists all system folders (OS 9 or OS X) on all 
volumes connected. Click on the one you want to boot and click 
continue. 

XP: Thanks to UnnDunn for help w/this section 

Booting to CD/DVD/Firewire/etc. is wholly controlled by the BIOS, which varies wildly 
from computer to computer. On some computers, you have to enter BIOS setup to 
change the boot order, but this is not true with all PCs. For instance, on some HP 
laptops, you can just hit F10 during startup and choose where to boot from. 

On x86 PCs that lack such key commands at boot time, you have to go to the BIOS to 
change the boot order of drives. This order is fixed, not dynamic, in the BIOS. So if your 
CD drive is set to boot before your hard drive (required to boot from CD) the PC will look 
for a system CD in the CD drive every time you boot, even if there is nothing there. 
Furthermore, XP's Product Activation may make it impossible to boot from an alternate 
IDE drive (other than NetBOOT). 

Booting from alternate drives is rare? One reader doesn't think so...
Jason Wiley took issue with my dimishing of the value of booting from alternate 
drives. He writes, 

"...this may be rare for you, but I am constantly using alternative boot 
drives for a variety of reasons, and most IT guys I know do as well. 
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The main reason is for backups. Sure, I can backup to a DVD and spend 
time restoring my system if something bad happens, or I can use 
Carbon Copy Cloner, or do a mirror install to a FireWire drive or 
another ATA drive, or just drag and drop, and be up and running with 
a simple reboot. Also, I can have my very own system available to me 
at work without stepping on IT’s toes by loading software on their 
systems, thanks to a portable FW drive or iPod. If I want to change 
machines, it’s as easy as cloning the drive, and rebooting from that 
drive. On my web server, I have the internal ATA drive (in an original 
iMac) partitioned into 3 drives. The first is the main boot drive, the 
second, a copy that update every 1-2 weeks, and the third is a large 
volume for data only. If I ever have a problem with the web server, 
database (MySQL), scripts (PHP), etc, or any system level gremlins, 
then I am 1 reboot away from being up and running again while I fix 
the problem. On my main desktop machine, I do the same to an 
external FW drive. It’s all infinitely useful if you actually utilize the 
tool." 

Much of what is described in this section is not handled at the OS level, but at a lower 
level. On the Mac, this level is called Open Firmware, and on the PC it is called BIOS. It 
is unfortunate the myriad differences in PC hardware make for a fractured user 
experience in this important troubleshooting method. However, in fairness, this is--for 
the most part-- not an OS issue. 

Booting from alternate drives: No Score 

Pick a topic:  
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Both OSes provide scripting languages. OS X comes with Script Editor for debugging scripts; XP 
does not ship with a debugging tool, but Microsoft provides them for free on its website, 
alongside the Microsoft Script Debugger. 

OS X: OS X's philosophy of scripting is allowing users to 
automate the operating system, as well as applications 
on their computer. Once application developers add 
AppleScript support to their apps you can automate 
them. Each scriptable application comes with its own 
built in dictionary so you can learn how to automate 
that app. This philosophy makes it very intuitive to 
automate your workflow, since your scripts will follow 
the same application steps that you would use. 

You write scripts using Script Editor (which comes 
preinstalled). Script Editor supports syntax coloring, 
syntax checking, Script Assistant (think of it as 
command auto-complete), event logging, and user-
modifiable context menus to aid in creating common 
subroutines. Script Editor has a Record button that will 
allow you to record actions from recordable apps. This 
is a great way to learn AppleScript, by having scripts 
write themselves! 

Script editor is best for making faceless scripts or scripts that require minimal user interaction. 
For full fledged applications with a rich interface, use AppleScript Studio. AppleScript Studio is 
supplied on the Developers Tools CD that ships with OS X. It's also a free download from Apple's 
Developer site (developer site membership is also free). 

Apple's Script Menu gives you a menu in all your apps for running scripts, which is a great way to 
automate basic workflows. Place scripts in ~/Library/Scripts/Applications/AppName to create 
application specific Script Menu items. Folder Action scripts allow users to attach scripts to 
folders. The scripts can monitor items added or removed from folders and invoke scripts based 
on these events. 

For die hard programmers, Unix shell scripting and Perl support  come preinstalled in Mac OS X, 
and both can be integrated with AppleScript. AppleScript's Open Scripting Architecture allows 
alternate scripting languages to be installed, like JavaScript. For VB fans, Microsoft has 
incorporated Visual Basic for Applications into its Office suite for X, so Office apps can be 
scripted using VBA and/or AppleScript. 

One nice aspect of AppleScripts is that they don't need to be recompiled each time they're 
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edited. In fact, you can edit an AppleScript app while it's running. Click Save and the running 
script will be updated—no need to restart it. 

XP: XP's philosophy is slightly different. Rather than automating individual applications, 
Microsoft's scripting languages hook directly into XP's underpinnings. The idea is that if you can 
hook directly into Windows, you should be able to do just about anything. They call their 
scripting architecture WSH (Windows Script Host). 

Annoyances.org has a decent introduction to Windows Script Host. According to Annoyances.
org, "The cool thing about the Windows Script Host is that it is language-independent, meaning 
that it will work with any modern scripting language. It has built-in support for JavaScript and 
VBScript, but can be extended (with third-party add-ons) to use almost any other language, 
such as Perl, TCL, Rexx, and Python." 

XP does not ship with a true script editor. Since scripts are plain text, they can be created with 
NotePad, but there's no syntax coloring, syntax checking, or event logging. Scripters looking for 
a full fledged development environment will need to download a freeware or shareware 
solution (for instance Gvim) or purchase Microsoft's Visual Studio. XP has no built-in dictionaries 
for learning scripting commands. Microsoft, however, provides extensive online documentation. 

Learn more about XP scripting at Microsoft TechWeb.

Let's look at the differences between AppleScript and Microsoft's scripting languages. 

Example 1: a subroutine to download an image to your hard drive 

VB: (Using Microsoft Internet Transfer Control displayed using Microsoft Visual 
Basic 6.0's syntax coloring)

Private Sub cmdWriteFile_Click()
  Dim b() As Byte
  Inet1.Protocol = icHTTP
  Inet1.URL = "http://www.xvsxp.com/images/xvsxp.gif"
  b() = Inet1.OpenURL(Inet1.URL, icByteArray)
  Open "C:\xvsxp.gif" For Binary Access
  Write As #1
  Put #1, , b()
  Close #1
  MsgBox "Done"
End Sub 

AppleScript: (Using URL Access Scripting, displayed using Script Editor's syntax 
coloring) 

on downloadImage()
    set web_URL to "http://www.xvsxp.com/images/xvsxp.gif"
    set file_path to "Macintosh HD:xvsxp.gif"
    tell application "URL Access Scripting" to download the web_URL 
to file file_path
   display dialog "Done"
end downloadImage 
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As seen in the above example, AppleScript is a very easy scripting language to 
learn, especially for novices. You can use expressions like "is greater than or 
equal to" and "isn't equal to" in AppleScript, or if you prefer, you can use 
mathematical operators like ≥ or ≠. Windows users can't use either of these (they 
can't even TYPE these math operators) instead relying on the popular yet more 
cryptic programmers comparisons >=, !=. This is fine for experienced scripters, 
but novices may find that discouraging. 

Example 2: scripting speech 

XP: This excerpt from CMP's TechWeb outlines how to script speech on XP. (It's 
ok to let your eyes glaze over in this example. Just notice how MUCH it takes to 
do it). 

"Sometimes, you need your PC to tell you what's wrong. The little 
script below lets you have the PC speak a message of your choice 
over the speakers. It uses the same ActiveX control as the Zinger 
ISP monitor, although I was using Perl for that project. You'll need 
to install the files for Microsoft Agent core components and text-
to-speech engine (link no longer available) if you don't have them 
already. 

var vt = WScript.CreateObject("Speech.VoiceText");
vt.Register("", WScript.ScriptName);
var phrase = "Is there something I should say?";
if ( WScript.Arguments.length )
        phrase = WScript.Arguments(0);
vt.Speak(phrase, 1);
while ( vt.IsSpeaking )
        WScript.Sleep(100);
WScript.Quit();

"Just take the lines above, save them in a file named SAYIT.JS, 
and run the file. You should hear it say "Is there something I 
should say?" (If you get an error message instead, you probably 
need to install Microsoft Agent [this was a free download from 
MS's developer site, however the link has disappeared].) To 
customize the message, you can edit the phrase in the SAYIT.JS 
file. However, the script also checks its argument list to see if 
anything has been passed in. If there's an argument, the script 
speaks its argument instead of the built-in phrase. To use this 
feature, create a shortcut (Right-click the desktop, select New > 
Shortcut) and enter a command line like:
  path\SAYIT.JS "I want to say this"
Where path is the folder where you saved the file. Launch the 
shortcut and it will say "I want to say this". Cool, eh?" 

OS X: Now here's how to do the same thing on X: 

Add the following to any of your scripts: 

say "Is there something I should say?"   

Replace "Is there something I should say?" with whatever phrase your want. 
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Not cool enough for you? How about this: 

say "This is cool" using "Kathy" saving to "someText.aiff" 

You can subsitute Kathy with any of the dozen or so built-in voices, and your 
script will save the spoken text to a file! You can then bring it into your favorite 
video or audio editor and use it to spice up your masterpieces! Cool, eh? 

And if that's not enough for you, check out this simple script to make a bunch of 
Macs talk to each other, literally! 

Example 3: Display free disk space 

XP: The following script was taken directly from Microsoft's own TechNet web 
site: 

Set objWmiService = GetObject("winmgmts:")
Set objLogicalDisk = objWmiService.Get("Win32_LogicalDisk.
DeviceID='C:'")
WScript.Echo objLogicalDisk.FreeSpace

OS X: tell application "Finder"  to display dialog (free space of startup 
disk) as string

Example 4: Address Book 

One night I was wondering if Address Book for OS X was scriptable. I could have 
looked up its dictionary, but instead I tried to write a sample script without 
having any knowledge about what commands Address Book supported. I wrote 
the following script: 

tell application "Address Book"
   set theFirstNameList to the first name of every person whose last 
name contains "e"
   display dialog (theFirstNameList as string)
end tell 

Amazingly, it worked. This is perfect testament to the elegance, simplicity, and 
power of AppleScript. 

OS X also comes with AppleScript Studio for creating AppleScript-based applications with user 
interfaces. 
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Using AppleScript Studio within Xcode 

Xcode updates are available for free (to members of Apple's Developer Connection, membership 
is free). 

Preserve Styled Text!
Copying code from Script Editor maintains its status as styled text. Copying from Visual 
Basic loses its styled text status, however. Who cares? Well, creating the HTML for the 
AppleScript code was a breeze. I copied the code from Script Editor and pasted it into a 
new Entourage Email message (with HTML formatting on). Save as a draft and view source, 
and there's the code, now HTML formatted. 

That process was not as easy with the PC code. Since the code lost its styled text status, 
no HTML editor could generate the code for me. I had to recreate the styles by hand in my 
editor. ;-( 

Does Speed Matter?
Hard core coders may point out 
that the lower level of XP's WSH 
may make the scripts run faster 
than comparable AppleScripts. 
Though I can neither confirm 
nor deny that, I can say that in 
workgroup environments, the 
speed of a script is often not 
the most important factor. If a 
30 second script on my 
computer saves me 5 minutes of 
labor, I'm all for it! 

Microsoft's support for its wide array of scripting languages 
makes it versatile, but not necessarily easy. AppleScript's 
plain english syntax, built-in dictionaries, syntax-coloring, 
code auto-complete, code context menu, script recording, 
the Script Menu, Folder actions and Xcode to create user 
interfaces to your AppleScript applications make for an 
incredibly powerful and easy solution for even novice 
scripters. 

Scriptability, Workflow Automation: OS X: 8, XP: 5 
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Web 
Applications 

OS X: OS X comes with Apache loaded with the widely popular and open source Python, Perl, 
and PHP for web application scripting languages. Updates/patches are managed automatically 
via Apple's Software Update feature. 

XP: XP comes with with IIS and .asp. XP users can download and install open source 
environments such as Perl and PHP (though they would have to keep track of updates/patches 
manually). 

Microsoft's .Net strategy has provided Windows users with a rich array of tools from which to 
develop both desktop and web applications. Microsoft does offer ASP.NET Web Matrix for free. 
This is really a scripting aid for ASP.NET web sites, and is of little value unless you have 
purchased the .Net server package.

Scriptability, Web Applications: OS X: 7, XP: 7 

Pick a topic:  
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Burning CDs

Both OSes support burning data to any recordable optical format: CD-R, CD-RW, DVD-R, DVD-RW, DVD+RW (although 
OS X cannot burn music, photo or video to DVD-RW or +RW via any iLife app, and iDVD only supports DVD-R). Both 
OSes can burn the cross-platform compatible ISO-9660 format, though only OS X writes that format by default. As of 
9/2003, XP also supports HighMAT format, although at the time of writing this, only a handful of Panasonic players 
support HighMAT format. 

Simple 
Burning 
(Single 
session 
CD-Rs)

OS X: When you insert a blank CD-R into a CD-R drive for the first time, OS X displays a dialog asking 
how to proceed:

From the list of actions, you can select from a list of native 
apps that support burning: Finder, iTunes, Disk Copy, or you 
can select another application. You can also run a script, for 
instance if you created an automatic backup script, just 
insert the CD, and the computer will perform the backup for 
you. If you check 'Make this action the default' then the 
action you select will automatically happen every time you 
insert a blank CD, bypassing this dialog box. You can alter 
your default selection at any time from the CDs & DVDs Control Panel. You can have separated 
default actions for blank CDs and blank DVDs, as well as other types of CDs and DVDs.

Burning is integrated directly into the Finder. The CD-R icon will display in 
the sidebar and on the desktop. Just drag your files and folders onto the CD-
R icon. Then click the Burn icon in the sidebar, or select Burn... from the 
Action menu. 
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Burning is also integrated directly into iTunes and iDVD. Create MP3 or audio CDs from your 
song playlists directly in iTunes. 

XP: (The following section courtesy of Uchendu 'UnnDunn' Nwachukwu, www.unndunn.com) 

1) Insert a Blank CD: When you 
insert a blank CD, you will get a 
prompt similar to this one:

The easiest way to burn a quick CD is to 'open a writable CD folder' in Explorer. So I do that. Of 
course, you can use your preferred app - I use Nero for advanced CD jobs. Select "Always do the 
selected action" to have this action be the default. 

2) Copy the FIles: You'll be presented with the CD window where you can drag files. It is a standard 
Explorer window and behaves exactly like one. The only difference is the 'CD Writing Tasks' box on 
the left. 
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Simply drag your files into the window. They will appear as "Files ready to be written to CD", as 
shown below. 

 

3) Begin Burning: To begin burning the files, simply click "Write these files to CD" on the left. You'll 
begin the CD-writing Wizard, seen below. 
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Depending on the type of content you are burning, it will give 
you different options. For example, if you are only burning 
music files, it will ask if you want an audio CD or a data CD. If 
you pick Audio, it will send you over to Windows Media Player 
to compose the track list and burn it from there. For pictures, 
it will offer to add a slideshow viewer, which will appear 
automatically when the CD is inserted into another Windows 
machine. In most cases, though, you'll begin burning 
immediately. 

Burning is also integrated directly into Windows Media Player 
to create Audio CDs and MP3 CDs. 

So it appears that the differences between OS X and XP for burning single session CD-Rs are subtle. 

Simple Burning: OS X: 7, XP: 7 
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CD-RWs/ 
Burning 
Multiple 
Sessions 
or 
volumes

OS X: Use Disk Utility to write multi-volume data disks. You can use any media that your burner 
supports: CD-R, CD-RW, DVD-R, DVD-RW, DVD+RW. The Burn Disk 
dialog has a check box to "Leave disc appendable". 

Rewritable discs can be erased by selecting Erase from Disk 
Utility's file menu. Once erased, the Finder prompts you to name 
the newly erased disk. It will then be mounted on your desktop, 
where you can drag items into it, then click the Burn icon. 

Data cannot be appended to a session once it's been written, but 
rather additional sessions can be appended to the CD-RW. 
Because of this, each burn session will appear as a separate CD 
on your desktop. 

XP: Windows XP can handle writing multiple sessions to a CD-RW, and can erase that CD-RW for reuse 
later. Those options appear on the Explorer window, as shown below. 

 It 
also differentiates between pre-existing files, and the files you want to add. 

OS X and XP handle advanced burning differently. XP treats CD-RWs just like CD-Rs, except that you 
can keep adding files to your disk (multi-session). OS X can create multi-volume CD-Rs or DVD-Rs 
from the Disk Utility application. However, OS X cannot create multi-session discs. 

XP:

●     can't create multi-volume CD-Rs or DVD-Rs
●     appending to existing sessions is most often more sensible
●     CD-RWs behave just like VERY big floppy disks, which is very user-friendly 
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OS X: 

●     Can create multi-volume CD-Rs and DVD-Rs, allowing you to create exact copies of multiple 
CDs burned on to one CD or DVD

●     Can't create multi-session discs
●     Mandatory use of Disk Utility means interface isn't as friendly as it could be 

CD-RWs: OS X: 5, XP: 8 

Advanced 
Burning

OS X: For advanced burning options, use Disk Utility. Disk Utility supports advanced functions, like 
creating and burning Disk Images. You can 
even use Disk Utility to make images of DVDs, 
that can be then replayed directly off your 
hard drive (please respect copyright laws, 
and duplicate your DVDs for your own 
personal use only). Often disk images of 
commercial DVDs too large to fit onto a 
4.7GB DVD-R, but as long as the image is 
small enough, it could be burned on to a DVD-
R. 

Disk Utility permits multi-volume CD-Rs. Just select Leave disc appendable in the Burn dialog. 
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You can also assign custom icons to your sessions. Make your disk image, mount it, assign it a custom 
icon (see instructions in the Icons section), and eject the image. Once burned your CD will display 
your custom icon. 

To erase a CD-RW, select Erase CD/DVD-RW Disc from the File menu. 

XP: XP lacks support for creating multi-volume CD-Rs and creating disk images. Disk images are often 
critical for creating exact duplicates of volumes, for instance if you want to create a bootable CD, or 
if you want to back up any of your data CDs. XP also lacks the ability to verify the data integrity of 
burns for you. Windows Server 2003 Resource Kit Tools contains Cdburn.exe which allows you to burn 
CDs from ISO images. 

Advanced Burning: OS X: 7, XP: 1

Pick a topic:  
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OS 
Updates

Both OSes can be configured to automatically notify you of OS updates and download and install them. 
Updates may occasionally require you to restart your computer for the update to take effect. 

OS X: (Thanks to Nick Mediati for help with this section) 
To check for software updates, select Software Update... from the Apple menu. To edit 
your Software Update settings, open System Preferences then click on Software Update. 

 

If you want to check for updates immediately, click "Update Now". The software Update Application 
will launch, and display a list of updates that you can download, plus some information regarding the 
selected update. 
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Check the box(es) to the update(s) you want 
to install, then click install. Your Mac will 
download and install the software without 
bugging you again, unless you the update 
requires a restart (but you can ignore it until 
you're ready to restart). Updates easily run in 
the background so that you can continue 
working while your software or OS is being 
updated. 

You can deactivate updates so they won't pop up all the 
time—useful if, for example, you don't have an iPod and Software 
Update keeps bugging you to download the iPod update 1.2.1. If 
you don't ever want to see that update again, select the update 
and then select "Make inactive" from the Update menu. 

Admins can hide the OS X Software Update System 
Preference from users by editing their Account. Go to 
Accounts, select the user, click on Capabilities, then 
click on "Open All System Preferences". 

XP: System administrators can configure end users computers to hide the Automatic Updates Control 
Panel, so that users cannot modify the settings made by the Admin. Updates can be configured to 
automatically occur at night, so the user isn't bothered by the update. Windows XP only displays/
installs updates relevant to your specific computer. If you don't have a certain piece of hardware, 
Windows XP won't tell you about update(s) for it. 
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Both X and XP seem pretty well matched in terms of their features for providing OS udates. 

OS Updates: OS X: 8, XP: 8 

Pick a topic:  
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One critical component of netwok installs is the concept of "imaging", creating an identical copy of a fully installed 
machine that can be replicated on subsequent computers. XP lacks built-in support for creating images sufficient for 
full computer deployment. Ryan Faas wrote an excellent article on the topic for ComputerWorld (4/29/2003, 
mentions Symantec's Ghost for XP, but otherwise focuses on OS X 10.2 strategies). Mac OS X 10.3's Disk Utility can 
create and restore complete disk images, though I'm not sure if you can restore an entire disk over the network. 

Network Installs OS X: Mac OS X Server supports NetBoot and Network Install, if you have OS X Server deployed. 
See Apple's web site or check out Hands on: A close-up look at Mac OS X's NetBoot, 
ComputerWorld, 8/13/03. 

Apple Remote Desktop also supports remote installation of software.

XP: XP Pro supports network booting and network installation, if you have Windows 2000 
Server and Active Directory deployed (XP Home does not). Create OS and "image" and copy it 
to a share on a server, and set up a couple simple settings (there’s a wizard to guide you 
through this). If you’d like to further customize your image with settings or pre-installed 
software, you just get a test computer the way you want it and run the wizard from that 
computer. 

Not all PCs can boot directly from networks; it depends on the BIOS settings and network card. 
However, any PCs bought for an environment that would use network installs will almost 
certainly support it. Besides, if a computer doesn’t support it, you can boot the computer 
from a floppy created with a wizard on the server, which you only need for the first 10 
seconds right at boot-up, to get the same effect. 

Once you start your network boot, you’ll be presented with a series of 2 or 3 text-mode 
screens (similar to the first part of WinXP setup). They tell you what's going on (you’re 
installing WinXP from a network), warn you that your drive will be wiped, ask for a domain 
username and password for someone who has been given the appropriate permissions, and ask 
which OS image you’d like to install (such as “Windows 2000 – Marketing”, or “Windows XP – 
Sales Staff”). This last step is skipped if only one option is available (or permitted). 

After setup starts, you can leave for half an hour, and your computer will be ready to go, 
waiting for you to login, when you get back. At this point, the entire setup process will be 
completely finished, and your workstation will be just like any other established workstation 
on the system - no hardware left to install, no Windows Activation or registration windows, 
and no settings to confirm. One exception – if you don’t include the product key with the 
server image (which you do by adding it to a configuration file), you’ll be asked for it halfway 
through the setup process. 

XP also has Group Policy software deployment. This is a tool administrators can use for 
installing software, OS updates and service packs, scripts, and pretty much anything else 
packaged into a Windows Installer file. Software can be assigned (installed automatically) or 
published (not installed until needed, such as the first time you open a PowerPoint 
presentation), and can be applied to computers or users. 
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The end result is that when the computer boots up (if assigned to the machine) or the user 
logs on (if assigned to the user), the software will automatically be installed. The only 
indication to the end user that software is being installed is a message (along the lines of 
“Installing managed software Microsoft Office XP Professional…”) displayed in the startup 
status window after the other messages (like “Preparing network connections…”). 

This, combined with remote installation, would make it so once setup is started, you walk 
away, and when you come back, Windows is completely set up, the network is available, 
you’re joined to the domain, user profiles are available, software is ready to use, and all 
updates and patches are applied. 

Both OS X and XP support netboot and network installs. Both allow adminitrators to remotely 
install software and upgrade the OS. Only OS X ships with a utility for creating disk images of 
entire drives for later deployment (though XP users can purchase similar utilities such as 
Ghost). 

Network Installs: OS X: 7, XP Pro: 7, XP Home: 0 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
Updated all the time. 
XvsXP.com is owned and operated by Dan Pouliot. 

http://www.xvsxp.com/net-installs/ (2 of 2)1/1/2005 5:50:30 AM



X vs XP > System Tools

          
 

Home Donate/PDF 
Version 

Final 
Score 

Discuss  Categories:  

System Tools

XP Pro's System Tools makes as good an inventory of System Tools as any, so I'll use that as my list for comparing these 2 OSes.

●     Backup
●     Character Map (Covered in the Keyboard section)
●     Disk Cleanup
●     Disk Defragmenter
●     Files and Settings Transfer Wizard
●     Synchronizing data across devices
●     Scheduled Tasks (Covered in the Remote Control section)
●     System Information
●     System Restore

Formatting and Checking Disks (Disk formatting and checking isn't listed in XP's System Tools folder because it's 
located elsewhere.)

OS X: Apple's Disk Utility can scan and repair your disk, check and repair file 
permissions, and erase, partition or restore your hard disk. 

 

Disk Utility has a clean, tabbed interface and provides plenty of information about 
the given tasks, making it clear what to do and how to do it. 
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Erase disk panel 
 

Restore panel 

If you prefer the command line, you can use /sbin/fsck -y.

XP: To check your disk for errors go to: Control Panels>Computer 
Management>Disk Management. Then right-click the disk you want to check and 
select Properties. Then under the Tools tab, locate Error-checking and click Check 
Now. 

To format a disk, right-click on the drive while in Disk Management and select 
Format. Disk Manager also allows you to create partitions and RAID arrays (Not 
available in XP Home Edition).

If you prefer the command line, you can use chkdsk c: /f.
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Formatting and Checking Disks: OS X: 7, XP: 7 

Backup XP: XP offers a backup utility so you can select files to back up, and select a 
destination for the backup. You can back up to external media, you can schedule 
automatic backups, and you can restore from your backups. 

OS X: OS X lacks a backup utility. OS X users can write their own backup 
AppleScripts or Unix shell scripts. They could also use Disk Utility to create disk 
images or burn CDs, but these are all manual methods of backing up. OS X users 
that want Apple-supplied backup functionality will have to sign up for a paid .Mac 
account. In addition to backing up to your iDisk, Backup 2.0 beta (released 
9/3/03) supports backing up to firewire drives, network devices, or CDs/DVDs. 

Backup: OS X: 2, XP: 9 

Disk Cleanup XP: XP's Disk Cleanup utility is handy for eliminating old files. 

 
Disk Cleanup

OS X: OS X relies on nightly, weekly and monthly cron scripts to clean up temp 
files. Users can run manually these scripts manually from the command line by 
typing: 

sudo periodic daily
sudo periodic weekly
sudo periodic monthly
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Disk Cleanup: OS X: 5, XP: 8 

Disk Defragmenting Thanks to Nick Mediati for help w/this section! 

The first time you put data on a freshly formatted disk, all the data is laid out 
together in nice contiguous blocks. However, over time, as the disk gets used (and 
files get added and removed), files get stored in discontiguous locations, requiring 
the disk to do more work to retrieve files, slowing the overall performance of your 
computer. This can be especially important for tasks like video or audio capture, 
where the disk must keep up with a high-bandwidth data feed. 

XP: According to this Microsoft article (under Disk Efficiency Optimizations), XP 
has some automatic methods to reduce fragmentation. XP will observe file usage 
patterns, and "If deemed necessary, Windows XP will adjust the file layout at 
three day intervals" so that frequently used files are placed at the faster locations 
on the disk (those files are kept contiguous). Microsoft recommends, "Users should 
still defragment their drives regularly." That's why Windows XP comes with Disk 
Defragmenter. 

Disk Defragmenter does what the name says, it defragments files on your disk.

 
Disk Defragmenter
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 A nice feature of Disk Defragmenter is its "analyze" option. Depending on the size 
of your disk and the size and number of files, a defragment operation can 
potentially take hours to perform. Clicking the Analyze button will quickly anaylze 
your disk and tell you if defragmentation is necessary - if not, you don't have to 
waste any time defragmenting the disk when doing so won't provide any significant 
performance gains anyway.

I defragmented my hard drive, and once it was done, Disk Defragmenter notified 
me that it was unable to defragment some files, giving me the option of seeing 
those files in a report. So I clicked for the report (below), but there were no left-
to-right scrollbars to help me see what files were fragmented. A helpful reader 
pointed out that columns need to be expanded first, then scrollbars will appear. 
How does one expand columns? Double-click the column dividers next to the 
column labels. 

 
Defrag Report

XP also has a command line defrag tool.

How fragmented is your drive right now?
So just how fragmented are OS X drives and XP drives in reality? One member 
on this site's forum came up with a nice way to get some real world data. 

OS X users: Download hfs-debug and type this at the command line: 

cd ~/Desktop
chmod 755 hfsdebug-1.12
sudo /Users/<user name>/Desktop/hfsdebug-1.12 -f -t 5
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the last 2 lines will give you the amount and percentage of unfragmented files 
on your system. 

XP Users: 

●     Control Panel->Administrative Tools->Computer Management
●     Click on Storage->Disk Defragmenter
●     Click Analyze
●     Click View Report when analyze is complete

The results posted to this site's forum showed no OS X user had greater than 
3% file fragmentation. XP's Disk Defragmenter typically reported somewhere 
between 20-40% fragmentation, however these numbers are suspect, since 
when comparing the ratio of total files to fragmented files, a percentage 
closer to 3-5% may be seen. This suggests that Disk Defragmenter's numbers 
are reporting something else, possibly the ratio of total files to total 
fragments. 

OS X: OS X has no defrag application, however, OS X has implemented five 
methods of dealing with fragmentation and IO performance. Allow me to 
paraphrase Apple's own Technical Document on this matter: About Disk 
Optimization. 

1.  Automatic file defragmentation works when you open a file in OS X. If the 
is under 20MB and fragmented, OS X will move it to a contiguous block of 
space on your hard disk. 

2.  Delayed allocation (for HFS+ volumes) allows a number of small allocations 
to be combined into a single large allocation in one area of the disk.

3.  Hot-File-Adaptive-Clustering tracks frequently used files and moves them 
to faster portions of your hard disk. 

4.  Aggressive read-ahead and write-behind caching reduces the impact 
associated with minor fragmentation

5.  HFS+ avoids reusing space from deleted files as much as possible, to 
avoid prematurely filling small areas of recently-freed space, thereby 
reducing the risk of fragmentation.

I thought fragmentation was still an issue in OS X due to getting this error: 

 
This was on a PowerBook G4, with a 10GB drive (4200 RPMs), running iMovie 3.0.3. 
I repeatedly got this error after between 5 and 30 seconds of digitizing audio. To 
get to the bottom of this, I decided to defragment. I disabled journalling, booted 
off an old Norton Utilities CD, and defragmented my drive. Upon booting back into 
OS X and trying again, I got the same results, with that error message occurring 
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between 5 and 30 seconds in to digitizing audio. This error occurred whether or 
not the drive was fragmented, thus ruling out fragmentation as the culprit. 

OS X's on-the-fly defragmentation of files smaller than 20MB is a welcome addition 
to the Mac. XP has no such ability, so users must instead manually run their Defrag 
application whenever they want to defrag their files. While Microsoft actively 
recommends regularly running Disk Defragmenter, Apple's stance w/regards to 
fragmenting is: "there is little benefit to defragmenting" in OS X (from their Tech 
Doc), but they stop short of saying that there is no benefit.

I have yet to find a scenario in which OS X suffers from the lack of a 
defragmenting application. For readers who are unconvinced that XP actually 
needs to be manually defragmented I offer some quotes directly from Microsoft.
com (emphasis in bold mine): 

Restore Your Computer's Performance with Windows XP 

"after defragmenting the hard drive on my desktop computer, 
Windows and other programs started about 20% faster!"

How to Troubleshoot Setup Problems in Microsoft Games 

"When a program is installed on your computer, the program's files 
may be stored in multiple, noncontiguous locations on your hard 
disk. This is fragmentation. If your hard disk is fragmented, 
programs on your computer may run slowly." 

Windows XP Performance 

"I/O performance is strongly influenced by the layout of files on 
disk. Files and directories that are heavily fragmented or dispersed 
across the disk will hurt performance. While Windows XP will 
automatically reposition some files to improve performance, this 
will generally be done infrequently and will usually include only 
a small fraction of the files on the disk. Therefore, it is a good 
idea to defragment the disk following an installation. 

Once every three days, by default, Windows XP will perform a 
partial defragmentation and adjust the layout of the disk based 
upon current use. The files to be moved are written in the file 
Layout.ini (found in the Prefetch directory under the System Root 
directory)." 

OS X: 

●     Hot-File-Adaptive-Clustering places frequently used files on the faster 
portion of a hard disk

●     Automatic file defragmentation defragments files under 20 MB as the are 
opened

●     Delayed allocation allows a number of small allocations to be combined 
into a single large allocation in one area of the disk.

●     Aggressive read-ahead and write-behind caching reduces the impact 
associated with minor fragmentation

●     HFS+ avoids reusing space from deleted files as much as possible, to avoid 
prematurely filling small areas of recently-freed space, thereby reducing 
the risk of fragmentation. 

●     No manual tool to report on % fragmentation, or to move files to one 
contiguous block, thereby making free space exist in one large contiguous 
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block

XP: 

●     Every three days XP places frequently used files on the faster portion of a 
hard disk (those files are kept contiguous)

●     Automatic scheduling of defrag on one or multiple drives based on 
whatever pattern or schedule (frequency) you want 

●     Defrags all files, even those over 20mb 
●     Provides analysis tools to view fragmentation levels 
●     Microsoft still recommends "Users should still defragment their drives 

regularly."
●     Sometimes after a defrag, the tool still reports fragmentation. 
●     Defragging will not succeed if disk is almost full. 

Further reading on Macintouch about Panther's disk optimization methods. 

Disk Defragmenting: OS X: 9, XP: 5 

Transferring Files and Settings XP: Files and Settings Transfer Wizard is intended to help you move files and 
settings from your old computer to your new computer. As such, you'll only ever 
use it once during the life of your computer. That said, it's still a nice tool to aid 
in the computer upgrade process. You can transfer your files and settings over any 
network connection (Ethernet, WiFi, USB, Firewire). 

OS X: OS X has no such tool to aid in the transfer of files and settings from an old 
computer to a new computer. However several readers have pointed out that 
copying your files is a trivial matter, since your entire computer identity 
(application preferences) and all of your files are located in one location: your 
Home directory. So all OS X users need to do is copy one directory. Done. (This is 
not possible in XP because certain application settings are stored elsewhere.) 
Furthermore, OS X supports Firewire Target Disk mode: Connect 2 computers 
directly via firewire, one turned on, one turned off. Turn on the second computer 
and hold down -T. A bouncing firewire symbols comes up on the computer that 
just started up. On the other computer, the hard drive icon with a firewire symbol 
mounts on the desktop. Drag your home directory from one computer to the other 
and you're done. All that w/out a Wizard! Starting in June of 2004, all new Macs 
ship with a Setup Assistant that help you to transfer user accounts, system 
preferences, documents and applications from another Mac. The other Mac must 
have built-in Firewire. 

So it seems that XP's Files and Settings Transfer Wizard is necessary because XP 
doesn't keep user files in one sole location. That said, it makes transferring files 
for even a novice relatively easy. OS X's OS elegance eliminates the need for such 
a wizard, but novice users would need to ask around to learn how to do this fairly 
simple task. To be fair, I'll give this one to XP. 

Transferring Files and Settings: OS X: 4, XP: 8 
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Synchronizing data across 
devices 

 

XP and OS X have taken different approaches to data synchronization. OS X has 
created a method to allow users to synchronize their Address Book, Calendar and 
Bookmarks across mobile devices (and other personal computers if you have a 
paid .Mac account). XP (Pro) has created a method to synchronize files and folders 
between your computer and a network server, so that you can easily bring work 
home and synchronize it when you get back to work. 

OS X: iSync enables you to synchronize personal data—Address Book and Calendar 
entries— across all your handheld devices (Palm PDAs, iPod and bluetooth enabled 
Mobile phones). You can even sync Contact photos to supported mobile phones! 
With a .Mac account you can sync Address Book, iCal, and Safari Bookmarks across 
all your Macs too. 

XP: XP uses Offline files and folders to keep files synchronized between your 
computer and files on a network server. XP uses Briefcase as a method to 
synchronize files between two computers (assuming you are either using a floppy 
disk or direct connection to transfer the files back and forth. Microsoft supplies 
ActiveSynch as a separate downlod for users wishing to synchronize e-mail, 
calendars, contacts, tasks and notes to Windows Mobile-based Pocket PCs and 
Smartphones. 

XP can synch in more scenarios (computer to server [XP Pro only], computer to 
computer, computer to floppy, computer to PDA. 

Synchronizing data across devices: OS X: 4, XP Pro: 7, XP Home: 6

System Information Both OSes have divided system information into general information (hardware 
details, installed software, etc.) vs. current details (CPU usage, disk activity, etc). 
OS X further divides networking details into its own utility, aptly named Network 
Utility. 

System Information for XP and Apple System Profiler for OS X both display details 
of your computer's current hardware and software. 

Task Manager for XP and Activity Monitor for OS X both display a list of currently 
running applications and system processes. Both allow the user to force quit any 
process, which is useful when an application misbehaves and can't be shut down 
normally. Both applications allow you to view CPU usage details and network 
usage statistics. 

XP: 
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Windows Task Manager 

Select different from over 20 different data 
columns in Task Manager. 
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Click the Performance tab to view 
graphs of CPU Usage History and 
Page File Usage History. 

 
Use Performance to view more performance details 

XP has a a couple of network diagnostic tools (ping, tracert), but they are only 
available via the command line. 

OS X: Activity Monitor displays both how much 
real memory and virtual memory every 
application and system process is using (so 
does Windows Task Manager, but in Windows 
Task Manager the virtual memory column is 
not displayed by default). Activity Monitor also 
displays application icons next to the process 
of that application, making it easy to identify 
applications' processes at a glance. 

Activity Monitor allows you to segment the different types 
of processes (above), and even view processes 
hierarchically (right), to better understand what a process 
pertains to. 
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Hung processes are colored red. Very handy. (Forget 
snide remarks about Help Viewer hanging, this shot 
was taken on a beta build of Panther.) 

 
Activity Monitor 

Activity Monitor's Dock icon can display 5 different real-time graphs. 

●     CPU Usage
●     CPU History 
●     Disk Activity
●     Network Usage
●     Memory Usage

 
Network Utility 
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Network Utility provides a variety of network diagnostic tools, however not all 
diagnostic options are available from the interface. Extra diagnostic features must 
be accessed from the command line. 

While it's clear that OS X displays system information in a more user friendly way, 
it remains unclear which OS provides more system information. One reader claims 
that XP monitors about 773 items, though I haven't seen the full list. Suffice to 
say, until the "which OS monitors more useful stuff" question is answered, I don't 
feel comfortable giving either OS a winning score. 

System Information: OS X: 8, XP: 8 

System Restore 
 

XP: XP's System Restore can create 'restore points' that you can later revert to a 
previous restore point after 'messing up' your computer. Restore points don't 
effect personal data, only system configurations. Also, NTFS (the default file 
system for XP) has built in support for journaling (for fault resistance). 

OS X: Use Apple Restore CD to revert to the factory installed OS that your 
computer came with or Backup to retrieve lost data. Disk Utility can be used to 
create disk images of your current system, and you can restore your drive to that 
disk image (this restores the entire contents of the drive, including personal files 
and applications). While OS X doesn't offer the ability to create arbitrary "restore 
points" it does offer journaling for fault resistance. 

Rollback in OS X? One readers experience:
" You noted that OS X does not have a "roll back" feature. However, it does 
have a close approximation - the Archive and Install function on the OS X 
Install CDs. 

"I don't know if you ever had the unfortunate need to use this feature, so I will 
take the liberty of describing it for you. I had need to use it after I 
encountered persistent printing glitches that it seemed that no amount of 
tweaking would fix. As a last resort, I decided to reinstall the operating 
system and start from scratch. By booting from the OS X install CDs (not the 
Software Restore Disks), selecting "Archive and Install," and selecting 
"Preserve Users and Settings" (this may not be the exact dialog wording), I was 
able to do this in about 30 minutes. The installer replaces your /System and /
Library folders, among others, and files the old copies of those folders into "/
Previous System". At the same time, the installer recreates the users and 
maintains the copies of your Home directory, including preference files. The 
net result was that 30 minutes after starting the reinstall, I rebooted and 
logged back in using my old user name and password, with all of my settings 
(and many of my modifications to the system - extra preference panes in ~/
Library, for example) intact. The installer preserved any modification that 
wasn't made at the OS level - down to my customization of the Finder toolbars 
and my exact configuration of the Dock. Even the UNIX packages I had 
installed through Fink were preserved. Furthermore, the few system level 
extensions I had installed could either be copied out of the "/Previous System" 
folder or freshly reinstalled. 

"Now, this does not seem to be exactly the same as XP's "System Restore" 
feature. Before reinstalling, I had 10.2.3 installed, afterwards, I had 10.2. 
However, since the need to reinstall a system may have been introduced by a 
minor system update, this seems like a reasonable solution. In my case, it was 
a quick run of Software Update to go to 10.2.3, followed by a few quick 
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installs of some system-level haxies. All in all, it took me 1.5 - 2 hours to 
exactly restore the system to its previous state (minus print glitches), during 
most of which I did nothing but waited on the installer and my network 
connection. I would say that this is a fairly painless procedure, considering 
that it involves swapping out the entire core of the operating system." 

Regards,
Z.H. 

Z.H's experience with the System Restore CD is impressive. OS X lacks incremental 
rollback, but Z's story illustrates that such granularity may not be that important. 
That said, however effective X's method may be, I'll still give this one to XP. 

System Restore: OS X: 5, XP: 9 

Pick a topic:  

© 2003, XvsXP.com. All rights reserved. 
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User Accounts, 
Overview

Both OS X and XP are multi-user OSes. This means that each user can have their own login, 
their own desktop and their own privileges as to what they can and cannot do. 

Both OSes allow the option automatic login (for security reasons, automatic login is 
disabled when on an Active Directory domain in XP Pro), and Fast User Switching. They can 
display a list of users, or require entry of name and password in a dialog box, for greater 
security. 

OS X and XP both allow users to 
define items that will 
automatically launch at startup. 
OS X users set startup items within 
the Startup Items tab of their user 
account. In XP, a "Startup" folder 
seems haphazardly located within 
All Programs under the Start 
menu. Users not familiar with how 
to create a shortcut may have 
difficulty understanding how to 
add an item to the Startup folder. 
OS X allows you to additionally 
specify if a startup item should 
automatically be hidden. In OS X 
you can also drag items to specify 
the startup order. 

User Accounts, 
Account Types

Not to be confused with user groups, each OS supports a variety of account types. Account 
types are intended to give each user only as much privilege on the system as he or she 
requires, and nothing more. 

Both OSes support the concept of remote Home directories— Home directories that reside 
on a server. However, XP has a more limited scope as to what belongs in a user's Home 
directory, yeilding a less customizable experience for each user. A greater array of items 
that can reside in a Home folder means that: 

●     Items can be accessed from any computer in a networked Home directory 
environment.

●     Items are "per account". One user's items will not be visible to another user, 
thereby allowing an experience more highly tailored to each user's needs.
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The following table outlines what each OS allows to be customizable on a per-user basis: 

 OS X XP Comments

Applications yes no  

Application settings yes some  

Accessory settings yes yes Calculator, Clock, etc.

ColorSync profiles yes no  

Codecs yes no  

Contextual menu plugins yes no  

Control Panels yes no  

Control Panel settings yes yes  

Cookies yes yes  

Desktop yes yes  

Documents yes yes  

Favorites/Bookmarks yes yes  

Finder/Explorer settings yes yes  

Fonts yes no  

Localization yes no* * Owners of Windows XP Multilingual User 
Interface Pack (MUI) for XP Pro (not Home) 
can set localizations per user. MUI is available 
through Volume Licensing channels only. It is 
not available through retail channels.

Taskbar/Dock settings yes yes  

Network Shortcuts yes yes  

Printer Settings/Shortcuts yes yes XP only allows one default printer setting per 
printer (per user), while OS X allows 
unlimited printer presets per user

Recently used item shortcuts yes yes  

OS X: OS X has five types of user accounts: 

Root— This is the most powerful account. Root can do anything and everything to the 
system. This account is disabled by default and is enabled differently than every other 
account type. 

Use NetInfo Manager to enable the root account. Few users ever need to enable the root 
account, and it should only be enabled by people that understand the implications of root 
access. 

Admin— An Admin: 

●     Can create and delete user accounts on the computer
●     Can change other users' accounts long display names, pictures, passwords, and 

account types
●     Can enforce limits on other users
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●     Can not change logged on users account information without a password
●     Classic enviroment can be set-up to save settings only to home directory

To create an Admin account, select "Allow user to administer this computer" under the 
Security tab within the Accounts preference pane. 

Standard— These are meant for accounts for individuals who need full access to the Finder 
and programs but you don't want to give them the ability to modify other users accounts or 
system-wide settings. A Standard user: 

●     Cannot change his or her account type.
●     Can access all programs that are in the Applications folder (at root).
●     Cannot install software that requires an administator password (unless they are 

given an admin's username and password to use, generally a bad practice). 
●     Can install software that does not require a password to install (drag-installation).
●     Can change his or her account picture and can also create, change, or delete his or 

her password. 

Standard accounts are created by default. To change a more limited account to a Standard 
account, select "No Limits" under the Limitations tab within the Accounts preference pane. 

Assigning limits to a Managed user

Managed— In addition to the 
restrictions of the Standard 
account type, this user is 
further restricted. A Managed 
user: 

●     Can not install software
●     Can only access 

programs that are 
specifically assigned

●     Can change his or her 
account picture

●     Can change his or her 
password

●     Optional limited access 
to system configuration

To create a Managed account, 
select "Some Limits" under the 
Limitations tab within the 
Accounts preference pane. 

Simplified— This user account is designed for individuals with special needs or young 
children. In addition to the restrictions of the Managed account type, a Simplified user: 

●     Can only directly access programs that are specifically assigned (however if the 
user double clicks on a associated file type the default program for that type will 
open. For instance, clicking on a web link in a game will launch Safari, even if the 
account lacks access to Safari). Because this method of restricting application is 
not foolproof, workarounds can be made by moderately savvy users to access 
restricted applications. It should not be used where application restriction is 
critical. 

●     Can not change his or her account picture
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Simplified users get a "Simple Finder"

●     Can not change his or 
her password

●     No access to system 
configuration

●     Admin password required 
to access the full Finder

To create a Managed account, 
select "Simple Finder" under the 
Limitations tab within the 
Accounts preference pane. 

OS X doesn't have an equivilent 
to XP's Guest Account. 

XP Pro: Windows XP Pro has 
several types of user accounts: 

The following accounts are 
available for all XP Pro 
machines 

●     Administrators— Administrators have complete and unrestricted access to the 
computer/domain

●     Backup Operators— Backup Operators can override security restrictions for the 
sole purpose of backing up or restoring files

●     Guests— Guests have the same access as members of the Users group by default, 
except for the Guest account which is further restricted

●     Network Configuration Operators— Members in this group can have some 
administrative privileges to manage configuration of networking features

●     Power Users— Power Users possess most administrative powers with some 
restrictions. Thus, Power Users can run legacy applications in addition to certified 
applications

●     Remote Desktop Users— Members in this group are granted the right to logon 
remotely

●     Replicator— Supports file replication in a domain
●     Users— Users are prevented from making accidental or intentional system-wide 

changes. Thus, Users can run certified applications, but not most legacy 
applications

●     Debugger Users— Debugger users can debug processes on this machine, both 
locally and remotely

●     HelpServicesGroup— Group for the Help and Support Center

If your XP Pro machine is on an Active Directory domain, these additional accounts will 
be available 

●     Account Operators— Proxy for account on domain controller
●     Domain Administrators— Proxy for account on domain controller
●     Pre-Windows 2000 Access— Proxy for account on domain controller
●     Print Operators— Proxy for account on domain controller

Guest login is off by default in XP Pro. 

XP Home: Windows XP Home has three types of user accounts: 
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Admin— An Admin: 

●     Can create and delete user accounts on the computer. 
●     Can change other users' account names, pictures, passwords, and account types. 

Because of the way that legacy (pre-XP) programs work, it is often necessary to be an 
administrator to make them function correctly. 

Assigning an account type

Limited— Microsoft prefers that 
the general home user be a 
Limited account. A Limited user: 

●     Generally cannot install 
software or hardware, 
but can access programs 
that have already been 
installed on the 
computer. 

●     Can change his or her 
account picture and can 
also create, change, or 
delete his or her 
password. 

●     Cannot change his or her account name or account type. 

Using a limited account might help prevent computer viruses from damaging your 
computer. However, some programs (that weren't originally designed for XP) might not 
work properly for users with limited accounts. 

Guest— This is intended for use by someone who has no user account on the computer. 
There is no password for the guest account, so the user can log on quickly to check e-mail, 
browse the Internet, or use installed programs. A Guest: 

●     Cannot install software or hardware, but can access applications that have already 
been installed on the computer. 

HelpServicesGroup— Group for the Help and Support Center 

Guest login is off by default in XP Home. When you boot into Safe Mode, an admin account 
that does not require a password is available (and is prominently displayed). 

OS X: 

●     Applications can be restricted per application/per user (this feature can be 
circumvented by accident or intentionally by moderately savvy users)

●     Option to create a disk image of Home Folder for deleted accounts
●     More types of data are user specific (fonts, plugins, control panels)
●     Each user can select their own localization (French, Japanese, English, etc)
●     A Guest account must be create by the Admin (if so desired)

XP Pro: 
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●     No easy way to limit access to programs
●     Fewer types of data are user specific (fonts, plugins, control panels)
●     Does not keep Bookmarks, Emails & Settings for deleted users By Default (Transfer 

wizard worth noting in text of article)
●     Each user must have the same localization with a retail copy of XP Pro (*Owners of 

Owners of Multilingual User Interface [MUI] can have separate localizations per 
user. MUI isÊ available through OEM PC purchases, MS Partners, and Volume 
Licensing agreements; not through retail channels.)

●     Guest Account can be activated for allowing infrequent use by nonusers

XP Home: 

●     Fewer types of user accounts limit access options
●     No easy way to limit access to programs
●     Fewer types of data are user specific (fonts, plugins, control panels)
●     Does not keep Bookmarks, Emails & Settings for deleted users By Default (Transfer 

wizard worth noting in text of article)
●     Each user must have the same localization with a retail copy of XP Home
●     Guest Account can be activated for allowing infrequent use by nonusers

User Accounts, Account Types: OS X: 8, XP Pro: 6, XP Home: 4 

File Permissions, 
Assigning

This section in incomplete

Both OSes allow you to inspect and modify (if you have sufficient privileges) the 
permissions on a file (choose Get Info in OS X or Properties in XP). 
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OS X: Files and folders have 3 types/
levels of users that each have their own 
permissions set for each file/folder: 

●     Owner
●     Group
●     Others

Most OS X users will not touch the Group 
permissions, instead focusing on Owner 
and Others. Each group is assigned one 
of three levels of access: 

●     Read and Write
●     Read Only
●     No Access

Get Info on a file or folder (seen here at 
right) and set the permissions for each 
user type. If you have sufficient 
permissions, you can also change the 
owner of a file. 

Permissions can be applied to all of the 
contents of a folder by clicking "Apply to 
enclosed items..." (not shown here). 

Select multiple items and the Get Info 
window allows you to assign permissions 
to the selected items. Option-Command-
I brings up the File Inspector. It differs 
from Get Info in that it always pertains 
to the currently selected files/folders, 
even as your selection changes. 
Permissions can also be set via the 
command line by using the unix chmod 
command. 
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XP: A file's permissions are located in the Security 
tab of its properties window. Notice that this dialog 
allows me to counterintuitively check both Allow and 
Deny for Read permissions. Click the Advanced buton 
for additional permissions controls. 

 

If the item you selected is a folder, you'll see an additional item: "Replace permission 
entries on all child objects with entries show here that apply to chile objects", which is 
Microsoft's way of saying "Apply to enclosed items". 

Select an item and click Edit... to edit those specific permissions. 
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Here's the "Effective Permissions" 
tab of Advanced Security Settings. 

Personally I find XP's permissions baffling. Other users may disagree, claiming that XP's 
permissions give you greater granularity of control though I have yet to find an instance 
when OS X's permissions weren't granular enough. I'm not sure if XP has a method to set 
the permissions on multiple files other than the contents of a folder all at once. 

File Permissions, Assigning: OS X: ?, XP: ? 

Pick a topic:  
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Username & Password Management

Both OSes can be set to "autofill" username and password form fields in web sites that have not intentionally 
disabled autofill. 

OS X: From Apple's site: 

"The Keychain stores all your information to log onto file servers, ftp servers and Web 
servers and to use encrypted disk images. Mac OS X automatically adds your .Mac 
account information to your Keychain. When you log in to Mac OS X, the system opens 
your Keychain. You don't have to enter your user name and passwords to access this 
data. You can set Mac OS X to lock your Keychain when the system sleeps or is inactive 
for a time. The system will ask you for your password the next time you try to access 
secure data. Other users on the system cannot access your Keychain or its data."

. 
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Any application can use Keychain to store its passwords. 

In Keychain, select Edit> Change password 
for, then click the (i) on the dialog that pops up, 
to view the Password Assistant which gives you tips 
on your password's strength: 
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Additionally, Safari can be set to autofill user 
names and passwords in Web Forms. 

Once enabled, the next time you submit a login 
form on a web site you'll be asked if you want 
Safari to save the password. 

Additionally, users can remove individual site logins, or remove them all. Safari also contains a Reset Safari 
command that clears all usernames and passwords (as well as history and caches). 

XP: Windows XP manages passwords for connecting to network resources (SMB shares, FTP/WebDAV sites and 
network connections such as RAS, Wi-Fi and PPPoE) and .Net sites on the Web. XP contains no centralized utility for 
managing (retrieving or deleting) usernames and passwords. Usernames and passwords are handled by their 
respective apps. 

Turn on Internet Explorer's autofill feature to 
autofill username and password form fields. 
Standard web browser authentication dialogs 
contain a "remember this password" 
checkbox. Users can delete autofill history 
under Internet Options > Content > 
Auto Complete (under Personal 
Information). 

Individual username/password autofill pairs can be deleted: 

1.  Visit the web page that uses that username/password
2.  Click on the username text input box 
3.  Hover over an autofill keyword to select it
4.  Hit delete

OS X: 

●     Centralized username and password management

XP: 

●     No centralized username and password management
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Username & Password Management: OS X: 8, XP: 3

Pick a topic:  
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Bluetooth

Bluetooth HUGE thanks to mflinn. This section is almost completely done by him. Also, thanks to uvarov for XP screen 
shots. 

To quote Apple's Bluetooth page: "Bluetooth® technology is a cutting-edge open specification that enables 
short-range wireless connections between desktop and notebook computers, handhelds, personal digital 
assistants, mobile phones, camera phones, printers, digital cameras, headsets, keyboards and even a 
computer mouse." 

Initial Set-Up

Refer to set-up screen shots at the bottom of this page.

OS X: OS X allows you to plug in a Bluetooth adapter (if you don't have built-in Bluetooth) then pair a 
Bluetooth device with it. Pairing is accomplished using a wizard, or by simply clicking "Pair new device" on 
the devices tab in the Bluetooth preference pane. It is also an option in the Bluetooth menu. 

OS X auto-senses computer name and computer type. However you can't force it to be a Laptop or Desktop. 

OS X's Bluetooth preference pane only appears when a Bluetooth adapter is connected. You have the option 
of adding a Bluetooth menu item. 

XP: Once a Bluetooth adapter is installed, XP adds a Bluetooth icon to the Notification Area. 

- Pairing isn't required for a device to work; if you don't pair a device, you have to discover it each time you 
use it. 

Windows XP's Bluetooth Wizard allows you to create a separate name for your computer, which may confuse 
novice users. However, XP will use the computer's name by default. The wizard also lets you select whether 
the computer is a laptop or a desktop by default it selects what your computer inherently is. This selection 
only changes the icon that is displayed on remote devices, not how it acts. For example the icon shown on a 
cell phone when you connect to the computer will be that of a laptop or desktop. 

Windows XP's Bluetooth control panel isn't easy to locate if using categorized Control Panel view. XP adds the 
options to put Bluetooth controls in the Desktop, System Tray, Start Menu, My Computer. 

Supported Profiles
Send And Receive Profiles Supported 

●     PIM Item Transfer 
●     File Transfer 
●     Network Access
●     Dial-UP Networking 
●     Bluetooth Serial Port 
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●     Fax 

Receive Only Profiles Supported 

●     Audio Gateway* 
●     Headset* 

*Windows XP Tablet Edition supports headsets and audio gateways as server (Send) services available to other 
computers. Both home and Pro editions of Windows XP supports client request (receive) from these profiles. 

Hardware Configuration

Hardware can be configured from normal locations in Both OS X & Windows XP. 

Bluetooth Keyboards:
-Are added to the Keyboard and Mouse preference pane of OS X
Microsoft's Wireless Keyboard isn't officially supported in OS X (however it works) 
-Are added to the Keyboards control panel in Windows XP
Apple's Wireless Keyboard isn't supported in XP (however it may or may not work)

Bluetooth Mice:
-Are added to Keyboard and Mouse preference pane of OS X
Microsoft's Wireless Mouse isn't officially supported in OS X (however it works)
-Are added to Mouse control panel in Windows XP
Apple's Wireless Mouse isn't supported in XP (however it might work)

Bluetooth headsets (Both input and output if supported by device):
-Are added to Sound preference pane in OS X
-Are added to Sound & Audio in Windows XP

On OS X, you get a new network port when you plug in a Bluetooth cell phone or access point that you can 
configure in Network Preferences. 

On Windows XP, Bluetooth Network Adapter is added to My Network Places for configuration of network 
settings if the proper services are enabled from the Bluetooth Control Panel. 

On OS X, you can configure printing from the standard OS X Print Center–You scan for Bluetooth devices right 
from the Print dialog. 

On Windows XP you can print to Bluetooth printers by setting them up the normal Windows XP way. On 
Windows XP you can configure Printing from “Printers and Faxes” in the control panels folder. There is a link 
to this in the task pane of My Bluetooth Places. 

Faxes can be configured from either the OS X Fax panel or from the Print/Fax dialog. On Windows XP you can 
configure Faxing from “Printers and Faxes” in the control panels folder. There is a link to this in the task 
pane of My Bluetooth Places. 

Windows XP goes a little bit further by adding a special Place for Bluetooth devices to "mount" called "My 
Bluetooth Places." 

Windows XP allows users to configure services for devices you don't currently have. This can be confusing to 
the novice users, but shouldn't be an issue for power users. It also allows you to control what sort of devices 
that can be connected to the computer (a great security feature). 

OS X only allows you to configure what a specific device you currently use can do, not what devices you may 
or may not get in the future can do, thus causing less user confusion. 
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Both OS X and Windows XP can be set to Discoverable, Require Encryption, and Require Authentication. 
Windows XP can be set to automatically check for new devices at specified intervals. This has its ups and it's 
downs, but is an added configuration option worth noting. 

Supported Devices

Both OS X and XP support most common Bluetooth devices: 

Device OS X XP

Cell Phones (Fax Service, Dial-
UP, Network Access)

yes Support for non-conforming phones 
(First Generation Phones) is limited on 
Windows XP and may vary from 
manufacturer to manufacturer. This is 
generally a non-issue since modern 
phones won't have this issue (unless you 
are overseas where this is more 
common).

Printers yes yes

Cameras Apple's iPhoto 4 doesn't officially 
support cameras connections 
through Bluetooth

yes

Scanners Apple's iPhoto 4 doesn't officially 
support scanners connections 
through Bluetooth

yes

Computers/Laptops yes yes

Keyboards & Mice yes yes

PDAs (SYNC, PIM Transfer, Dial-
Up Etc)

yes yes

Pocket PC No Apple's iSync requires 
software from Markspace to get 
Pocket PC Sync via Bluetooth (it 
also support sync via 802.11, & 
USB)

Supports transfering files to and from 
Pocket PCs Dial-Up Connections, and 
Network Access, limited PIM Transfer 
via IrMC are built in. However it works 
best with Active Sync. Email sync and 
advanced functions provided by 
ActiveSync are avilable via bluetooth 
however users may experience Errors 
while doing so.

Palm OS Neither OS X nor Windows XP allow out of the box support for Palm OS, 
however this is easily remedied by visiting Palmone.com

Sending Files

Windows XP: This can be accomplished via the File Transfer Agent in My Bluetooth Places. Alternatively, you 
can right-click the file(s) and choose 'Send to'>'Bluetooth'>specific device. 

OS X: This can be accomplished by selecting "Send File to Bluetooth Device..." from the Services Menu. You 
can also "Send This Card" in Address Book. Entries added in /dev/ extends Bluetooth support to legacy Unix 
applications. 

Cell Phones

OS X: Individual Bluetooth devices supported by iSync get individual icons allowing for easy configuration. 
This results in one application capable of managing many phones. 
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XP: Syncing on Windows XP generally requires that you download a separate program for each phone. You can 
set Windows XP up to sync phones, but Pocket PC phones (which require Active Sync) work the most 
consistently (see your individual phone manufactures for details on support). To do this you have to right 
click on the cell phone in My Bluetooth Places and select “Start IrMC Synchronization” this by all accounts is 
buggy: Difficulties in Syncing Phones in Windows XP. Note: this article is from Feb 2003, these issues will 
probably be fixed with SP2 if they aren't already fixed with a hotfix. 

Cell Phone Features 

OS X: 

●     Send SMS Messages to your contacts directly from Address Book or iChat.
●     Address Book adds Phone Dialing and Fax Dialing directly from contacts.
●     When you receive a phone call, a dialog appears showing the phone number (and the name of the user 

if it's in your Address Book) and allows you add unknown callers to Address Book, reply with SMS, send 
it to Voice Mail or answer the call on your phone. 

 
Bluetooth calls are looked up in Address Book to acheive a "Caller ID" effect 

●     You can log missed calls, and to reply via SMS.
●     SMS Message Transcripts can be attached to the "Note" portion of the Contact.
●     Synchronize your Address Book with your Bluetooth phone
●     Use phone as remote control for computer (New in 10.3.5) 

❍     Third-party apps allow still greater control of your Macintosh computer from a mobile phone or 
handheld computer: 

■     Romeo (freeware)
■     Salling Clicker (shareware), has some neat (and unique!) features like proximity screen 

locking with your Bluetooth device

XP: SMS Sending on Windows XP requires the free SMS Sender, however this doesn't allow receiving of SMS 
Message (you'll have to pick up the phone to read them). *(MSN Messenger allows you to send and receive SMS 
messages just not through Bluetooth) 

OS X 

●     Support for older Bluetooth Cell Phones
●     SMS Send and Receive from Address Book
●     Telephone Services - Send call to Voice Mail, Log Call, SMS Reply
●     iSync works with lots of Bluetooth phones
●     Remote control your computer from Bluetooth phones
●     No option to limit devices that can be attached to your computer.
●     No option to configure services for devices that you may get later.

Windows XP 

●     Option to Limit the devices that can be attached to computer
●     Configuration of Bluetooth Services for devices you don't have, but might get
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●     Intially you have to wait up to 5 minutes for services to install before you can configure 
●     No "one stop" syncing program for all your BT devices, although the services in Bluetooth Places allow 

you to sync
❍     To sync a cell phone you must either right click and select “Start IrMC Synchronization” from 

the phone in My Bluetooth Places or use the provided software with the phone. The latter is 
the recommended method by most phone manufactures due to IrMC Sync being buggy by most 
older accounts.

●     To SMS from bluetooth enabled phones you have to download Extra software, Third party software 
needed for receiving SMS messages with this same Phone Number on the computer. *(You can use MSN 
messenger to achieve some of the functionallity)

●     No built-in cellular telephone solutions for Caller ID, Answering the phone, sending to Voice Mail or 
Replying with SMS messages from the computer. 

●     No built-in remote control of your computer from your cell phone 

Bluetooth: OS X: 8, XP: 7 

Some Screen Shots:

 
Bluetooth Setup Assistant
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When you attach a bluetooth adapter to your Mac, a Bluetooth preference pane will appear
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Bluetooth preference pane, Settings Tab
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Bluetooth preference pane, File Exchange Tab
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Bluetooth preference pane, Devices Tab
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Click Pair With Device from the Devices Tab to locate nearby devices 
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The Show only menu allows you to filter which device you'd like to display 
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Bluetooth Serial Utility

 
Bluetooth Menu

 
Bluetooth File Exchange Preferences 
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Select Send File... from the Bluetooth menu and then browse to the file you want to send 

 
Select Browse device from the Bluetooth Menu or use File Exchange to browse a device 

http://www.xvsxp.com/bluetooth/ (13 of 25)1/1/2005 5:51:00 AM



X vs. XP > Bluetooth

 
Select the Network preference pane and a new bluetooth port will automatically be detected 
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Bluetooth Network Settings 

More Bluetooth Pictures: 

Set-Up Assistant: 

●     Set-Up
●     Searching_For_Phones
●     Passkey
●     Oops_forgot_to_unpair_with_my_old_Computer
●     Worked
●     Phone_Settings (includes new 10.3.5 feature: Use phone as remote control for computer) 
●     Account_Info
●     Done

Address Book: 

●     Addressbook_Bluetooth_Phone_Number_Options_Menu
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●     Bluetooth in Addressbook
●     Send SMS

iSync: 

●     Default iSync Options
●     iSync

Serial Utility: 

●     Port Options
●     Serial Port New
●     Serial_Port_Util_Edit
●     Supported_Services_for_Device

Misc: 

●     Browse_Device_OPPS
●     Data_Connection_Menu_Bar_Icon
●     Internet_Connect
●     Services_Menu

Preference Pane: 

●     Lower_Pane_Revealed
●     Pair_Device_Icons
●     What_To_Do_with_File_Request_from_Sys_Pane

A screenshot of 'My Bluetooth Places'. empty, since no 
devices are in range. clicking 'bluetooth setup wizard 
brings up blueconfwiz2-1; these are basically shortcuts to 
different screens. 
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Clicking 'view or modify configuration' gives you the same 
options as the wizard in a non-wizard format (tabs across 
the top - computer name, services, etc). clicking 'view 
my bluetooth services' brings up mybluedevice, which is 
again the services you have and options. The Bluetooth 
exchange folder would appear to be the default location 
for received files. 
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Pick a topic:  
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Home Donate/PDF 
Version 

Final 
Score 

Discuss  Categories:  

Miscellaneous

OS X Cheers ●     Translucent terminal windows (below) are beautiful AND functional. I can read 
background windows THROUGH my Terminal window! Not good enough? I can set 
background pictures to Terminal windows too.

●     Stickie Notes (above) are invaluable.

●     Dialog boxes attached to their windows (Apple calls this Sheets) is a pretty novel idea. 
Never lose a dialog box behind its own window. 

●     *Nearly* system-wide spell checking: My Mac spell checks my web forum posts, iPhoto 
comments, and my iMovie titles as I type them! (No spell checking in a few apps, like 
iTunes)

●     -dragging background windows moves them without bringing them to the front. This 
trick works w/scrollbars too. 

●     Quartz Extreme is beautiful. For example, I downloaded a bunch of art images off the 
internet, and I threw them in a folder, and set that folder as my desktop background 
images folder, and set the desktop to randomly change every minute. That in itself is 
no big feat, but the images have a dissolve transition. Very nice.

●     

●     TextEdit can open and edit Word files 

●     Supplied X11 means Mac users can run tons of Unix apps natively. 

OS X separates the Close and Zoom buttons (opposite functions) by placing the 
minimize button between them while XP puts them side-by-side, increasing the 
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●      

 

chances that an accidental click will have the opposite effect that 
one intended. To help prevent accidentally hitting the wrong 
button, OS X has a healthy dead zone around each while XP's 
buttons are REALLY BIG. Though functionally equivalent to OS X's 
buttons, the overall feel is clunky, childish. 

●     

While we're on the topic, OS X includes an additional state for the 
Close button, called a Dirty Flag. The pitted red circle denotes 
that the file has changed since the last time it was saved. Finally, 
OS X only displays the x - + symbols on the icons when your mouse 
hovers over them, reducing screen clutter (but appropriately 
displays the dirty flag whether your mouse is near it or not). 

OS X Jeers ●     You can assign keyboard shortcuts to Script Menu items, you just can't invoke them.

●     TextEdit's support for rich text elements is confounding. You can paste bulletted lists 
from other documents or open them from Word files, but you can't create them 
natively.

●     Opening HTML files in TextEdit displays them in a wysiwyg view (this could be a Cheer 
or a Jeer). To alter this default behavior select "Ignore rich text commands" in 
TextEdit's preferences.

●     Terminal supports themes, but OS X doesn't ship with any preset themes. 

●     Connecting to printers in a PC environment is still not very easy.

XP Cheers ●     Newly installed programs are highlighted in the Start Menu.

●     Task bar notifies you if your network becomes physically disconnected.

●     Offline files & folders 

●     XP Media Center Edition offers Tivo-like recording of TV shows and live pausing of TV.

XP Jeers ●     Viruses, Trojan horses, Worms and Macros. Need I say more?

●     Clicking internet shortcuts on the desktop go into IE's primary window, even if it's in 
the background. Who can remember which window is primary? Reader input: Uncheck 
"Reuse windows for launching shortcuts" in Tools> Internet Options> Advanced to 
always open shortcuts in new windows. IE still lacks an option to launch shortcuts in 
the *frontmost* window. 

●     XP Home Edition doesn't support multi-processors.

●     Advanced Trackpad features aren't so advanced: In both XP and OS X you can simulate 
the action of a mouse click-hold-and-drag by doing a tap-tap-drag. I use this feature 
all the time to move windows around. However, how do you think the OS should 
behave when your finger makes it to the edge of the trackpad but you haven't finished 
dragging yet? When this happens on a mousepad with a mouse, you just pick up your 
mouse, place it back in the middle of the mousepad and continue dragging. Apple has 
simulated that behavior too. Just pick up your finger, place it back in the middle of 
the trackpad, and continue dragging. Perfectly intuitive. XP does not do this. To 
accomodate users who need to keep dragging but their finger has met the end of the 
trackpad, just leave your finger there, and the item you're dragging will continue 
moving—very slowly—until you let go. Sorry, this is lame. If you don't like that, you'll 
have to keep your thumb on the left mouse button, and drag w/your trackpad that 

http://www.xvsxp.com/misc/ (2 of 4)1/1/2005 5:51:05 AM

http://www.versiontracker.com/dyn/moreinfo/mac/13997
http://support.microsoft.com/default.aspx?scid=KB;en-us;307853&


X vs. XP> Miscellaneous

way. What about XP's ClickLock mouse setting? ClickLock reproduces this behavior 
more closely, but it effects the behavior of both the mouse AND the trackpad, which 
makes the mouse too sticky.

●     Visually, XP is rough around the edges.

●     Scrollbars in XP respond unfavorably (when scrolling) to mouse movement 
perpendicular to the scrollbar. While scrolling up, if your mouse travels too far left or 
right (about an inch), the scrollbar will snap back to it's original location. OS X's 
scrollbars correctly ignore mouse movement counter to the scroll direction, requiring 
less dexterity. 

●     Look ma, GUIArt™!

 

Splitting Hairs? File and folder names in XP cannot begin with a space. Starting filenames 
with a space is a common technique (for Mac users, at least) to override 
alphabetial order when viewing window's in list view. 

Reader input: This can be accomplished by using (!) instead of a space. 
(According to the reader) the real problem is not spaces but rather both OSes 
inability to allow arbitrary sorting. Point taken. Still, I prefer using spaces 
since they are easier to type and introduce no visual clutter when viewed in 
the list. 

Reader input #2: Type ALT+ 255 on the numeric keypad to add a "non-
breaking space" at the beginning of a file name in Windows XP. Ok, this is 
better than having exclamation points at the beginning of file names, but 
wouldn't it be nice to just type a space? 

Reader input #3: "It should be noted that [ALT+ 255] is not an ASCII space, 
which is 32 in ASCII decimal. It is, rather, a "non-breaking space"; it looks like 
a space when viewed with alphanumeric data, but it isn't." 
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You can only use your numeric keypad in XP when num lock is turned on, 
even with full size keyboards. 

Reader input: This is how it's supposed to work, because some people still use 
the arrow keys, home, end, etc. on their keypads. Seems backwards to me. 
Why inconvenience the 99% of users that will never use the numeric keypad as 
navigation keys for the sake of the 1% who will? Maybe Num Lock should be 
renamed Nav Lock, that way it's default (off) behavior is that the number keys 
work. 

Miscellaneous: No Score 

Pick a topic:  
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Home Donate/PDF 
Version 

Final 
Score 

Discuss  Categories:  

Final Score

OS X XP Pro/ Home
Login

  Login Security 7 9

  Security, out-of-the-box 7 7

  Fast User Switching 8 7

  Handling Caps Lock Key 5 8

  Locking the Screen 8 8

General Interface

  Activation 9 7

  Real-time feedback during pauses 7 4

  Responsiveness 7 9

  Move/resize windows at borders 6 8

  Cursors, Context sensitive 9 9

  Moving Windows Offscreen 9 9

  Menus, Context sensitive, Accessing 8 8

  Fitt's Law, Adherence to 7 7

Dialog Boxes

  Dialog Boxes 7 5

  Open and Save 7 7

  Open Recent 9 6

Drag and Drop 8 5

Cut and Paste 7 6

Desktop/Windows 

  Maximize vs. Zoom 7 7

  Navigating the file system 7 7

  Sorting 6 9

Files

  Files, Folders, Copying 7 8

  Files, Folders, Renaming 8 7

  Files, compression 6 8

Scored defined 

0.  not natively supported, solutions may be 
purchasable

1.  not natively supported, but freeware/
open source solutions are available

2.  exceptionally poor support
3.  poor support
4.  below average support
5.  average/acceptable support
6.  slightly above average support
7.  good support
8.  very good support
9.  exceptionally good support

10.  Perfection - improvement is not possible

This scoring method sucks!
You're right, it does suck. The scores aren't 
weighted (web server vulnerabilities have the 
same weight as icons), and the scores don't take 
into account the fact that different people with 
different computing objectives will care more 
about different topics (One ambitious reader 
has created a weighted scores calculator). So 
unweighted scores is by no means meant as a 
definitive conclusion, but rather as a starting 
point for thoughtful discussion. So on to the 
final scores... 

Unweighted Totals: 
(out of a possible 1070 points, with 1 topic w/
unfinished scores) 

●     OS X: 763
●     Windows XP Pro: 699
●     Window XP Home: 663

Ok, so it's no surprise that a Mac user rated OS X 
more usable than Windows XP. However, I 
acknowledge that different people will feel 
more comfortable–and therefore more 
productive–with different OSes. By all means 
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  Files, encryption 8 8

  Files, handling large numbers of 9 9

  File names, forbidden characters 8 5

  Aliases vs. Shortcuts 9 8

  Handling Busy Files 8 4

  Trash vs. Recycle Bin 8 8

Icons  

  Icons, Overview 9 5

  Icons, Changing 8 4

Fonts

  Quantity/Quality 8 6

  Previewing 9 7

  Management 8 7

  Anti-aliasing and Sub-pixel rendering 9 8

Dock vs Taskbar 7 7

Find/Search 8 5

Help 7 7

Keyboard

  Keyboard shortcuts, Universal 8 7

  Menu Navigation 5 9

  Dialog Box Navigation 8 8

  Navigating the file system 9 5

  App/Doc Switching 9 7

  Shutting down 9 8

  Keys, non-standard 9 5

Applications, Adding and Removing 7 5

Applications, Audio 9 8

Applications, Internet

  Web Browsing 7 8

  Email 8 7

  Email, Junk Mail Filtering 8 2

  HTML Editing 5 5

  Web Serving 7 7/1

  Web Serving, vulnerabilities 7 7

  Basic Chat 8 7

  Video/audio conferencing 8 9

  Advanced conferencing 1 9

Applications, Video

  Playback 7 9

  Editing, Adding Video 9 9

buy a computer (and an OS) that feels best to 
you. (I hope my IT department is listening!) 

There's one more intangible factor that 
deserves consideration: the pleasure/coolness 
factor. It's one thing for an operating system to 
allow you to be productive and get your job 
done. However, if that same OS can be as 
productive, and be cool at the same time, it 
can draw you in and make you enjoy doing what 
you set out to do. The more you enjoy using 
your computer, the longer you will be willing to 
sit in front of it and get your work done. If your 
computer is simply functional, you'll get your 
work done, but you'll burn out more quickly. 
And OS X surely gets my vote for the coolest OS. 

An Appeal to the Soul:
A recent "it's just an OS" remark by a co-
worker got me thinking. I spend more hours 
a day looking at and interacting with my OS 
than I do with my wife, more time looking 
at it than looking at trees, clouds, the 
ocean, or anything beautiful—combined! 
Millions of people log billions of hours in 
front of their OSes. For the sake of the soul, 
OSes at least need to be less aggravating, 
and at best to be things that are a pleasure 
to the eye and to the soul. I won't make any 
claims as to which OS I think does this 
better, but consider this next time you're 
pulling an all nighter in front of your 
computer. 

●     Love this shootout? Hate it? Speak out in 
the X vs XP forum!

Donations keep this site current! 
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  Editing, Adding Audio 8 4

  Editing, Adding Photos 8 6

  Editing, Filters 8 7

  Editing, Transitions 6 8

  Editing, Titles 6 8

  DVD Playback 9 6

  DVD Creation 1 1

  VCD Creation 4 4

Applications, Miscellaneous

  Calendar 8 1

  Calculator 9 8

  Developer Tools 9 3

  Image Creation 1 7

  Games No Score

Applications, Legacy 7 8

Digital Photos

  Importing 8 8

  Managing 8 6

Printing and Faxing

  Starting a Print Job 8 7

  Managing Print Jobs 6 6

  Configuring Printers 7 8

  Printing Preferences 8 3

  PDF Creation 5 1

  Faxing 7 7

Speech/Voice Recognition

  Voice Recognition 7 1

  Speech Synthesis 8 3

  Talking Dialogs 8 4

Networking 9 8/5

Power User

  Screen Capture 8 5

  Schedule Tasks 7 8

  Remote Control 4 9/1

  Booting from alternate drives No Score

Scriptability

  Workflow Automation 8 5

  Web Applications 7 7

Burning CDs

  Simple Burning 7 7
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  CD-RWs/Burning Multiple Sessions 5 8

  Advanced Burning 7 1

OS Updates 8 8

Network Installs 7 7/0

System Tools

  Formatting and Checking Disks 7 7

  Backup 2 9

  Disk Cleanup 5 8

  Disk Defragmenting 9 5

  Transferring Files and Settings 4 8

  Synchronizing data across devices 4 7/6

  System Information 8 8

  System Restore 5 9

User Accounts

  Account Types 8 6/4

  File Permissions, Assigning ? ?

Managing Usernames and Passwords 8 3

Power Management 7 8

Bluetooth 8 7

Miscellaneous No Score

Total 763 699/664

Pick a topic:  
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